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KmisH

Web-saytlarni yaratish va undan foydalanish ta'lim tizimida ham
muhim ahamiyat kasb etadi. Ta'limda web-saytlardan nafaqat tijorat
yoki namoyish vositasi sifatida, balki bilim berish maqsadlarida ham
foydalaniladi. Albatta bunda ta'lim masofadan turib amalga oshiriladi.
Bunday ta'lim berish jarayoni o"qituvchi va o'quvchi to'g'ridan-to'g'ri
muloqot qilmasdan olib boriladi. Buning uchun ta'lim beruvchi (oliy
o'quv yurti, maktab va boshqalar) o'qitiladigan predmetga tegishli
ma'lumotlarni web-sahifalarga bar xil ko'rinishlarda (matn, rasm,
jadval, animatsiya, tovushli ma'lumot va xatto video tasma ko'rinishida)
joylashi kerak. O'quvchi esa dunyoning xohlagan joyidan turib
Internet orqali bu ma'lumotlardan bilim olishi mumkin. Ta'limning
bunday ko'rinishi masofaviy ta'lim deb yuritiladi. Bugungi kunda
masofaviy ta'lim dunyoning ko'plab rivojlangan davlatlarida qo'llanilib
kelinmoqda. Masofaviy ta'limdan foydalanish natijasida vaqt va pulni
tejash, ortiqcha ovvoragarchiliklarsiz bilim olish imkoniyatlariga
ega bo'linadi. Bunday imkoniyatlarni bizga web-sahifalar yaratib
beradi. Ma'lum predmetga tegishli ma'lumotlarni (matn, rasm, jadval,
animatsiya va boshqalarni) sahifalarga joylab, ularni doimiy ravishda
to'ldirib, yangilab borish, o'quvchilarni bilimlarini baholash uchun
nazorat test savollarini kiritish imkoniyatlari mavjud. Buning natijasida
o'quvchining olgan bilimini nazorat qilish, baholash imkoniyatlari
paydo bo'ladi. Bu esa web-texnologiyadan ta'limda foydalanishning eng
optimal variantlaridan biri hisoblanadi.

Ushbu qo'llanmada ana shunday Web-saytlarni yaratishda qo'llani-
ladigan Macromedia Dreamweaver, Macromedia Flash, Corel Draw,
Adobe PhotoShop dasturlari va HTML - gipermatnlarni belgilash



tilidan foydalanish imkoniyatlari haqida ma'lumot berilgan. Professional
dasturlar qatoriga kiruvchi Dreamweaver dasturi o'zining barcha
imkoniyatlari bilan bar qanday murakkablik va masshtabdagi Web-
sahifalarni yaratish va o'zgartirishga qodir. U vizual loyihalash
(WYSIWYG) rejimini ta'minlab. dastlabki matnli WEB - hujjatlarning
juda aniq ishlashi bilan ajralib turadi va katta tarmoqli loyihalarni
qo'llab-quvvatlovchi ichki qurilgan vositalarga ega.

Dasturda matnlar hamda obyektlarning obrazlari ustida olib
boriladigan ishlar bevosita kodlashtirishdan ustun turadigan gipermatnli
hujjatlar yaratish usulmi vizual deb atash qabul qilingan. Dastur
nafaqat vizual loyihalash vositalarining kuchli bazasiga ega, balki
web - sahifalarni deyarli maxsus ko'rib chiqish dasturlari yordamida
aks ettirishga ham qodir: Microsoft Internet Explorer yoki Netscape
Navigator.

Dastur web-dizayn sohasida gipermatnli hujjatlarni to'g'ridan-to'g'ri
kodlashtirish yordamida yaratishni afzal ko'ruvchi mutaxassislarga
ham ma'qul keladi. Dreamweaver qobig'iga gipermatnlarni belgilovchi
diskreptorlar bilan ishlash uchun zarur barcha uskunalarga ega to'liq
funksional HTML tahrirlagichi integratsiya qilingan.

Dreamweaver dasturi «ochiq arxitektura» prinsiplariga asoslangan.
Bu amaliy dasturni interfeysi (Application Programming Interface, API)
to'liq ochiq ekanligini bildiradi. Uning yordamida tashqi dasturchilar
hamda dasturiy ta'minot bilan shug'ullanuvchi firmalar, dastur va uning
interfeysiga radikal funksional o'zgartirishlar kiritishi: yangi uskuna
qo'shish, menyu palitrasi yoki bo'limini yaratish, yangi obyekt yoki
multimedia roligini dasturlashtirish va hokazolar.

Dreamweaver ti/iimi tarkibiga multimedia roliklarini qo'yishga
mo'ljallangan qo'shimcha dastur kiradi, shuning uchun Flash —
texnologiyaning interfaol imkoniyatlarini tahrirlagichdan chiqmay turib
ko'rib chiqish mumkin.

Ta'lim tizi.mida esa, axborot texnologiyalarini qo'llab, ta'lim-
tarbiya berish va unga tegishli barcha jarayonlarni axborotlashtirish
bilan ta'lim samaradorligini oshirishga olib kelinadi. Bunda - axborot
texnologiyalaridan dars jarayonidagi ko'rgazmalilik imkoniyatlari oshib
o'quvchilarning mazmunni tushunish darajasi ortadi. O'quvchi dars
vaqtida biror murakkab jarayonni ko'z oldiga keltirishi qiyin bo'lib. uni



tasavvur qila olmaydi. Ana shunday paytda kompyuterning maxsus
dasturlari yordamida shu murakkab jarayonni aynan o'zidek qilib
tasvirlab berish mumkin. Bunda o'quvchilarda ushbu murakkab jarayon
haqidagi tasavvurni hosil qiladi. Bu kabi dasturlar ko'pincha inson ko'zi
bilan ko'ra olmaydigan (masalan, mashina dvigateli ichidagi harakatlar,
odam qon aylanish tizimi va boshqalar) murakkab jarayonlarni tasvirlab
berish uchun xizmat qiladi. Bunday dasturlarga misol qilib Flash
MX, 3D MAX kabi dasturlarni aytishimiz mumkin. Ushbu dasturlar
yordamida nafaqat murakkab jarayonlarning tasvirlarini, balki barcha
turdagi elektron darsliklarni yaratish imkoniyatlari ham mavjud.
Ayniqsa animatsiyali ma'lumotlarni keltirish va bezashda keng qo'llash
mumkin.

Ushbu qo'llanmada shuningdek Flash MX dasturini o'rganishga
bag'ishlangan ma'lumotlar ham berilgan. Qo'llanmada dastur imko
niyatlari, uning interfeysi, flash—filmlar, flash-saytlar yaratish va
ulardan turli jarayonlarda foydalanish to'g'risidagi ma'lumotlar berilgan.
Bundan tashqari web dizaynning eng muhim ajralmas qismlaridan
biri bo'lgan kompyuter grafikasi haqida ham ma'lumot beriladi. Bizga
ma'lumki web muharrirlar saytning asosini yaratishda ishlatilsa,
uni rasmlar, grafiklar va turli illustratsiyalar bilan boyitish uchun esa
grafik muharrirlariga murojat qilamiz. Bunda Adobe PhotoShop, Corel
Draw kabi grafik muharrirlarning o'rni tengsiz. Qo'llanmani yozishda
aynan bu dasturlarning tanlab olinishiga sabab, birinchidan ularning
professional dasturlar qatoriga kirishi bo'lsa, ikkinchidan Adobe
PhotoShop rastrli grafika bilan, Corel Draw esa vektorli grafika bilan
ishlashga mo'ljallanganligi uchundir.



I-bob. WEB-DIZAYN

1.1. Web-dizayn. Web-dizayn qo'IIaniladigan dasturlash vositalar

Dizayn (ingliz tilidan design injener-konstruktor, lotinchadan
designare o'lchab ko'rmoq, o'lchab bermoq) - bu ijodiy faoliyat bo'lib,
uning asosiy maqsadi sanoat buyumlarini formal sifatlnl belgilaydi.
Bu sifat shuningdek buyumning tashqi qirralarini o'z ichiga dish biian
birga, asosan shu tuzilmaviy va funksional aloqadoriik xaridor hamda
ishlab chiqaruvchi ko'zi bilan qaraganda buyumni yagona holatga
keltiradi. Dizayn sanoat ishlab chiqarishi bilan bog'langan insonni o'rab
turgan atrof-muhitning barcha jabhalarini qurshab oladi [21], [22], [23].

Dizaynning turlari - dizaynerlik faoliyati loyihalash predmetining
farqlanishi, loyiha ishining maqsadlari va metodlari hamda uning
yakuniy natijasi bilan farqlanadi. Dizaynning quyidagi turlari
mavjud:
- grafik dizayn,
- sanoat dizayn,
- web-dizayn.

Grafik dizayn

Grafik dizaynda - informatsion grafika, reklama va boshqalar
bilan ishlanadi. Web-dizayn va grafik dizayn nomining o'xshashligiga
qaramasdan, dizaynning turli yo'nalishlari hisoblanadi. Web-dizayn
ma'lumotni saytda tasvirlash uchun ishlatiladi. Ammo grafik dizayn
bilan web-dizayn o'zaro bog'langan. Grafik dizaynda tayyorlangan
illyustratsiyalar saytlarni bezashda keng ishlatiladi. Grafik dizayn aslida
foydalanuvchiga uzatiladigan ma'lumotni qabul qilinishini loyihalashi
kerak. Grafik dizaynning yo'nalishlari:

1. firma stili,
2. Shriftlar,
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3. Plakat,

4. Grafik reklama,

5. Kitobiy grafika,
6. Gazeta grafikasi,
7. Jurnal grafikasi.
Sanoat dizayni - maishiy buyumiar va asbob-uskunalarni ishlab

chiqishda, mashiriasozlik obyektlarida, transport vositalarida va bosh-
qalarda ishiatiladi.

Bulardan tashqari dizaynning bir qancha ko'rinishlari mavjud.
Bular: arxitektura dizayni, kiyim va aksessuarlar dizayni, art-
dizayn, reklama dizayni.

Web-dizayn (ingliz tilidan oiingan bo'lib, web-design — web-
sahifani loyihalash ma'nosini bildiradi) - bu web-sahifani jihoz-
lanishidir. Web dizayn sayt uchun huddi poligrafiya dizayni va qog'ozli
nashrlar dastgohlari singari muhim rol o'ynaydi. Web-dizayn deganda
nafaqat web sayt uchun grafikli elementiarni yaratish, balki uning
strukturasini loyihalash, unda harakatlanish vositalari, ya'ni butun
saytni yaratish tushuniladi. Shu sababli ham biz ushbu qo'llanmada
nafaqat web muharrirlarni, balki grafik muharrirlar, animator das-
turlarni ham gapirib o'tishni ma'qul ko'rdik.

Sayt qancha ajoyib bezatilgan bo'lmasin, unda qulay va tu-
shunarli harakatlanish chizmasi mavjud bo'lmasa, hammabop ke-
rakli matnlar boMmasa, agar sayt yaxshi dasturchilar tomonidan
tayyorlangan samarali dasturiy vositalarga ega bo'lmasa - bunday
sayt tezda o'z foydalanuvchilarini yo'qotadi va undagi noqulaylik
(hattoki u professional va munosib stilda tayyorlangan bo'lsa ham)
muvofaqiyatsizlikka mahkum bo'ladi. Yaxshi web-dizayn saytning
sahifalarini hamohanglik bilan birlashtiradi. Boshqacha aytganda, web-
dizayn saytning Joylashish o'rnini belgilaydi.

Web-dizaynni o'rganishda quyidagi uchta tushuncha muhim
ahamiyat kasb etadi: Web-sahifa, Web-sayt va Web-server.

Web-sabifa - o'zining unikal adresiga ega bo'lgan va maxsus
ko'rish dasturi yordamida (brauzer) ko'riluvchi hujjatdir. Unga matn,
grafika, ovoz, video yoki animatsiya ma'lumotlar birlashmasi -
multimediyali xujjatlar, boshqa hujjatlarga gipermurojaatlar kirishi
mumkin.
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Web-sayt - bir qancha web-sahifalarning mantiqiy birlashinasi.
Inglizcha «site» (tarjimasi «joy») so'zining o'zbekcha talaffuzi. Umum-
jahon o'rgimchak to'ri ma'lum axborot topish niumkin bo'lgan va
noyob URL bilan belgilangan virtual joy. Mazkur URL web-saytning
bosh sahifasi manzilini ko'rsatadi. O'z navbatida, bosh sahifada web-
saytning boshqa sahifalari yoki boshqa saytlarga murojaatlar bo'ladi.
Web-sayt sahifalari HTML, ASR PHP, JSP, grafik va boshqa fayllardan
tashkil topgan bo'lishi mumkin. Web-saytni ochish uchun brauzer
dasturidan foydaianiladi. Web-sayt shaxsiy, tijorat, axborot va boshqa
ko'rinishlarda bo'lishi mumkin..

Web-server - tarmoqqa ulangan kompyuter va undagi dastur
hisoblanib, umumiy resurslarni mijozga taqdim etish yoki ularni
boshqarish vazifalarini bajaradi. Web-serverlar ma'lumotlar bazalari
va multimediyali ma'lumotlarni bir biriga moslashtiradi. Web-
serverda Web-sahifa va Web-saytlar saqlanadi. Web-server - Internet
yoki Internetga ulangan umumfoydalanishdagi axborot serveri. Unda
hujjatlar va fayllar - audio, video, grafik va matn fayllari - saqlanib,
ular foydalanuvchilarga HTTP vositalar orqali taqdim etiladi. Web
server nomi u umumjahon tarmog'ining qismi bo'lgani uchun kelib
chiqqan. Maxsus dasturiy ta'minotga ega bo'lgan, bir yoki bir necha
web-sayt fayllarini saqlash va ularga ishlov berish mumkin. Bir necha
web-sayt bitta kompyuterda ishlaganda, web-server deganda web-
sayt ishlovchi virtual makon (dasturiy ta'minot va kompyuterdagi joy)
tushuniladi. Shunga ko'ra ko'pchilik uchun «web-server» deganda
«web-sayt» tushuniladi. Ko'p axborotni saqlovchi web-saytlar bir
paytning o'zida bir necha kompyuterda saqlanishi va ularga ishlov
berilishi mumkin. Web-server mijozlarning web-saytga so'roviga javob
beradi.

Bu tushunchalarga qo'shimcha web hujjat tushunchasini ham ko'rib
o'tamiz.

Odatda, maxsus HTML (Hypertext Markup Language) tilidagi
hujjat. Web-hujjat jahon o'rgimchak uyasining asosini tashkil qiladi.
Ular gipermatndan iborat bo'lib, foydalanuvchiga ajratib ko'rsatilgan
so z yoki jumlaga qaratib, ma'lumotlarni o'qish, hujjatning boshqa
qismiga yoki ayni hujjat bilan giperhavola yordamida bog'langan
boshqa web-hujjatga o'tish imkonini beradi. Web-hujjat, shuningdek,



matn, tasvir, tovusli, videolarni mujassamlovchi gipermuhit ma'lumotni
ham o'z ichiga olishi mumkin. Web-hujjatni ochish, ularni o'qish yoki
aks ettirish Internet brauzerlari yordamida amalga oshiriladi. Web-
hujjat tushunchasi «web-sahifalar» va «vveb-saytlar» tushunchalari
bilan chambarchas bog'liq. Odatda «\veb-sahifa» atamasi web-hqjat
atamasining sinonimini bildiradi, «web-sayt» atamasi esa yagona mavzu
ostida birlashtirilgan yoki bitta tashkilot, muallif yoki foydalanuvchiga
tegishli boigan sahifalar majmuasiga tegishlidir.

Munosib web-dizaynni yaratishda qatnashuvchi quyidagi element-
larni sanab o'tish mumkin:

Shrift - web sayt ichida imkoni boricha bitta shrift, yoki odatda
ikki-uchta bir-biriga o'xshash (oson qorishadigan) shriftlarni qo'shib
ishlatish mumkin bo'lgan xususiyatlar va tanlangan fonda o'qish
mumkin bo'lgan rangiarga ega bo'lishi lozim.

Abzats - imkoni boricha web saytning barcha sahifalarida
matn va boshqa vizual materiallarni tekislashning (sozlashning) bir
ko'rinishlarida bo'lishi maqsadga muvofiq.

Web-saytning rangli sxemasi - sahifaning oddiy matnini, havola
va tashrif buyurilgan havolalarni taqdiin qilishning uch xil ranglarini
belgilaydi. Rangli sxema, yoki turli mavzudagi saytning bo'limlaii
uchun bunday sxemalaiming bir nechta ko'rinishi saytning barcha
sahifalarida takrorlanishi lozim.

Web-dizayn o'zida belgilangan rangli va mantiqiy sxemani bir-
lashtirgan qandaydir grafikli jihozlashni nazarda tutadiki, shuning
uchun ish boshida saytni jihozlashning umumiy konsepsiyasini o'ylab
ko'rish kerak bo'ladi. Barcha grafik elementlarni ikkita katta sinfga
ajratish mumkin: chizilgan va biror real voqelik fotosuratlari. Saytni
bezash ishlarida bu ikki tipni aralashtirib yubormaslik yoki ularni
web saytning tematik yoki mantiqiy qismlariga to'g'ri taqsimlash
maqsadga muvofiq. Shuni alohida ta'kidlab o'tish kerakki, saytda har
qanday tipdagi foto suratlarni illustratsiya sifatida ishlatishdan oldin,
ularni tegishli tarzda qayta ishlash (rang va tonda tuzatish, korreksiya)
zarur.

Web-dizaynning asosiy maqsadi - saytni egasiga foyda (moddiy,
ma'naviy) keltiradigan ko'rinishda taqdim qilishdan iborat. Foyda sayt
orqali mollarni to'g'ridan-to'g'ri sotish orqali bo'lishi, shuningdek unga



qo'shimcha firmalarni, mahsulotlarni reklama orqali yangi mijozlarni
o'ziga tortish yo'Ii bilan ham kelishi mumkin. Ta'limda esa bularga
qo'shimcha o'quv resurslarini yetkazib berish, ta'limni boshqarish
ishlarini amalga oshirish mumkin.

Bizga ma'lumki web-dizayner boshqa kasblarga nisbatan yosh
(yangi) kasb hisoblanadi. Internetga bo'lgan talabning ortishi bilan,
saytlaraing dizayniga bo'lgan talab va web-dizaynerlar soni ham ortib
bormoqda.

Endi web loyihalarning asosiy tiplari va ularni bar birini vizual
bezashga qo'yiladigan talablar bilan tanishib chiqamiz. Saytlar tarkibiga
ko'ra quyidagi asosiy tiplarga bo'linadi:

Uy sahifasi (Домашняя страница) tushunchasining bir nechta
ko'rinishi mavjud:

1. Alohida shaxsga tegishli web-sayt. Bu saytda shaxs haqidagi
bir necha mavzudagi ma'lumotlar, matnlar, foto jamlanmalar berilishi
mumkin. Odatda bunday saytlarga turli sohalarning (masalan, fan-
texnika, madaniyat, sport va boshqa sohalarda) mashhur kishilari ega
bo'ladi.

2. Brauzerda birinchi yuklanadigan web-sahifa. Saytdan foydalanish
undan boshlanadi. Odatda, foydalanuvchi o'zining qayerda ekanligi va
saytning boshqa sahifalarida nimalarni ko'rishi mumkinligi haqida uy
sahifasidan ma'lumot oladi. Brauzer tomonidan dastur yuklangandan
so'ng terminalda paydo bo'ladigan web-sahifaning, portalning, maj-
muaning birinchi sahifasi. Odatda, prezentatsiya va navigatsiya bo'yicha
ham asosiy ish bajaradi.

Prezentatsion sayt - nomidan ko'rinib turibdiki, sayt fi rma /
xizmatlar / mahsulotlar haqidagi ma'lumotlarni taqdim qiladi. Ma'lum
sondagi sahifalarni o'zida birlashtirib, kamdan-kam holatda yangilanadi.
Saytning asosiy vazifasi - taqdim qilinayotgan xizmatlar va uning
afzalliklarini tashrif buyuruvchilargacha vizual jihozlash yordamida
maksimal tezlik va samara bilan yetkazib bera olishdan iborat. Bunday
loyihalar tartib qoidalar bo'yicha aniq, noyob dizayn, grafikli jihozlanish
matnli ma'lumotlar oldida ustunlik qiladi.

Misol sifatida http://www.loyalstudios.com va http://www.de-
signchapel.com saytlarida keltirilgan sahifalarni aytish mumkin.

Korporativ saytlar — tashkilotning (firmalar, korporatsiyalar) inter
net tarmog'idagi vakolatxonasi hisoblanadi va binobarin, bunday
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loyihalarda eng asosiy talab ma'lumotni ya'ni grafika yoki matnning
jihozlanishiga qaratiladi.

Informaision resurslar - bu elektron kutubxonalar va gazetalar.
Bunday tipdagi saytlarda ma'Iumotlar bir sirtkada bir necha marta
yangilanadi. Ma'lumotlarning hajmi juda ham katta, va bunday saytlarni
ishlab chiqishda shuni ta'kidlash kerakki, tashrif buyuruvchi saytni
tomosha qilish uchuii emas - ular mazmuni uchun kelishadi. Yangiliklar
nashri (misol uchun - http://www.cnews.ru') yoki http://sight.nmi.ru
singari rasmlar galereyasida, loyihaning bosh maqsadi - yuqori tezlikda
ma'lumotni tashrif buyuruvchiga taqdim qilish yoki bu ma'lumotni
qidirish imkoniyatidan iborat. Har qanday grafikli bezaklar sahifaning
hajmini oshirib yuboradi - ya'ni sahifaning yuklanish vaqtini oshirib
yuboradi. Shuning uchun mumkin qadar bunday loyihalarda dizayn
matnli ko'rinishda ishlab chiqiladi. Kartinkalar, fotografiyalar, grafiklar,
sxemalar illustratsiyalar hisoblanadi.

Elektron tijorat - axborot texnologiyalariga asoslangan biznes
hisoblanadi. Elektron tijorat (ingliz tilidan e-commerce) - internetda
o'zining sayti va virtual magazini, shuningdek o'zining (firma yoki
kompaniyaning) boshqaruv tizimi mavjudligi bilan asoslanadi. Elektron
tijoratga quyidagilar kiradi:
- elektron ma'lumot almashish (Electronic Data Interchange, EDI),
- elektron jamg'arma ko'chirish (Electronic Funds Transfer, EES),
- elektron savdo (e-trade),
- elektron karmon (e-cash),
- elektron marketing (e-marketing),
- elektron banking (e-banking),
- elektron sug'urta xizmatlari (e-insurance).

Web-dizaynda qo'IIaniladigan dasturiy vositalar

Bugungi kunning talablaridan kelib chiqib to'laqonli. web-saytlar
yaratishda bir qancha turdagi dasturiy vositalardan foydalaniladi. Ularni
to'rtta katta guruhga ajratish mumkin (1.1-rasm) [11], [12], [13].

Undan tashqari web muharrirlarning ham turlari juda ko'p. Ular
o'zining imkoniyati, tezkorligi, interfeysi va boshqa xususiyatlari
bilan farqlanadi. 1-jadvalda shunday dasturlardan asosiylari kel-
tirilgan.
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Dastuny
vositalar

l.l-rasm. Web saytlar yaratishda qo'Ilaniladigan dasturiy vositalar guruhlari.

Ll-jadval

Web-muharrirlar ro'yxati

№ dastur nomi izoh

1. Bloknot (Notepad) Windows operatsion tizimi standart vositala-
ridan bo'Ilb, undan HTML tilini yaxshi bilgan
o'rganuvchilar foydalanadi.

2. HomeSite 4.5 HTML-muharrir. Teglarni ranglar bilan ajratish,
bir vaqtning o'zida bir nechta faylda qidirish,
almashtirish va boshqalar.

3. UltraEdit-32 Dasturchilar uchun keng imkoniyatli matn
muharriri. Bir vaqtning o'zida bir nechta fayini
tahrirlash imkoniyati mavjud.

4. Web Page Maker Dastur Software Inc mahsuloti hisoblanadi.
Qisqa vaqt ichida web-sahifa yaratish va
yuklash imkoniyatini beradi, Unda HTML tilini
bilish shart emas.

5. DTM Lome 1.2 Ish boshlovchilar va professionallar uchun
oddly, tezkor va quiay HTML-muharrir.
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6. Artisteer.2.3.0.10943 Dastlabki web-dizaynni avtomatlashtirgan das-
tur. Photoshop, CSS, HTMLlami bilish talab
qilinmaydi.

7. Codelobster

PHP Edition 3.3

Juda qulay PHP, HTML, CSS muharriri

8. Amaya web-brauzer va HTML-muharrir The World

Wide Web Consortium (W3C) - tomonidan
ishlab chiqilgan.

9. NeoiiHTML O'zida vizual uskunalarni birlashtirgan HTML
va CSS muharrir.

10. Serif WebPlus X2 Professional darajadagi web-saytlar yaratishga
mo'ljallangan web-dizayn dasturi

11. PHP Designer 2008
Professional 6.2.5.2

PHP tilida ish boshlayotgan va professional
foydalanuvchilar uchun dastur PHPdan tash-
qari, dasturda HTML, MySQL, XML, CSS,
JavaScript, VBScript, JAVA, C, Python va
Rubylami ham ishlatish mumkin.

12. Dreamweaver CS4 Murakkab strukturali web-saytlarni loyihalash,
yaratish va boshqarishga mo'ljallangan profes
sional dastur.

13. Wap Editor 0.6d Qulay va ko'p funksiyali web-sahifalar yara
tishga mo'ljallangan dastur.

14. BestAddress

HTML Editor 2008

Professional 12.12.0

Ko'p funksiyali HTML-muharrir. Dasturda
DHTML kodlari yordamida menyu yaratish
imkoniyatlai'i mavjud.

15. DzSoft PHP Editor

4.2.1

PHP - skriptlar yozishga va HTML-sahifalar
yaratishga mo'ljallangan dastur.

16. SaveChm 1.2 Rasmli web-sahifalarni tezkorlik bilan CHM

(Windows-help) formatida saqlovchi dastur.

17. MenuEditor

1.0.3.231

Web-saytlarda harakatlanish uchun qulay men-
yularni yaratishga mo'ljallangan dastur

18. Quick Page 2008
(3.0.3.254)

Web-saytlar yaratishga mo'ljallangan profes
sional dasturiy vosita.

19. AAA Web Album Bu dasturiy vosita web-sahifalar uchun foto
albomlar yaratish uchun mo'ljallangan.
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dcn'omi

20. Multiple File Search
and Replace 2.0

Bir vaqtning o'zida web-saytning bir nechta
fayllari bilan ishlashga mo'ljallangan dasturiy
vosita

21. Incomedia Website

Evolution X5 7.0.9

Foydalanish uchun qulay bo'lgan, tushunarli
interfeys va qadamba-qadam yordamchidan
foydalanib bir necha minutda web-sayt yaratish
mum kin

22. Arachnophilia
5.3.2177

Java asosida qurilgan HTML-muharrir Sun Mi
crosystems mahsuloti hisoblanadi

23. Web Page Maker
v2.5 Rus

Dasturning arxivida bir qancha tayyor sayt
shabionlari mavjud bo'lib, bir necha daqiqada
HTML sahifalar yaratish imkonini beradi

24. Incomedia WebSite

X5 Evolution 7.0

Shaxsiy web-saytlar yaratishga mo'ljallangan
dastur

25. AceHTML Pro

V6.03.0

Web-saytlar yaratish va ularga xizmat ko'r-
satuvchi dasturlar paketi

26. Sothink

DHTMLMenu 8.3

build 71210

Web-ustalar uchun mo'ljallangan dasturlar pa
keti

27. HtmlReader 2.5 html-sahifalarni yaratish, tuzatish va ko'rishga
mo'ljallangan dastur.

28. PHP Designer 2008
Professional v6.0.0

PHP, HTML, XHTML, CSS, Perl, C*, jav-
Script, VB, java va SQL muharriri.

29. Atani 4.3.4 Rus Web-sahifalar uchun bannerlar yaratishga mo'l
jallangan dastur

30. Sothink

DHTMLMenu

DHTML menyular yaratishga mo'ljallangan
dastur. Dasturdan foydalanishda DHTML yoki
JavaScript bilish talab qilinmaydi

31. TIGER CMS vl.O

Lite

Shaxsiy web-sahifalar yaratishga mo'ljallangan
dastur

Web-dizaynda qo'llaniladigan bir qancha dasturiy vositalar va yana
ko'plab uskunaviy dasturlar, turli dasturlash tillari mavjud. Eng ko'p
qo'llaniladigan tillarga misol qilib, HTML-gipermatnlarni belgilash tili,
PHP, ASP, Java, JavaScript, DHTML va boshqa tillarni aytish miimkin.
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Mijoz tomonidan

■■ "4

Web dasturlash tillari

/

'{JavaScript ]

[AdobeFlash (ActionScript) ]

^SilverLtght |

Server tomonidan —

|JSP (Java) ]

ASP.NET (CU. Visual Basic. JScript va
boshqa .NET tillari.

4 PHP)

■S
^Ruby (Ruby on Rails) j

1.2-rasm. Web-dasturlash tillarining guruhlarga bo'linishi.

Web-dasturlash tillari ikki guruhga bo'linadi: mijoz va server tillari.
Biz yuqorida web-serverga ta'rif berdik. Unga ko'ra server sizning
saytingiz saqlanadigan, brauzerning so'rovlari qayta ishlanadigan
qaysidir sahifadagi dasturlar saqlanadi. Undan tashqari serverga
quyidagiclia ta'rif berish mumkin: Server - tarmoq ishini ta'minlovchi
maxsus kompyuter. Server disklarida kompyuterlarni birgalikda ishlash
imkonini beruvchi dasturlar, ma'lumotlar omborlari va boshqalar
saqalanadi. Bundan tashqari serverlar modemli va faksli aloqalarni,
ma'lumotlarni bosmaga chiqarish ishlarini amalga oshiradi. Serverda
joylashgan dasturlardan foydalanish doirasi umumiy masalaning
qo'yilishiga ko'ra cheklangan bo'lishi mumkin.

Mijoz tomonidagi senariylar
JavaScript nima?

Mijoz tillaridan eng ko'p tarqalgani JavaScript tili bo'lib, Netscape
(Netscape Navigator, www.netscape.com) SunMicrosystems .(www.sun.
com) kompaniyalari hamkorligida ishlab chiqilgan. JavaScript faol
HTML-sahifalar uchun senariylar yozishga mo'ljallangan. JavaScript
avtonom ravishda ishlaydigan ilovalarni yaratishga mo'ljallanmagan.
JavaScriptdagi dasturlar bevosita HTML-hujjat kodi ichiga quriladi va
brauzerda sahifani yuklanishi vaqtida faollashadi. Sodda qilib aytganda
HTMLning cheklangan, sodda imkoniyatlarini kengaytirish va to'laqonli
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sahifalar yaratishga mo'ljallangan. JavaScript yordamida odatda
ma'lumotli va muloqot oynalarini chiqarish, animatsiyalarni ko'rsatish
kabi vazifalarni bajarish mumkin. Bundan tashqari, JavaScript-
senariyda ba'zan o'zi ishlab turgan brauzer va platforma tipini aniqiash
mumkin. JavaScript-senariyiar foydalanuvchi tomonidan kiritilayotgan
ma'Iumotlarni to'g'riligini tekshirishda ham qulay hisoblanadi.

ActionScript nima?

ActionScript — obyektga yo'naltirilgan dasturlash tili boiib, Flash-
iiovalar tarkibida interfaollik, ma'Iumotlarni qayta ishlash va boshqa
ko'plab imkoniyatlarni beradigan ECMAScript dialektlaridan biri
hisoblanadi.

Silverlight nima?

Microsoft Silverlight - bu dasturiy platforma bo'lib, RIA (Rich
Internet application)ga xos bo'lgan animatsiyalar, vektorli grafika va
audio-video roliklardan tarkib topgan ilovalarni yuklash imkonini
beradigan brauzer uchun plaginlarni o'z ichiga oladi. Bu esa
Silverlight barcha brauzerlarda WMV, WMA va MP3 kabi formatlarni
Windows Media Player singari qo'shimcha komponentlarsiz ijro qilish
imkoniyatini beradi. Dasturning 2.0 versiyasi 2008 yil oktyabrda ishlab
chiqilgan bo'lib, unga .NET tillari bilan ishlash imkoniyati qo'shilgan.
Bundan tashqari Microsoft kompaniyasi 2009-yil iyulda IDE bilan
integratsiyalashgan Silverlight 3 va Microsoft Expression Studio 3
dasturlarini ishlab chiqdi.

Silverlight platformasi Windows 2000, Windows XP, Windows
Server 2003, Windows Vista, Windows 7, Mac OS X 10.4, Mac OS
X 10.5, Mac OS X 10.6 operatsion tizimlariga va Internet Explorer
6.0/7.0/8.0, Mozilla Firefox 1.5/2.0/3, Safari 3.1, Google Chrome 3.0,
Opera 9.50 brauzerlariga mo'ljallangan.

VBScript nima?

VBScript tili Microsoft korporatsiyasi tomonidan yaratilgan bo'lib.
Visual Basic filining bir qismi hisoblanadi. VBScript tili Internet
Explorer va Microsoft Internet Information Server (IlS)lar bilan
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ishlashga mo'ljallangan tildir. VBScript tilining JavaScript tili bilan
umumiy qismlari bir nechta. Jumladan, u aynan Microsoft Internet
.Explorer bilan ishlash va uning qo'llanish sohasini cheklay olish
imkoniyatiga ega. VBScript interpretatorli (sharhlovchi, izohlovchi,
tushuntirib beruvchi) til hisoblanib, Microsoftning Web-texnologiyalari
(masalan ASP (Active Server Page)) bilan hamkorlikda ishlay
oladi. Shunga qaramay VBScript klient tomonida ishlovchi senariy
hisoblanadi, ASP esa server tomonida ishlaydi.

Server tomonidagi senariylar

Dasturning ishlashi to'liq sayt joylashtirilgan serverga bog'liq.
Server tillaiini ishlashining muhim jihatlaridan biri bu serverda
tartiblangan holda saqlanuvchi va xohlagan paytda chaqirilishi mumkin
0 Igan ma lumotlarni bevosita ma'lumotlar bazalarini boshqarish

tizimlari bilan o'zaro bog*langan holda faoliyat yuritadi. Eng ko'p
ishlatiladigan ma lumotlar bazasini boshqarish tizimlari quyidagilar:
Firebird, IBM DB2, IBM DB2 Express-C, Microsoft SQL Server,
^crosoft SQL Server Express, mSQL, MySQL, Oracle, PostgreSQL
SQLite, Sybase Adaptive Server Enterprise.

Server tomonida bajarilishi kerak bo'lgan senariylar odatda sayt
papkasining ichidagi maxsus papkaga joylashtiriladi. Foydalanuvchi
so roviga asosan server bu senariyni bajaradi. Bajarilgan senariy natijasi
We -serverga uzatiladi va undan so'ng mijoz (klient)ga uzatiladi. Server
tomonidagi senariylarni tashkil etish uchun odatda Perl, ASP, PHP, JSP,

I kabi tillai va texnologiyalardan foydalaniladi.

Perl nima?

Г  P''otsedurali dasturlash tili bo'lib, juda keng qamrovliopshinqlarni yechish uchun mo'ljallangan universal uskunadir.
er boshqa to laqonli tillar singari platformalarga, operatsion tizim

va boshqa vositalarga bog'liq bo'lmagan funksiyalar va qoidalar
0 plarniga ega yadrodan tashkil topgan. Perl tili Web-ilovalar

yaratish a eng ommabop tillardan biri hisoblanadi. Matnlarni qidirish
va tahrirlash, fayllar bilan qulay ishlay olish qoidalari uchun Perl tili
n ernetning asosiy tillaridan biri bo'lib qoldi. Perl - interpretatorli til
isoblana i, s u bois unda yaratilgan senariylar ishlashi uchun server

^ - Pfdai^ogik weh-Jizayn Г
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kompyuterda Perl-interpretator o'rnatilgan bo'lislii kerak. Bevosita
Perl-kodaing interpretatsiya qilinish jarayoni uning samaradorligini
pasaytiradi. Bugungi kunda Perlning asosiy yutuqlaridan, uning barcha
platformalar uchun ishlay olishi va uning barcha resurslari bepul
tarqatilayotganligidir. Ko'pgina web-serverlar UNIXda ishlaydi, Perl
interpretator esa bu operatsion tizimning bir qismi hisoblanadi.

ASP nima?

ASP (Active Server Pages) - ma'lumotlar bazalari tashkil etish
va ular bilan ishlash vazifalarini bajarishda juda moslashuvchan.
quiay vositadir. ASP vositalari server tomonida ishlaydi va HTML-
kod va senariyiar kabi fayllarni qayta ishlaydi. ASP texnologiyasi
VBScript, Java va JavaScript tillarini qo'llab quvvatiaydi. ASP-
kod joylashtirilgan Web-sahifalar fayllari kengaytmasi .asp bo'ladi.
ASP texnologiya Windows NT va Microsoft IIS web-serveriga
mo'ljallangan bo'lib, imkoniyatlari va samaradorligi yuqori bo'lganligi
bois ko'pgina kompaniyalar o'z vositalariga ASPni qo'llab-quvvatlash
imkoniyatlarini kiritmoqdalar. Ko'pgina HTML-muharrirlar, masalan,
Adobe GoLive ham ASPni qo'llab-quvvatlaydi. ASP texnologiyasi
bir nechta qulayliklarni o'zida jamlagan: HTML-hujjatni dinamik
generatsiyalaydi, formalarni qo'llab-quvvatlaydi, ma'lumotlar bazasiga
ruxsatni tashkil etadi va u bilan ishlay oladi. ASP — dasturlash till
ham, ilova ham emas, u interfaol web-sahifa hosil qilish texnologiyasi
hisoblanadi.

PHP nima?

PHP - bu serverda qayta ishlanuvchi senariyiar tilidir. ASP kabi
PHP kodlar ham bevosita HTML-hujjatni tarkibiga qo'shiladi. Ushbu
tilning nomi Personal Home Page Tools so'zlarining qisqartmasidan
olingan. PbJPda С va Perl tillarida uchragan bir qator muammolar hal
etilgan. Bundan tashqari, PHP ma'lumotlar bazasi bilan ishlash uchun
juda qulay vositadir. Umuman olganda Perl, PHP - ochiq tizimli tillar
hisoblanadi va ularni dasturchilar modernizatsiyalashtira oladi.

Ko'pgina bashqa dasturlash tillaridan farqli ravishda. PHP qandaydir
tashkilpt yqki kuchli dasturchi tomonidan yaratilgan emas. Uni oddly
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foydalanuvchi Rasmus Lerdorf 1994-yili o'zining bosh sahifasini
interfaol uslubda ko'rsatish uchun yaratgan. Unga Personal Home Page
(PHP — shaxsiy bosh sahifa) deb nom bergan.

1995-yili Rasmus PHPni o'zining HTML formalari bilan ishlaydigan
boshqa dastur bilan umumlashtirib PHP/FI Version 2 («Form
Interpretator») hosil qildi. 1997-yilga borib PHPdan foydalanuvchi
saytlar 50 mingdan oshdi. Shundan so'ng web texnologiya ustalari
PHP g'oyasi asosida mukammal til yaratishga Ziva Suraski va Endi
Gutmans asoschiligida kirishildi. PHPni samarali deb hisoblanmagani
uchun deyarli noldan boshlab, mavjud С va Perl tillaridan ibrat olib
PHP3 talqinini yaratildi. 1999-yilga kelib PHP asosida qurilgan saytlar
milliondan oshib ketdi. 2000-yiida esa Zend Technologies shirkati yangi
ko'pgina funksiyalarni qo'shgan holda PHP 4 sharhlovchisini yaratdi.

PHP - web texnologiya tili. PHPni o'rganish uchun avval bTTML
va dasturlash tiiidan habardor bo'lish talab qilinadi. HTML/CSS va
JavaScript tillarini mukammal biladiganlar uchun PHPni o'rganish
murakkablik tug'dirmaydi. PHPning vazifasi HTML faylini yaratib
berish. JavaScript yordamida bajariladigan ko'pgina operatsiyalarni
PHP orqali ham amalga oshirish mumkin.

JavaScript — mijoz tomonda bajariladi, PHP esa serverda bajariladi.
PHPda yozilgan kod serverning o'zida bajarilib, klientga HTML
shaklida etib boradi. Bu havfsizlik jihatdan ancha maqsadga muvofiq.

JavaScript yordamida kod yozish, ma'lumot uzatish va qabul qilislini
biroz tezlashtirsa-da, kodni mijoz ko'rish imkoniyatiga ega bo'ladi.

«PHPda har qanday dasturni bajarsa bo'ladi» - degan edi uning
yaratuvchisi. Birinchi navbatda PHP tili server tomonidan bajariladigan
skriptlar yaratish uchun foydalaniladi va aynan shuning uchun u
yaratilgan. PHP tili ixtiyoriy CGI-skriptlari masaialarini yechishga va
bundan tashqari html formali ma'lumotlarni qayta ishlashga hamda
dinamik ravishda html sahifalarni ishlab chiqishga qodir. Biroq PHP tili
foydalaniladigan boshqa sohalar ham mavjud. Bu sohalarni biz uchta
asosiy qismga bo'lamiz:

Birinchi soha - biz yuqorida aytib o'tganimizdek, server tomonidan
bajariladigan ilovalar (skriptlar) yaratish. PHP tili bunday turdagi
skriptlarni yaratish uchun juda keng qo'llaniladi. Bunday ish ko'rsatish
uchun PHP-skriptlarni qayta ishlovchi va skriptlarni qayta ishlovchi
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web-server, skriptlarni natijasini ko'rish uchun brauzer va albatta php-
kodini yozish uchun qanday boisa ham matn muharriri kerak bo'ladi.

skriptlarni qayta ishlovchi CGI-dasturlar ko'rinishida yoki server
modullari ko'rinishida tarqalgan.

Ikkinchi soha — buyruqlar satrida bajariladigan skriptlarni yara-
tish. Ya'ni PHP tili yordamida biror-bir kompyuterda brauzer va
web-serverlardan mustaqil ravishda o'zi bajariladigan skriptlarni
ham yaratish mumkin. Bu ishlarni bajarish uchun hech bo'lmaganda
PHP"Skriptlarni qayta ishlovchi (bu holatda biz uni buyruqlar satri
interpretatori (CLI, command line interpreter) deb ataymiz) talab
etiladi. Bunday ishlash uslubi turli masalalarni rejalashtirish yordamida
bajarilishi uchun kerak bo'lgan skriptlar yoki oddiy matnni qayta
ishlash uchun kerak bo'lgan masalaga o'xshash ishlaydi.

Uchinchi soha - bu mijoz tomonidan bajariladigan GUI-ilovalarni
(grafik interfeys) yaratish. Bu soha PHP tilini endigina o'rganayotgan
foydalanuvchilar uchun uncha muhim bo'lmagan sohadir.

PHP tilini qo'llanilish sohalari keng va turlichadir. Yuqoridagi
masalalarni yecha oladigan boshqa turlicha dasturlash tillari ham
mavjud. Unda nima uchun PHP tilini o'rganishimiz kerak? U til bizga
nima beradi? Birinchidan, PHP tili o'rganish uchun juda qulay. PHP
tilini sintaksisi asosiy qoidalari va ishlash prinsipi bilan yetarlicha
tanishib chiqib o'zingizni shaxsiy dasturingizni tuzib ko'rib, so'ngra
uni boshqa dasturlash tillarida tuzilgan variantlari bilan solishtirsangiz
bunga guvoh bo'lasiz. Ikkinchidan, PHP tili barcha bizga ma'lum
platformalarda, barcha operatsion tizimlarda hamda turlicha serverlarda
erkin ishlay oladi.

PHP dasturlash tilini turli dasturlash tillari o'rtasidagi o'zaro
aloqasiga diqqatni qaratsak. bunga Java dasturlash tilini aytib o'tish
lozim, chunki Java dasturlash tili obyektlarini PHP tili o'z obyektlari
sifatida qaraydi. Obyektlarga murojaat sifatida CORBA kengaytmasidan
foydalaniladi.

JSP

JSP (JavaServerPage) texnologiyasi o'zining funksional imkoniyat-
lariga ko'ra ASPga o'xshashdir. Asosiy farqi shundaki, bunda VBScript
va JavaScript bilan birga Java tili ham qo'llanila oladi. Shunga qaramay
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JSP Javadan oldinroq qo'Ilanilgan va ushbu texnologiya mukammal
Web-ilovalar yaratish uchun yetarli imkoniyatga ega.

SSI

SSI (Server Side Include) HTML-faylni dastlab serverda qayta
ishlaydi va undan so'ng uni mijozga uzatadi. Dastlabki qayta ishlash
vaqtida hujjatga dinamik generatsiya qilingan ma'lumotlar qo'shiladi.
Masalan joriy vaqt haqidagi ma'lumot. Umuman olganda SSI
texnologiyasi HTML-faylning tarkibiga qo'shimchalar qo'shishga
moMjallangan HTMLning qismi hisoblanadi.

DHTML nima?

DHTML (dinamik HTML) - bu serverga ortiqcha bog'Ianishlarsiz
interfaol Web-sahifalar yaratish imkonini beradigan vositaiar to'p-
lamidir.

DHTML tili HTML va JavaScriptlardan farqli ravishda bir qancha
qo'shimcha internet texnologiyalariga ega. Dinamik HTML — Netscape
va Microsoft tomonidan o'ylab topilgan tijorat termini bo'lib, unda
Web-brauzerlarning dinamik imkoniyatini kengaytirish maqsadida
kiritilgan. Bu texnologiyalar HTML yordamida Web-sahifa yaratishdagi
mavjud imkoniyatning cheklanganligi va ana shu cheklovdan oTib
ketish uchun yaratilgan yoki qo'shilgan hisoblanadi. Chunki bizga
ma'lumki HTMLning faqatgina o'zidan foydalanib bugungi kunda
mukammal Web-sahifalar yaratib bo'lmaydi. Boshqacha aytganda
mavjud Internetda matnli ma'lumotlar va grafik ma'lumotlarga
mo'ljallangan Juda yaxshi.texnologiyalar_mavjud edi. Ammo multimedia
imkoniyatlariga ko'nikib qolgan odamlar esa bunga ko'nika olmadi. Shu
sababli Internet imkoniyatlarini kengaytirish kerak edi.

DHTML asosida yaratilgan sahifa serverdagi qo'shimcha ma'
lumotlarga murojaat qilmasdan turib ham o'zgarish imkoniyatiga ega.
DHTML o'zida turli xildagi standartlarga (CSS, DOM, JavaScript va
gipermatnlarni belgilash tillariga) asoslangan kombinatsiyalarni namoj'on
qiladi. Bu standartlarning kombinatsiyasi sizning web-sahifangizni
interfaolligini oshirish imkonini beradi. Boshqacha aytganda, sahifaga
tashrif buyurgan foydalanuvchi uning tashqi ko'rinishi va mazmunini
serverga murojaatlarsiz o'zgartira olish imkoniyatidir.
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1.2. HTML tili haqida

Bizga ma'lumki, bar qanday murakkablikdagi web-saytlar HTML
tiliga asoslangati bo'lib, bu tilni bilmasdan turib to'laqonli web-saytlar
yaratib bo'Imaydi. Endi HTML tilining asoslari bilan tanishib chiqamiz.
HTML (Hyper Text Markup Language) - giper matnlarni belgilash

tili degan ma'noni angiatadi. HTML - web sahifada matn, tasvir va
boshqa ma'lumotlarni qanday ko'rinishda joylashtirilishini belgilovchi
vosita. Bu til 1989-yilda Jenevada Tim Berners-Li (Tim Berners-Lee)
tomonidan yaratilgan. Keyinchalik Tim Berners-Li «Internet otasi»
nomiga sazovor bo'lgan. Til dasturlash tili emas, faqat Web-sahifa
yaratish uchun mo'ljallangan. Web-sahifada biror ma'lumotlarni qayta
ishlash algoritmlarini o'rnatish uchun Java tilida tuzilgan dasturlardan
foydalaniladi.

Ushbu ma'lumotlardan foydalanib, ko'zda tutilgan asosiy maqsad
-HTML haqida asosiy tushunchalarni misollar yordamida tushuntirib
berish, HTMLning bir-oz qiyin bo'lgan elementlari hisoblanmish jadval
tuzish, freymlardan foydalanish va sahifaga tasvirlarni joylashtirish,
sahifalarni bir-biriga faol havolalar orqali bog'lash usullarini ko'rsatib
berishdan iborat.

Teg tushunchasi

HTML sahifa - bu oddly matn fayl bo'lib, HTML kengaytmasiga
ega. HTML sahifani yaratish uchun maxsus dastur shart emas. Har
qanday matn muharriri yordamida HTML sahifa yaratish mumkin.
Ana shunday matn tahrirlovchi oddiy dasturlardan biri bo'lgan Notepad
(Блокнот) standart holatda Windows mo'hitida mavjud. HTML
sahifaning asosiy elementlaridan biri bo'lgan teglar haqida dastlabki
tushunchalar bilan tanishib chiqamiz.

HTML teg

HTML teg bu HTML hujjatdagi turli elementlarni (matn, tasvir
va boshqalar) web sahifada qanday ko'rinishda aks etishi lozimligini
brauzerda ko'rsatuvchi buyruqlar hisoblanadi. Teglar ma'lum o'lcham
va vazifani bajariwchi buyruqlardir.
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Teg quyidagi ko'rinishda boMadi: <TEG> hujjat elementi </TEG>
Ko'rib turganingizdek teglar < > uch burchaksimon qo'shtironoq

(burchak qavs) ichiga olib yoziladi. Uch burchaksimon qo'shtironoq
ichiga teg nomi va uning atributlari yoziladi.

Quyida teg va uning atribut yozilishiga misol keltirilgan:
<B> <FONT COLOR=«red»> Hello World! </FONT> </B>

Misolda keltirilgan teglar HTML hujjatga kiritilgan Hello World!
jumla qizil rangda, ajratilib yoziladi. Teglar orasida kiritilgan matn, teg
atributida qanday vazifalar berilgan bo'lsa, shu vazifaga bo'ysungan
holda ekranda hosil bo'ladi. Bu misolda Hello World! jumlasiga
nisbatan ikkita teg ishlatilgan. 1 - teg <B> va 2 - teg <FONT> Hello
World! jumlasidan key in yana ikki teg </B> va </FONT> yozilgan.
Bularning farqi shundaki, birinchi ikkita teg ochuvchi va jumladan
so'ng yozilgan ikkita teg esa jumla oldida yozilgan teglarni davomi
ya'ni yopuvchi tegdir. Yopuvchi teglarning vazifasi ochilgan teg ta'sir
maydoni tugaganligini belgilashdan iborat. HTML hujjatda deyarli
barcha teglarni yopish lozim. '/" belgisini qo'yish orqali yopuvchi teg
yasaladi.

Eslatma: har doim eng oxirgi ochilgan tegni birinchi navbatda
yopishni unutmang. Teglarning ochilishi vayopilish tartibini almashtirib
yubormang. Aks holda xatoliklar kelib chiqishi mumkin.

Endi e'tiborimizni <FONT COLOR=«red»> ga qaratamiz. FONT
(shrift) teg nomi, COLOR (rang) — esa tegning tarkibidagi qo'shimcha
atribut, red (qizil) — rangning belgisi. Bu teg matnni qizil harflar bilan
yozilishini anglatadi. Ayni misolda ranglarni o'zgartirish uchun red so'zi
o'rniga boshqa rang nomini kiritish kifoya. Matn shu zahoti siz kiritgan
rang bilan ifodalanadi. Ushbu teg va uning qo'shimcha atributlari
qanday yozilishini eslab qoling. Bu sizga keyinchalik ham as qotadi.
Teglarning atributi bir nechta bo'lishi mumkin va ularni kiritganda har
— biri orasida bo'sh katakcha ya'ni probel qoldirishni esdan chiqarmang.

HTMLda teglarni ishlatish shartlari

Siz yuqorida teg tushunchasi haqida qisqacha tushunchaga ega
bo'lgansiz. HTML teglarni ishlatganda ularni to'g'ri yozish muhim
ahamiyatga ega. Quyida teglarni to'g'ri yozish va ishlatish shartlari
haqida so'z yuritamiz. Bu borada quyidagi qoidalar mavjud;
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Barcha teglar uch burchakli qo'shtirnoq ichida yoziladi
'<TEG>'.

^ Ochuvchi teg - uch burchakli qo'shtirnoq, teg nomi va uning
qo shimcha atributiari (zarur bo'lgan taqdirda). Yopuvchi teg -
uchburchakli qo'shtirnoq, У slesh belgisi va teg nomi.

• Probel orqali yoziluvcbi teglar atributiari.
Teg nomidan so'ng uning qo'shimcha o'lchamlari bo'lishi mumkin.

Barcha atributlar probel orqali ajratib yoziladi. Bitta harf hajmidagi
bo'sh joy qoldirilish HTMLda probelni anglatadi.

<TEG 1 - atribut=yuklatilgan vazifa 2 - atribut=yuklatilgan va-
zifa...>

• Qo'shtirnoq ichida yoziluvcbi yuklatilgan vazifalar ma'nosi.
^ Ma'lum vazifani bajaruvchi buyruqlar tenglik belgisidan

so'ng qo'shtirnoq «...» ichida yoziladi. Agar probel ishlatilmagan
taqdirda qo'shtirnoqni tushirib qoldirish mumkin. <FONT SIZE=2
FACE—«Times Roman»> Har hil hatoliklar kelib chiqishini oldini olish
uchun qo'shtirnoqlarni ishlatish maqsadga muvofiq.

• Aksariyat teglar yakunlash buyrug'ini talab qiladi.
Agar siz tegni yopmagan taqdiringizda aksariyat hollarda hatolik

kelib chiqmaydi. Ammo ochilgan teg atributiari butun hujjatga ta'sir
qiladi. Jadval ichida yopilmagan taqdirda bu hatolikni keltirib chiqarishi
mumkin. Bu haqda jadvallar tuzish bo'limida so'z yuritamiz.

• Teglarni yopisb qoidasi
Har doim teglarni qat'iy tartibga rioya qilgan holda yoping. Birinchi

navbatda eng oxiri ochilgan teg yopiladi va shu tariqa navbati bo'yicha
barchasi yopiladi. <TEG1> <TEG2> <TEG3> ... </TEG3> </TEG2>
</TEGl>

• Teg harflar yozish shartlari.
HTML hujjatda teglarni katta yoki kichik harflar bilan yozilishi

hech qanday ahamiyatga ega emas. Hamma teglarni katta yoki
kichik harflar bilan yozishingiz mumkin. Hattoki mana bunday
<teg></Teg> Sizga maslahatimiz: barcha teglarni bir hil shaklda
yozgan ma'qul.

• Teg atributlarini yozish tartibi qanday bo'lisbl ahamiyatslz.
Teg tarkibidagi atributlar qanday tartibda yozishingiz hech qanday

o'zgarishlarga sabab bo'lmaydi. Quyidagi ikki variant ham to'g'ri:
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<TEG 1 - atribiit=yuklatilgan vazifa. 2 - atribut=yuklatilgan va-
zifa. 3 — atribut=yuklatilgan vazifa. >

<TEG 3 - atribut=yuklatligan vazifa. 1 - atribut=yuklatilgan va
zifa. 2 - atribut=yuklatilgan vazifa.>

HTML web-sahifa yaratish

Siz bilan birgalikda eng sodda HTML sahifa yaratishga harakat
qilib ko'ramiz. Buning uchun bizga Notepad (Блокнот) matn muharriri
kerak bo'ladi. Dasturni ishga tushirish uchun asosiy menyu Start
(Пуск) > Programs (Программы) > Accessories (Стандартные) >
Notepad (Блокнот) buyrug'ini tanlang.

Quyida keitirilgan HTML teglarni Notepad (Блокнот)§а qanday
bo'lsa shundayiigicha yozing:

<HTML>
<HEAD>
<TITLE> Eng sodda ko'rinishdagi HTML sahifa!</TITLE>
</HEAD>
<BODY BGCOLOR=«white)»
<B><FONT COLOR=«red»>Salom!</FONT></B><BR>
Bu mening ilk HTML sahifam.
</BODY>
</HTML>
Navbatdagi amalga oshiradigan ishimiz, uni kompyuter xotirasiga

saqlash. Buning uchun Notepad (Блокнот) dasturi File (Файл) menyusi
tarkibidagi Save As... (Сохранить как...) buyrug'ini tanlang va fayl
saqlanishi lozim bo'lgan papkani tanlang hamda faylni nomi.html
kengaytmasi bilan saqlang.

Eslatma: har qanday HTML sahifa html yoki htm kengaytmasiga
ega bo'ladi. Faylni kompyuter xotirasiga saqlagach, uni brauzer
dasturlari yordamida ochishingiz raumkin. Brauzer dasturlari internet
ishlashini ta'minlovchi maxsus dasturlar hisoblanib, gipermatnni
o'qish, web-resurslarda navigatsiyalash va ko'rib chiqish dasturidir.
Web-brauzeri gipermatnlarni o'qishdan tashqari, tovushni va video
ma'lumotlarni qaytadan chiqarish, ya'ni, gipermediani qayta chiqarish,
tarmoqning boshqa kompyuterlari bilan ulanishni o'rnatish va ularda
ishlayotgan serverlarga web-hujjatlarga so'rovlarni yuborish, tarmoqning
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boshqa foydalanuvchilari bilan muloqot tashkil qilish va uni quvvatlash
kabi qo'shimcha imkoniyatlarga ega boMishi mumkin. Eng ommaviy
tarqalgan web-brauzerlarga misol qilib Internet Explorer, Opera, Avant
Brauzer, Mozilla kabi dasturlarni aytishimiz mumkin. 1.2-jadvai
brauzer dasturlarning ro'yxati va imkoniyatlari keltirilgan.

I.2-jadval

Brauzer dasturlari ro'yxati

№ Brauzer nomi: Imkoniyatlari

I. Opera 10.63 Opera Software kompaniyasi dasturidir. Bu dastur
43 tildagi foydalanuvchilar uchun mo'ljallangan
bo'lib, Windows, Linux va Mac operatsion
tizimlarida ishlaydi.

2. Mozilla Firefox Mozilla Firefox - tezkor, ko'p funksiyali brauzer
dasturi. Firefox dasturida bir oynada bir nechta
sahifani ochish mumkin. Shuningdek, siz
giper havolalarni shu sahifani (siz ayni paytda
ko'rib turgan sahifani) tark etmasdan turib
ochish imkoniyatiga ega bo'lasiz. Brauzer web
standartiarni juda yaxshi qo'llab, unda juda quiay
interfeys mavjud va o'zida qidiruv paneli (Google
va boshqalar) joylashgan.

3. Google Chrome Google Chrome - bu brauzer, murakkab tex-
nologiyalarni va sodda dizaynni biriashtirgan
va bu esa Internetda ishlashni tezlashtiradi va
xavfsizligini oshiradi.

4. Apple Safari Apple Inc. kompaniyasining brauzer dasturi
hisoblanadi. Dastlab dastur Mac OS operatsion
tizimi uchun ishlab chiqilgan edi. Dasturda ko'p
oynalik interfeys mavjud bo'lib, unda xavfsizlik
uskunalari bilan boyitilgan.

5. Maxthon Internet-brauzer dasturi. Maxthon web-sahifalarni
ko'p oynali rejimda ko'rish imkonini beradi.
Dasturning asosiy xususiyatlaridan biri ko'p sonli
bog'lanishlar imkoniyati mavjud.
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6. Avant Browser Bu brauzer ham ko'p oynali rejimda ishlaydi.
Ya'ni asosiy oyna ichida ko'plab oynalami ochish
imkoniyati mavjud. Avant Browser dasturida
sichqoncha tugmasini'6ir bosish bilan grafiklar,
video, tovushlar va Flash animatsiyalami yuk-
lashni taqiqiash yoki aksincha ruxsat berish
imkoniyati mavjud.

7. Netscape Navigator Dastur o'zining oddiy va yengil sozlanadigan
foydalanuvchi interfeysi bilan va tezkorligi, ish-
lashga qulayligi hamda web-sahifalarni ko'rishni
boshqarish imkoniyatlari kengaytirilgan.

Bizga ma'lumki yaratilgan web-sahifalarni ishlatib ko'rishda
o'zimiz bilgan yoki bilmagan holda brauzer dasturiga murojaat qilamiz.
Ana shu paytda yaratilgan web sahifani ochish uchun uning fayli
ustida sichqonchaning chap tugmasini ikki raarta ketma-ket bosish
yetarli. Bundan tashqari avvai brauzer dasturini (Internet Explorer)
ishga tushirib olib, keyin esa File > Open buyrug'ini berish orqali
ham faylni ishga tushirish mumkin. Hammamizga ma'lumki, web
sahifani yaratish vaqtida uning qanday dizaynda chiqayotganini ko'rish
uchun biz brauzer dasturlariga qayta — qayta murojaat qilamiz. Ayrim
professional dasturlarda (Dreamweaver va boshqalar) natijani ko'rish
uchun to'g'ridan-to'g'ri maxsus tugma bosiladi. Bunda to'g'ridan-
to'g'ri belgilangan brauzerda sahifa yuklanadi. Bu haqida Dreamweaver
dasturida batafsil ma'lumot beramiz.

HTML hujjatning a&osiy strukturasi

Siz yaratgan ilk HTML sahifa asosida HTML hujjat asosiy
strukturasini tahlil qilamiz. Kompyuter xotirasiga saqlangan HTML
hujjatni Notepad dasturi yordamida oching. Har qanday HTML hujjat
ichki qismi quyidagilardan tashkil topgan bo'ladi:

<HTML>

bu teg HTML hujjatni ochish (boshlash) uchun xizmat qiladi va u
HTML hujjatning birinchi ochuvchi va oxirgi yopuvchi teg hisoblanadi.
Boshqacha aytganda web sahifaning boshlanish va tugash chegarasini
ifodalaydi. Uning yagona vazifasi, mazkur hujjatni ochayotgan dasturga
bu fayl HTML hujjatligi haqida axborot berishdan iborat.
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<HEAD>

HEAD tegidan so'ng HTML hujjatning tizimli axborotlari haqida
ma'lumot beradi. Bizning misolimizdagi yagona tizimli axborot -
TITLE tegi hisoblanadi.

<TITLE>

Bu teg ochuvchi teg <HEAD> va yopuvchi teg </HEAD> orasida
yoziladi. Ochuvchi va yopuvchi TITLE orasida kiritilgan axborot siz
yaratayotgan hujjat nomini anglatadi. Siz kiritgan nom brauzer dasturi
tomonidan va internetdagi qidiruv tizimlari tomonidan ishlatiladi. Biz
keltirilgan misoida «Eng sodda ko'rinishdagi HTML sahifa!» niatni
brauzer dasturi yuqori qismida ya'ni sarlavha satrida namoyish etiladi.

<BODY>

BODY ochuvchi va yopuvchi teglari orasida yozilganlarning
bai'chasi sizning HTML hujjatingizning tanasi hisoblanadi. Agar siz
ushbu teg orasiga matn yozsangiz yoki tasvir kiritsangiz — bularning
barchasini brauzer ekranda namoyish etadi.

Har qanday HTML hujjat quyida keltirilgan tartibda yozilishi shart:
<HTML> HTML hujjat boshi <HEAD> Hujjat nomlanishining

boshlanishi <TITLE> ... </TITLE> HTML sahifa nomi (sarlavhasi)
<HEAD> Hujjat nomlanishining yakunlanishi <BODY BGCO-
LOR=«white»> Hujjat tanasining boshlanishi ... </BODY> Hujjat
tanasining yakunlanishi </HTML> HTML hujjat yakuni.

HTML sahifaga tasvir joylashtirish

Internet bilan ishlovchi dasturlar tasvirlarni (grafik elementlarni)
ochish imkoniga ega bo'lishi bilan internetda mavjud sahifalarning
deyarli barchasi tasvirli axborotlarni nashr eta boshladi. Siz yaratgan
web-sahifa qiziqarli va chiroyli dizayn asosiga qurilgan boMsa uning
o'quvchilari soni shubhasiz ortadi. Tasvirlar yordamida harakatlanuvchi
tugmalar va Gif animatsiyalarni kiritish mumkin. Biroq tasvirlar bilan
ishlashda ularni hajmi va formatiga e'tibor berish kerak. Hozirgi paytda
internetga joylashtirilayotgan deyarli barcha sahifalarda ishlatilayotgan
tasvirlar formati *.JPEG yoki *.GIF ni tashkil etadi. Bunga asosiy
sabab, bu formatdagi tasvirlar hajmi juda kichik. Bu formatdagi
tasvirlar ishlatilganda web-sahifa hajmi ortib ketmaydi va sizning web
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sahifangizdan foydalanuvchi sahifani internetda ochilishini uzoq vaqt
kutmaydi.

Agar siz boshqa formatdagi tasvirlardan web-sahifani bezashda
foydalansangiz uning hajmi ortib ketadi va undan foydalanuvchilarga
sahifani ochishda muammolar keltirib chiqaradi. Web-sahifani
bezatishda uning dizayniga *.GIF formatdagi tasvirlardan foydalaning.
Boshqa maqsadiarda *.JPEG dan foydalanishingiz mumkin.

<img> tegini qo'llash qoidalari

<IMG> tegi bilan bog'liq bo'lgan, quyida keltirilgan asosiy qoidalar
bilan tanishib chiqing va o'z sahifangizni yaratishda ushbu qoidalarga
doim rioya qilishga harakat qiling.

• Tasvir nomi va joylashgan o'rnini yozganda harflarning bir
hilda bo'Iishini ta'minlash katta ahamiyatga ega. Tasvir joylashgan
papka nomi va tasvirning nomini kiritganda harflarni bir hilda yozilishi
shart. Biror bir harfni tushirib qoldirish yoki hato yozilishi tasvirni
ochishda hatoliklarni keltirib chiqaradi.

• Tasvir yoki papka nomini kiritganda probel isblatmang. Web-
sahifani yaratayotganingizda fayllar yoki papkalar nomini kiritganda
probel (bo'sh Joy) ishlatmang. Agar siz kiritgan nom ikki yoki undan
ortiq so'zlardan iborat bo'lsa, probel o'rnida (pastgi chiziqcha)
ishlatishingiz mumkin. Masalan: .../Chet_elga_sayohat/Ispaniya/Ma-
laga_01.Jpeg

• Internetda ishlatiluvchi tasvir formatlari. Hozirgi paytda
internetda ikki hil formatdagi tasvirlar keng qo'llanilib kelinmoqda. Bu
formatlar: GIF (bu formatdagi tasvirlar *.gif qisqartmasiga ega) hamda
JPEG (bu formatdagi tasvirlar esa *. jpg yoki *.jpeg qisqartmasiga ega).
Siz ham ushbu formatdagi tasvirlardan foydalaning. Boshqa formatdagi
tasvirlarni aksariyat brauzerlar ocha olmaydi.

• Har doim WIDTH va HEIGHT atributlarini kiritishga
harakat qiling. Bu sizning web-sahifangizni ochilishini tezlashtiradi
va tasvirlarni asl o'lchamda bo'Iishini ta'minlaydi.

• Tasvir hajmini sun'iy kichraytirish. WIDTH va HEIGHT orqali
tasvirning real atribut o'lchamlarini kichraytirish mumkin. Ammo
bu usuldan iloji boricha kamroq foydalanish kerak. Eng yaxshi usul

29



tasvirni real o'lchamini grafik muharrirlar yordamida kichraytirishdir.
Bu usul tasvirning ochilish vaqtini kamaytiradi.

• Tasvir hajmini sun'iy kattalashtirish. Tasvir o'lchami kat-
talashtirilganda yoki kichraytirilganda uning sifatida o'zgarish
sodir bo'ladi. Agar siz o'lchamlarni o'zgartirganda bo'yi va enini
proportsionalligiga e'tibor bermasangiz, tasvir sifatini buzilishiga
olib keladi. WIDTH va HEIGHT atributiari orqaii tasvir hajmini
kattalashtirganda, real o'lchamni 2 marta, 3 marta va shu tariqa
oshishiga erishish kerak. Masalan, tasvirning real oMchami WIDTH=
=«100», HEIGTH=«200» ga teng bo'lsa, uni ikki marta kattalashtir
ganda WIDTH=«200», HEIGTH=«400» ga teng bo'lishi shart. Bu usul
tasvir sifatidagi salbiy o'zgarishlarni bir oz yumshatadi. Shuningdek,
ayni holatni tasvir o'lchamini kichraytirishda ham qo'llash maqsadga
muvofiq.
. Наг doim ALT atributini qo'IIang.
Har doim ALTdan so'ng tasvirga aloqador qo'shimcha axborotni

kiritishga harakat qiling. Buning asosiy sababi, siz joylashtirgan tasvir
ochilmagan taqdirda, Internetdan foydalanuvchi siz kiritgan tasvir
izohini o'qiydi va minimum axborotga ega bo'ladi.

Giperhavolalar - web-hujjatlarni bir-biriga bog'lash
Web-sahifaga tasvir joylashtirishni o'zlashtirib olganingizdan so'ng,

endigi navbatda havolalar haqida tushuncha olishning ayni mavrudi.
Havolalar tufayli internet hozirgi mavqeiga erishdi. Havolalar yordamida
ikki va undan ortiq (cheksiz) web-sahifalarni bir-biriga bog'lashingiz
mumkin. Havola rus tilida «ссылка» deb ataladi. Havolaga bosish
orqaii siz ikkinchi sahifani ochishingiz mumkin. Havolalar yordamida
web-sahifangiz uchun menyu tuzishingiz mumkin. Havolalar sizning
web-sahifangizdan foydalanuvchini sahifa bo'ylab tom ma'noda sayohat
qilishi imkonini beradi va unga to'g'ri yo'lni ko'rsatib turadi.

Havolalar

Havola - bu HTML hujjatning boshqa HTML hujjat bilan bog'lovchi
qismi. Unga kursorni bosishingiz bilan ikkinchi HTML hujjat ekranda
namoyon-bo'ladi. Shuningdek, havoladan (agar siz yaratgan bir sahifada
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juda ham ko'p matn kiritilgan bo'lsa) bitta sahifa ichida boshqa HTML
hujjatni ochmasdan turib ham foydalanish mumkin. Sizga maslahatimiz,
agar bitta sahifaga joylashtirmoqchi bo'lgan matn juda ham ko'p bo'lsa,
uni iloji boricha turli bo'laklarga bo'lgan holda, bir nechta HTML
faylga joylashtiring. Shunday qilsangiz, web-sahifadan foydalanish oson
kechadi.

Navbatdagi sahifalar bilan tanishib chiqqach siz havolalarni ishlatish
usullarini va havola tuzish uchun qanday HTML tegiardan foydalanish
zarurligini bilib olasiz.

Havolalar tuzish usullari

Havolalarni ta'sir doirasi va ularni qaysi sahifa bilan bog'lash
vazifasini <A> ochuvchi hamda </A> yopuvchi teglari orasida bel-
gilanadi. Ushbu teglar orasida uning atributlari va kalit so'z
joylashtiriladi.

Ushbu teg orasida nimalarni Joylashtirish mumkin? Deyarli
hamma narsani. Bu matn, tasvir, jadval va hatto harakatlanuvchi
tasvir ham bo'lishi mumkin. Ulardan qaysi birini joylashtirish
o'zingizga havola.

Bu bo'limda oldimizga qo'ygan maqsadimiz havolalar tuzish.
Maqsadga erishishning eng oson usuli barchasini oddiy misollardan
boshlash. Shunga amal qilgan holda sizga havola tuzishning eng oddiy
misolini keltiramiz:

<A HREF=«pictures.htmr'>Bu sahifada mening hayotim bilan
bog'liq tasvirlar joylashgan.</A>

Natija mana bunday ko'rinishda bo'ladi:
Bu sahifada menine havotim bilan boe'lia tasvirlar iovlashean.

so'zini bosishingiz bilan pictures.html sahifasi ekranda namoyon
bo'ladi. <A> tegining qo'shimcha atribut bo'lgan HREF sizni pictures,
html sahifasiga olib boradi.

Tasvirlarni havola sifatida namoyon etish uchun <A> va </A> teglari
orasida <IMG> tegi yordamida tasvirda qaysi faylni nimani qo'yish va
u joylashgan papkaga yp'lni ko'rsating.

<A HREF = «pictures.HTML»> <IMG SRC = «img/photo.jpg»
WIDTH = «100» HEIGHT = «100» ALT= «Mening foto galereyam»>
</A>
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Havolalar — <A> tegining qo'shimcha atributlari tasnifi

Boshqa HTML teglari kabi <A> tegining ham qo'shimcha atributi
mavjud. Quyida ushbu buyruqlarning tasnifi keltirilgan.

HREF

Bu atribut yordamida havola qilinishi lozim bo'lgan HTML hujijat
nomi va uning joylashgan joyi belgilanadi. Bu atribut <IMG> tegining
SRC atributi kabi bir hil vazifani bajaradi. <IMG> tegining SRC
atributi yordamida tasvir nomi va u joylashgan papkaga yo'i ko'rsatilsa,
HREF yordamida HTML hujjat nomi va u joylashgan papkaga yo'l
tasvirlanadi.

TARGET

Bu atribut HTML hujjatni aynan o'sha oynada yoki alohida oynada
yoki qaysi freymda ochilishini belgilaydi. TARGET atributining
qo'shimcha o'lchamlari: _Ыяпк - brauzerda siz ishlab turgan oynadan
tashqari yangi oynada ko'rsatilgan hujjatni ochish.

_top - web sahifada freymlar ishlatilgan bo'lsa, havolada
ko'rsatilgan hujjatni faol oynada freymlai- strukturasini buzgan holda
ochadi. Ochilgan oynada freym alomatlari mavjud bo'lmaydi.

_parent - havolada ko'rsatilgan hujjatni avval ochilgan oynada
ochiladi.

_self — havola qaysi freym yoki freymdan holi sahifada ishlatilgan
bo'lsa aynan o'sha sahifada ochadi.

<A HREF=«pictures.html» TARGET=«_blank»>Bu sahifada</A>
mening hayotim bilan bog'liq tasvirlar joylashgan. <BR> Bu sahifada
siz <A HREF=«about.html» TARGET=«_top»> men haqimda </A>
qiziqarli ma'lumotlarni o'qishingiz mumkin.

Natija mana bunday ko'rinishda bo'ladi:
Bu sahifada mening hayotim bilan bog'liq tasvirlar joylashgan.

Sahifada siz men haqimda qiziqarli ma'lumotlarni o'qishingiz mumkin.
Ushbu , havolalardan biriga bosib, siz havolada belgilangan HTML
hujjatdagi ma'lumotlarni o'qishingiz mumkin.
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E-MAIL havola

E-mail (Elektron pochta) manzillarni faollashtirish uchun havola
tuzish mumkin. E-mail manzil ko'rsatilgan havolani bosish bilan
kompyuterga o'rnatilgan elektron pochtalar bilan ishlovchi dastur
faollashadi va unda havolada ko'rsatilgan elektron pochta manzili
ko'rsatilgan yangi oyna hosil bo'ladi va siz ko'rsatilgan manzilga xat
jo'natishingiz mumkin.

E-mail manzilni havola sifatida belgilash uchun HREF atributi
o'rnida mailto: elektron pochta manzili yoziladi. Misol uchun:

Mening <A HREF=«mailto: tsamar@mail.ru»> elektron poch-
tamga</A> ushbu o'quv qo'llanma haqidagi fikr - mulohazalaringizni
yozing!

Natija mana bunday ko'rinishda bo'ladi:
Mening elektron poshtamga ushbu o'quv qo'llanma haqidagi fiki-

mulohazalaringizni yozing!

Havolalar yozishning asosiy qoidalari

Quyida havola tuzishda bilishingiz lozim bo'lgan oddiy qoidalar
yozilgan. Ularni diqqat bilan o'qib chiqing va eslab qolishga harakat
qiling. Havola tuzishda bu qoidalarga amal qilsangiz, siz tuzgan
havolalar hatoliklarsiz ishlaydi.

• Harflarning bir Hilda yozish va fayl yoki papka nomini to'g'ri
ko'rsating. Havola tuzilganda eng katta e'tiborni siz murojaat qilmoqchi
boigan faylga olib boruvchi yo'l aniq va to'g'ri ko'rsatilishi lozim.
Bunda papka va fayl nomiga katta..e'tibor qarating. Ularning nomida
arzimagan hatolikka yo'l qo'ysangiz havola ishlamaydi. Aytaylik biror
bir harfni tushib qolishi yoki bosh harf o'rniga kichik harf bilan yozilsa
hatolik yuz berishi muqarrar. Shu bois, havola tuzishda aniqlik katta
ahamiyatga ega.

• Fay! va papka nomini kiritganda probel ishlatmang. Web-
sahifa yaratish jarayonida fayl va papkalarni nomi ikki va undan ortiq
so'zdan iborat bo'lsa so'zlar orasida va oxirida probel ishlatmang.
Probel ishlatilgan fayl yoki papkaga havola murojat qilganda hatolik
sodir bo'ladi.

• Kalit so'zlarga havola tuzish. Biror hujjat ichidagi kalit so'zga
havola tuzganda, eng avvalo kalit so'zni <A> tegining NAME buyrug'i
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yordamida belgilab olisli lozim. So'ngra shu tegning HREF atributi
orqali u joylashgan fayl nomi (agar kalit so'z boshqa faylda joylashgan
bo'lsa) va kalit so'z manziiini ko'rsating HREF = «fayl noml.HTML#
kalit so'z».

• FTP server va E-MAIL uchun maxsus havola. FTP serverda

joylashgan faylga havola tuzganda 'FTP://' bilan boshlanuvchi manzilni
yozing. E-MAIL havola tuzganda esa «mailto: e-mail manzibmi
yozing.

Matnlarni tahrirlash

Matn tahrirlashni o'zlashtirib olishingizni osonlashtirish uchun
uni ikkiga bo'lib tushuntirishni lozim topdik. Ularning bar biri matn
tahrirlashda ishlatiladigan HTML teglarni batafsil tahlili misollar
yordamida aks ettirilgan.

• Matnning alohida bo'laklarini tahrirlovchi teglar;
• Matnning yirik bo'laklarini tahrirlovchi teglar.

Matnning alohida bo'laklarini tahrirlovchi teglar

Quyida tasnifi keltirilgan barcha matn tahrirlash uchun ishlatiluvchi
teglar ochilgandan so'ng ularni yopish shart. Ochilgan tegning ta'sir
doirasi u yopilgunga qadar davom etadi. Agar siz tegni yopishni
unutsangiz, uning ta'sir doirasi hujjat oxirigacha davom etadi. Barcha
teglash quyidagi tartibda yoziladi: <TEG1><TEG2> Kerakli matn </
TEG2></TEG1>. Har doim eng oxiri ochilgan tegni birinchi bo'lib
yopishni unutmang.

<B> Kerakli matn </B>

Bu teg orasida yozilgan matn qalin harflar bilan belgilanadi.
<l>Kerakli matn<l\>

Matn o'ng tomonga egiltirib yoziladi.
<BIG>Kerakli matn</BIG>

Matnni kattalashtirish. Yozilgan matn boshqalariga nisbatan
kattalashtirilgan harflar bilan belgilanadi.

<SMALL>Kerakli matn</SMALL>

Matnni kichraytirish. Yozilgan matn boshqalariga nisbatan ki-
chiklashtirilgan holda belgilanadi.
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<STRIKE>Kci-akli niatii</STRIKE>
Teg orasida yozilgan matn ustidan chiziq tortiladi.
<STRONG>Kerakli matn</STRONG>
Matn ichidagi ayrim so'zlarni kuchli ajratib koTsatish uchun

ishlatiladi.

Kerakli <SUB> </SUB>
matn

KoTinib turganidek bu teg orasida kiritilgan matn, matn chizig'idan
pastda kichik harflar bilan yoziladi (indeks).

Kerakli <SUP>'"'""</SUP>

Yuqorida keltirilgan tegning teskari shakldagisi bo'lib, u matnni
yuqorida kichik harflar bilan yozilishini ta'minlaydi (daraja).

<U>Kerakli matn</TI>

Yozilgan matn ostida chiziq tortiladi. Bu teg yordamida ayrira
so'zlarni belgilab ko'rsatish mumkin.

<CENTER>Kerakli matn</CENTER>
Bu teg kiritilgan matnni sahifa o'rtasida bo'lishini ta'minlaydi. Agar

bu teg jadval ichida qo'llansa, u holda bu jadval katakchasi ichidagi
matnga ta'sir etadi. Bu tegni jadval ichida qo'llash usullari haqida
jadvallar bilan ishlash bo'limida tushuntirib o'tamiz.

<BR>

Bu teg matn qatorlarini surish uchun xizmat qiladi. Ma'lum
jumladan so'ng ikkinchi Jumlani yangi qatordan boshlamoqchi
bo'lsangiz, Jumla so'ngida ushbu tegni yozing.

Endi hech boimaganda bitta qo'shimcha buyruqqa ega bo'lgan
teglar bilan tanishib chiqamiz.

<FONT>Kerakli matn</FONT> '"
Bu teg harfning qo'shimcha atributlarini belgilash uchun ishlatiladi.

Quyida ushbu tegning eng ko'p qo'llaniladigan qo'shimcha atributlari
bilan tanishib chiqamiz:

SIZE

Harf o'lchamini belgilashda qo'llaniladi. Matndagi harflar o'lchamini
1 dan boshlab xohlagan son bilan belgilash mumkin.

Masalan: <FONT SIZE=«5»>Salom!</FONT> Bu mening web
sahifam. <FONT SIZE=«2»>(Izoh)</FONT>
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Bundan tashqari siz SIZE o'lchamlarini plyus + va minus - bilan
ham belgilashingiz mumkin. Bu usul qo'llanganda haif o'lchami
ishlatilayotgan harfga nisbatan katta yoki kichik belgilanadi. Misol
uchun siz 3 ga teng kattalikdagi harfdan foydalanayotgan bo'lsangiz,
SIZE=«+2» barf o'lchami SIZE=«5» ga, SIZE=«—1» o'lchami esa
SIZE=«2» ga teng bo'ladi.

COLOR

Bu atributdan so'ng rang nomi yoki rangni belgilovchi olti xonali
lotin harflari hamda raqamli kod kiritiiadi va shu tariqa harf rangi
belgilanadi. Turli brauzeriar turli rang nomlarini belgilay oladi. Rang
nomlari ingliz tilida kiritiiadi. Rang nomi va ko'rinishini yodlab
olishingiz uchun ularning har birini nomi o'sha rangda belgilangan.
Bu ranglarni Netscape Navigator va Internet Explorer brauzerlari
muammosiz taniydi va o'qiy oladi.

Rangni belgilovchi lotin alifbosi va raqamli kod simvol bilan
boshlanadi. Raqamlardan I dan 9 gacha yoki A dan F gacha bo'lgan
lotin harflarini ishlatish mumkin. Rang kodi qanday bo'lishidan qaCiy
nazar u RGB (RED - qizil, GREEN - yashil, BLUE - ko'k) ranglar
tizimida aks ettiriladi. Rangni belgilash uchun uchta rangni bir-
biriga qo'shish lozim. Har bir rang ulushini 0 dan 255 gacha bo'lgan
miqdorda belgilanadi. Misol uchun toza qizil rangni belgilash
uchun qizil rang miqdorini 255 ga. yashil va ko'k ranglar miqdorini
esa 0 ga tenglashtirish lozim va bu mana bunday yoziladi <FONT
COLOR=#FFOOOO>. Olti xonali alifboli — raqamli kodini qo'llash juda
ham qiyin. Shu bois ranglar kodini belgilab beruvchi jadvalimizdan
foydalanishingiz mumkin.

FACE

Matnni qanday shriftda yozilishini belgilash uchun shrift nomi
keltiriladi. SHrift nomi kompyuterda o'rnatilgan bo'lishi kerak yoki
umumiy ishlatiladigan shriftlardan foydalanish mumkin. Agar siz
qo'llagan shrift foydalanuvchining kompyuterida topilmagan taqdirda
brauzer standart shriftni tanlaydi.

Masalan;

<FONT FACE=«Arial»>Salom!</FONT>
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<FONT FACE=«Times New Roman, Arial, Courier New»>Bu
mening web sahifam.</FONT>

Siz bar doim <FONT> tegining FACE atributini taniaganingizda,
standart shrift turlaridan foydalaning. MiSol uchun Windows muhitida
ishlovchi barcha kompyuterda o'rnatiladigan standart shriftlar quyida-
gilardan iborat:

Windows: Arial Arial Black, Arial Narrow, Courier, Courier New,
Garamond, Helvetica Times, Times New Roman.

Aytaylik siz Times va Times New Roman shriftining boshqacha
turini tanlagan bo'lsangiz, u holda foydalanuvchi kompyuterida bu
shrift o'rnatilmagan bo'lsa, brauzer siz tainlagan shriftni standart Times
New Roman shriftiga almashtiradi.

Ma tuning yirik bo'laklarini tahrirlovchi teglar

Endi siz bilan matndagi yirik bloklar va abzatslarni tahrirlovchi
teglar va ularning qo'shimcha buyruqlarining ishlash tartibini o'rganib
chiqamiz.

<PLAINTEXT>

Ushbu tegdan so'ng kiritilgan barcha HTML teglarning ta'sirini
butunlay kesadi va ular huddi ekranda ko'rsatilishi lozim bo'lgan
matn kabi aks etadi. Bu teg boshqa teglardan tubdan farq qiladi va
uni yopish shart emas. Agar matnda ayrim HTML teglarni ekranda
brauzer aks ettirishini xohlasangiz bu tegdan foydalanishingiz mumkin.
Biroq yuqorida aytganimizdek bu tegdan so'ng matnni HTML teglar
yordamida tahrirlash mumkin emas. Chunki ularni brauzer huddi
oddiy matn kabi tushunadi. Agar siz </PLAINTEXT> tegini kiritgan
taqdiringizda ham bu <PLAINTEXT> ta'sir doirasini cheklay olmaydi.
Web sahifangizda HTML teglarni matn shaklida aks ettirmoqchi
bo'lsangiz, u holda uch burchakli qo'shtirnoq '<' o'rnida &LT; simvolini
qo'llang.

<ADDRESS>

Kerakli matn

</ADDRESS>

Teg o'z nomi bilan adres ya'ni manzillarni belgilash uchun
ishlatiladi. Bu teglar orasida yozilgan manzilni har qaysi brauzer o'zi
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xohlagan tarzda namoyish etadi. Teg yopilganidan so'ng kiritilgan matn
yangi satrdan boshlanadi.

<BLOCKQUOTE>

Kerakli matn

</BLOCKQUOTE>

Bu teg matndagi paragraf va satiiarni belgilash uchun qo'llanadi.
<H1>, <H2>, <H3>, <H4>. <H5> va <H6>
yuqoridagi oltita teg sarlavhalarni belgilash uchun qo'llaniladi.

Sarlavhalar qalin harflarda yoziladi. Bu teglarning bir-biridan farqi
ularning o'lchamlarida. 1 dan 6 gacha bo'lgan sonlar saiiavha
o'lchamlarini katta-kichikligini quyida keltirilgan tartibda belgilaydi:

Sarlavha HI

Sarlavha H2

Sarlavha H6

<P>

Kerakli matn

</P>

Bu teg paragraflarni belgilaydi. Paragraf boshi va ohirida bo'sh
qator qoldiradi.

ALIGN

<P> tegining qo'shimcha atributi bo'lib u papagraf ichida yozilgan
matnni tekislash uchun ishiatiladi. Bu atributning qo'shimcha
o'lchamlari ALIGN - LEFT (matnni chap burchakdan tekislaydi),
RIGHT (o'ng tomonga tekislaydi), CENTER (sahifa maikaziga
tekislaydi) va JUSTIFY (matnni sahifa eni bo'ylab tekislaydi). JUSTIFY
ishlatilganda brauzer matnni chap va o'ng tomon bo'ylab bir xilda
tekislab chiqishga harakat qiladi. Bu jarayonda so'zlar orasi cho'zilib
ketishi ham mumkin.

<PRE>

Kerakli matn

</PRE>

Bu teg yordamida siz matnni qanday kiritgan bo'lsangiz shunday
ko'rlnishda bo'lishi ta'minlanadi. Quyida keltirilgan ikki misolda buni
yaqqol ko'rish mumkin. <PRE> tegidan tashqarida yozilgan matnda
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probel necha marta ishlatilishidan qat'iy nazar u bittaga hisoblanadi.
<PRE> tegi tarkibida kiritilgan matn qanday bo'lsa shundayligicha
ekranda ko'rinadi.

Hujjat asosiy qismini tahrirlash

Bu bo'Iimda hujjat tanasini belgilab beruvchi <BODY> tegi va
uning qo'shimcha buyruqlari haqida so'z boradi. <BODY> tegini
oldingi bo'iimlarda qisqacha tanishtirib o'tgan edik. Bu teg bevosita
HTML hujjatni ekranda ko'rinishi lozim bo'lgan matn, tasvir va boshqa
elementlarni o'z ichiga qamrab oladi. <BODY> ochuvchi hamda </
BODY> yopuvchi tegiari orasida barcha muhim elementlar joylashadi.
Bu tegning qanday qo'shimcha buyruqiarini quyida birgalikda ko'rib
chiqamiz.

BGCOLOR

Sahifaning orqa foni rangini belgilash uchun ishlatiladi. Bunda
rangning ingliz tiiidagi nomi yoki harf va sonlardan iborat kod
qo'llaniladi.

BACKGROUND

Sahifaning orqa foni uchun qo'Ilaniluvchi tasvir nomi va u
joylashgan papkaga yo'lni ko'rsatishda qo'llaniladi. Tasvir joylashgan
papkaga yo'lni ko'rsatish haqidagi maTumotlarni «HTML safi&ga tasvir
joylashtirish» bo'lirnida o'qishingiz mumkin.

TEXT

Hujjatda yozilgan matn harflarini qanday rangda bo'lishini rang
kodlarini kiritish orqali belgilab beradi. Agar siz ii'shbu atribut
ishlatmagan taqdiringizda matn rangi qora rangda bo'ladi.

LINK

Bu atribut qo'llanilgan sahifadagi havola rangi teg o'lchamlarida
qaysi rang kodi yoki nomi berilgan bo'lsa, o'sha rangda ekranda
namoyon bo'ladi.
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VLLNK

Bu atribut yordamida ishlatilgan havoialarni belgilab ko'rsatish
uchun qo'llaniladi. Siz foydalanuvchilar adashib ketmasligi va havolada
ko'rsatilgan sahifaga qayta kirmasligi hamda hali qoilanilmagan
havoialarni qo'llanilgan havolalardan ajratib ko'rsatish uchun ish-
latishingiz mumkin.

ALINK

Bu atribut kursor yordamida tanlangan va sichqoncha chap tugmasi
bosilgan paytda havola rangini o'zgartirish uchun ishlatiladi.

Siz hozir o'qigan sahifada <BODY> tegining barcha qo'shimcha
atributlari quyidagi tartibda qo'llaniladi.

<BODY BGCOLOR=#003399 TEXT=black LlNK=biue ALINK=

=red VLINK=#006666>

Ro'yxatlar tuzish

Sahifada matndagi ayrim elementlarni ro'yxatlangan tartibda yozish
qiyin emas va bundan tashqari o'quvchi matn bilan tanishib chiqishida
qulayliklar yaratib beradi. Siz huddi Microsoft Word matn muharririda
ro'yxatlarni qanday tuzsangiz huddi shu ko'rinishda HTML hujjatda
ham maxsus teglar yordamida belgilash imkoniga egasiz.

Bu bo'limda ro'yxatlangan tartibda matnni kiritish usullari bilan
tanishib chiqamiz:

<RO'YXATNI OCHUVCHI TEG>

< Ro'yxat elementining tegi > Matn
</ RO'YXATNI YOPUVCHI TEG >

Tartiblangan ro'yxat: Tartiblanmagan ro'yxat:
1. Ro'yxat dementi 1 • Ro'yxat elementi 1
2. Ro'yxat elementi 2 • Ro'yxat elementi 2
3. Ro'yxat elementi 3 • Ro'yxat elementi 3
Matn ro'yxatini belgilovchi teglar tarkibida siz HTMLning boshqa

matn tahrirlash uchun qo'llaniluvchi teglarini ishlatishingiz mumkin.

Ro'yxatlar tuzish - ro'yxatni tartiblash

Matn bo'laklarini tartiblashda sonlar yoki hai*flar bilan belgilash
mumkin. Shuningdek ayni jarayonda simvollardan ham foydalanish
imkoni mavjud.

40



Matn bo'laklarini tartiblashda <0L> ochiivchi va </0L> yopuvchi
teglaridan foydalaniladi. Ushbu teglar ichida tartiblanuvchi matn oldiga
<LI> atributi yoziladi. <OL> tegining yagona qo'shimcha o'lchami
TYPE bo'Iib, u tartiblovchi beigi ko'rinishini aniqlab beradi.

Arab raqamlari bilan belgilash:

HTML kodi

<0L TYPE=1>

<LI> Matn 1

<LI> Matn 2

<LI> Matn 3

</OL>

Natija

1. Matn 1

2. Matn 2

3. Matn 3

Rim raqamlari bilan belgilash:

HTML kodi

<0LTYPE=1>

<LI> Matn 1

<LI> Matn 2

<LI> Matn 3

</OL>

Natija

I. Matn 1

II. Matn 2

III Matn 3

Rim haiflari bilan belgilash:

HTML kodi

<OL TYPE=i>

<LI> Matn 1

<1.I> Matn 2

<LI> Matn 3

</OL>

Natija

i. Matn 1

ii. Matn 2

iii. Matn 3

Bosh harfalari bilan belgilash:

HTML kodi

<0L TYPE=A>

<LI> Matn 1

<LI> Matn 2

<LI> Matn 3

</0L>

Natija

A. Matn I

B. Matn 2

C. Matn 3
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Kichik harflar bilan belgilash:

HTML kodi Natija

<0L TYPE=a> a. Matn 1
<LI> Matn 1 b. Matn 2
<LI>Matn2 c. Matn3

<LI> Matn 3

</OL>

Ro'yxat tuzish - tartiblanmagan ro'yxat

Tartiblanmagan ro'yxat tuzishda <UL> va </UL> yopuvchi
teglaridan foydalaniladi. Ro'yxat ichidagi tartib <LI> atributi bilan
belgilanadi. <UL> tegi uchun ham TYPE o'lchami ishlatiladi. TYPE
o'lchami 3 xil turdagi ro'yxat kirita oladi:

Doirasimon belgi yordamida tartiblash:

HTML kodi

<UL TYPE = circle>

<LI> Matn 1

<LI> Matn 2

<LI> Matn 3

</UL>

Natija

Matn 1

Matn 2

Matn 3

HTML kodi

<UL TYPE = disc>

<LI> Matn 1

<LI> Matn 2

<LI> Matn 3

</UL>

Nuqtasimon belgi yordamida tartiblash:

Natija

Matn 1

Matn 2

Matn 3

To'g'ri to'rtburchaksimon belgi yordamida tartiblash:
HTML kodi

<UL TYPE=square>
<LI> Matn 1

<LI> Matn 2

<LI> Matn 3

</UL>

Matn

Matn 2

Matn 3

Natija
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Ro'yxat tuzish - aniqlashtiruvchi ro'yxatlar

Aniqlashtiruvchi ro'yxat va uning- izohidan iborat matnni tartibli
tuzish uchun bir-necha teglar ishlatiladi.

Aniqlashtiruvchi ro'yxatni <DL> ochuvchi va </DL> yopuvchi tegi
yordamida amalga oshiriladi. Aniqlashtiruvchi ro'yxat nomi <DT>
tegidan so'ng yoziladi va uni izohlovchi matn esa <DD> tegidan so'ng
kiritiladi. <DL> tegi qo'shimcha o'lchamlarga ega emas.

Aniqlashtiruvchi ro'yxat:
<DL>

<DT> Aniqlashtiruvchi asosiy so'z yoki jumla
<DD> Izoh beruvchi matn

</DL>

Jadval tuzish

Jadval tuzish - HTML bo'yicha o'zlashtirish qiyin bo'lgan bo'lim-
lardan biri. Shu bois bu bo'limni jadval tuzishni eng sodtja usullaridan
boshlaymiz. Web-sahifani mukammal darajada yaratishni xohlasangiz,
unda jadval tuzishni chuqur o'rganib olishingiz kerak. Qisqa qilib
aytganda jadvallar yordamida sahifani o'zingiz xohlagan tarzda
boshqara olishingiz mumkin. Jadval ichiga nafaqat matn, balki tasvir va
boshqa elementlarni tartibli joylashtirish mumkin.

Jadval tuzish - umumiy qoidalar

Jadval tuzishda ishlatiladigan teglarni tasniflashdan avval, oddiy
jadval tuzish sxemasi bilan tanishib chiqsak. Har qanday jadval
quyidagi sxema bo'yicha tuziladi;

<JADVALNI OCHUVCHI TEG>

<JADVAL QATORINI OCHUVCHI TEG>
<JADVAL BO'LAGINI OCHUVCHI TEG>

Matn, tasvir yoki jadval
</JADVAL BO'LAGINI YOPUVCHI TEG>

</JADVAL QATORINI YOPUVCHI TEG>
</JADVALNI YOPUVCHI TEG>

Har qanday jadvalda qatoiiar va ustunlar mavjud bo'ladi. Jadvalning
bo'lakchalarida esa axborot kiritilishi mumkin. Yuqorida keltirilgan
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misoldan ko'rinib turibdiki, bitta ustun, bitta qator va bitta katakchadan
iborat jadvalni tuzish uchun jadval ochiladi va yopiladi. Bitta ustundan
iborat va bir nechta qatorni o'z iciiiga olgan jadvalni tuzish uchun.
jadval qatorini ochuvchi va yopuvchi teglar orasiga bir nechta jadval
katakchalarini ochuvchi va yopuvchi teglarini kiritish lozim.

Oddly jadvallar tuzish

Jadval tuzish usullarini tushunib olish uchun dastavval eng oddly
jadvalni tuzishni o'rganamiz. Biz tuzmoqchi bo'lgan jadval uchta
ustundan iborat bo'ladi va har bir ustunda 3 dona katakchalar o'rin

oladi. Jadvalning birinchi ustunini «Mahsulot», ikkinchisini esa -
«Rangi», uchinchisini «Narhi» deb nomlaymiz. Biz tuzgan jadval mana
bunday ko'rinishda bo'ladi:

1.3-jadval

Mahsulot Rangi Narhi (so'm)

Qalam Qora 100

Qalam ochgich Qora 500

Endi ushbu jadvalni tuzishda qanday HTML teglardan foyda-
lanilganligini ko'rib chiqamiz:

<TABLE>

<TR>

<TD>Mahsulot</TD>

<TD>Rang i</TD>
<TD>Narhi(co'm.)</TD>
</TR>

<TR>

<TD>Qalam</TD>

<TD>Qora</TD>

<TD>100</TD>

</TR>

<TR>

<TD>Qalam ochgichi</TD>
<TD>Qora</TD>
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<TD>500</TD>

</TR>

</TABLE>

Jadvalni ochuvchi teg
1 - qatorni ochuvchi teg
1 - Jadval bo'Iagini ochuvchi va yopuvchi teg
2 - Jadval bo'Iagini ochuvchi va yopuvchi teg
3 — Jadval bo'Iagini ochuvchi va yopuvchi teg
1 — qatorni yopuvchi teg
Jadvalni yopuvchi teg
Misolda ko'rinib turibdiki, jadvalni <TABLE> va </TABLE> teg-

lari yordaraida ochiladi va yopiladi. Qatorlar uchun <TR> va </TR>
teglari qo'llaniladi, <TD> va </TD> teglari esa jadval ustunlarini
(katakchalarini) belgilash uchun ishlatiladi.

Jadval chizish - HTML teg o'lchamlari

Murakkab jadvallar tuzishni boshlashdan avvai <TABLE>, <TR>
va <TD> teglariga qisqacha tasnif berib o'tamiz. Mazkur uchta teg
bilan qo'llaniladigan bir xildagi o'lchamlar mavjud bo'lib, faqatgina
ularning farqli tomoni, ularning ta'sir doiralarining chegaralanishidadir.

BGCOLOR

Atribut yordamida jadvalning orqa fonida qanday rang qo'llanilishi
belgilanadi.

BACKGROUND

Jadvaldagi bo'lakcha foni sifatida berilayotgan tasvirni joylashgan
joy va uning nomini belgilash uchun ishlatiladi. Agar siz bii atributni
<TABLE> tegidan so'ng qo'llasangiz, u holda siz tanlagan tasvir
jadvaldagi har bir kataklar foni sifatida qo'llaniladi.' <TR> tegidan so'ng
qo'llanilganda, mazkur qatorda joylashgan hamma katakchalaf uchun,
<TD> tegidan so'ng qo'llanilganda esa aniq biror katakchagacha fon
o'rnatiladi.

WIDTH

Jadval eni (kengligi)ning o'lchami (umumiy jadval uchun xos).
Bu o'lcham bilan jadvaldagi ma'lum bir ustuncha yoki bo'iakning
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kengligini piksel yohud foiz o'lchamida belgilash mumkin. Bu
o'lcham <TABLE> yoki <TR> tegi bilan qoMlanilgan taqdirda ham
bir xil ko'rinishdagi, ya'ni siz bergan o'lchamlarni hisobga olgan
holda jadval enining kengligini belgilaydi. Shuni doim yodda tutish
lozimki, siz bu o-lchamdan foydalangan holda jadval enining kengligini
belgilaganingizda bir xildagi o'lchov turidan foydaianishingiz maqsadga
muvofiq. Agar siz jadval kengligini piksellarda belgilasangiz (misol
uchun WIDTH=«100»), boshqa o'lchovlar ham pikselda belgilanishi
lozim. Agar jadval kengligi foizlar hisobida berilsa (misol uchun
WIDTH=«50%»), boshqa o'lchovlar ham foiz hisobida berilishi lozim.
Ayni hollarda brauzer siz yaratgan jadvalni ekranning teng yarmi, ya'ni
50% ga joylashtiradi.

HEIGHT

Jadvalning, qator yoki katakchalarning balandligi o'lchovlarini
piksellar yoki foiz hisobida belgilash uchun qo'llaniladi.

BORDER

Jadval ustuni va qatorlari kesishmalarini belgilovchi chiziqlarni
qalinligini piksellar hisobida belgilash uchun qo'llaniladi. Agar jadval
chiziqlarini nolga teng qilib belgilansa BORDER (BORDER=0) chiziq
(border) brauzerda ko'rinmaydigan bo'lib qoladi.

ALIGN

Jadvalning ekranga nisbatan joylashish o'rhini belgilaydi. Agar
jadval ichida qo'shimcha jadval tuzilgan bo'lsa, u holda ichki jadvalga
bu atribut kiritilganda, ichki jadval joylashishi o'rni tashqi jadvalga
nisbatan belgilanadi. ALIGNning quyidagi qo'shimcha o'lchamlari
mavjud: ALIGN - center (Jadvalni markaz bo'ylab joylashtirish), left
(chap burchak bo'ylab joylashtirish) va right (o'ng burchak bo'ylab
joylashtirish).

CELLPADDING

Katakcha enining kengligini piksellar yordamida kengaytirish yoki
toraytirish.
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CELLSPACING

Jadvaldagi katakchalar chegara enining piksellar yordamida ken-
gaytirishi yoki toraytirishi.

Misol:

<TABLE BORDER=0 WIDTH=100% CELLSPACING=5

CELLPADD1NG = 5 BGCOLOR=bIue>

<TR BGCOLOR=yellow>
<TD>Mahsulot</TD>

<TD>Narhi</TD>

</TR>

<TR BGCOLOR=white>

<TD>Qalam</TD>

<TD>100 so'm</TD>

</TR>

</TABLE>

ALIGN

Jadvaldagi bar bir katakchaning ichidagi elementlarni gorizontal
tarzda tartiblash uchun qo'llaniladi. Uning mavjud o'lchamlarl quyida-
gilardan iborat: - left (chap tomonga tekislash), right (o'ng tomonga
tekislash) va center (markaz bo'yiab tekislash).

VALIGN

Jadvaldagi har bir katakchaning ichidagi elementlarni vertikal tarzda
tartiblash uchun qo'llaniladi. Uning mavjud o'lchamlari quyidagilardan
iborat: - top (katakning yuqori qismiga nisbatan), middle (yuqori va
quyi qismiga nisbatan markazga tekislash).

Jadval tuzish qoidalari

Bu sahifada Jadval tuzish jarayonida siz amal qilishingiz lozim
bo'lgan eng asosiy qoida va maslahatlar keltirilgan.

• <TABLE>, <TR> va <TD> teglarini tartibiga rioya qiling
Har doim jadval tuzish sxemasini buzmaslikka harakat qiling. Awal

aytib o'tilgandek eng avvalo jadvalni oching so'ngra jadval qatorlari va
ustunlarini tuzing va eng oxirida jadvalni yoping. Ushbu tartib buzilgan
taqdirda turli hatoliklar kelib chiqishi mumkin.
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. <TABLE> tegini jadval so'ngida yoping
Agar <TABLE> tegini yopniasangiz kutilmagan hatoliklar vujudga

keladi. Masalan, Netscape Navigator siz tuzgan jadvalni ekranda
umuman ko'rsatmaydi.

• Ustunda joylashgan qatorlar son!
Har bir qatorda kataklarning soni bir xilda bo'lishiga e'tibor bering.

Bu tartibga, agar siz ayrim kataklarga hech qanday axborot kiritmagan
taqdiringizda ham ularni yaratish lozim. Bunday holatlarda bo'sh
katakchalarni mana bunday ko'rinishda yozish lozim; <TD>&nbsp;</TD>.
'&nbsp;' simvoli brauzerga mazkur katakda hech qanday axborot mavjud
emasligi haqida xabar beradi. Agar ushbu simvo! yozilmagan taqdirda
brauzer bu katakni aks ettirmaydi va <TD> tegida BGCOLOR atribut
ishlatilgan taqdirda fon rangi ifoda etilmaydi va hatolik yuz beradi.

• Har bir jadval tegini yangi qatorda yozing
Jadval tuzishda adashib ketmaslik uchun har bir jadval qatori, ustuni

va katakchalar belgilanganda ularni bir-biridan ajratib yozishga harakat
qiling. Quyida ana shu holatga misol keltirilgan.

<TABLE>

<TR>

<TD> ... </TD>

<TD> ... </TD>

<TD> ... </TD>

</TR>

<TR>

<TD> ... </TD>

<TD> ... </TD>

<TD> ... </TD>

</TR>

</TABLE>

Ushbu qoidalarga rioya qilsangiz jadval tuzishda turli qiyinchi-
liklarga duch kelmaysiz hamda siz tuzgan jadvallarda hatoliklar
bo'lmaydi.

Murakkab jadvallar tuzish

•  Oddiy jadval tuzish usullarini o'rganib oldingiz. <TD> tegining hali
siz bilmagan ba'zi qiziq oMchamlari mavjud bo'lib ularni qo'shish orqali
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ajoyib natijalarga erishish mumkin. Aytaylik siz quyida keltirilgan
jadvalga o'xshash jadval tuzmoqchisiz (1.4-jadval).

1.4-jadval

№ Mahsulot nomi ,Narhi(so'in)
1 Qalam 100

2 Ruchka 150

3 Daftar 400

Jami:::650 so'm '' . /.

E'tibor bergan boMsangiz jadvalning so'ngidagi qator boshqalaridan
farqli o'laroq bitta katakchadan iborat. Biz avval aytib o'tganimizdek
jadvaidagi barcha kataklar soni bir xil eraas. Bu misolda oxirgi
qatordagi uchta kataklar bir-biri bilan birlashtirilgan xolos. Buni <TD>
tegining COLSPAN yordamida amalga oshirish mumkin.

COLSPAN

Jadvaidagi bir qator yoki ustundagi bir nechta kataklarni bir-
lashtiradi. Bu atribut o'lchamiga siz nechta katakchani birlashirmoqchi
bo'lsangiz, ularning sonini kiritishingiz lozim. Quyida, yuqoridagi
jadvalda bu usul qanday amalga oshirilganini ko'rsatib beruvchi misol
keltiramiz. Bu misolda jadvalning aynan COLSPAN atributi qo'llanilgan
qismigina yozilgan:

<TR>

<TD COLSPAN = 3 BGCOLOR=red>
<FONT COLOR=white>Jami: 650 so'm</FONT>
</TD>

</TR>

HTML kodlarga izoh

HTML kodlarni tahrirlashni oson kechishini ta'minlash uchun turli
izohlarni kiritish maqsadga muvofiq. Izohlar yordamida siz HTML
kodlarni qayerda boshlanib, qayerda yakunlanganini muntazam kuzatib
borasiz va adashib ketmaysiz.
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Murakkab web-sahifalar tuzganda ishiatiladigan HTML kodlar
soni cheksiz ko'payib ketishi mumkin. Bunday paytda HTML kodlarni
qayerdan boshlanib qayerda yakun topganini adashtirib yuborishingiz
aniq. Shu sababli teg ochilganda va u yopilganda izoh bilan belgilab
borish lozim. Quyidagi misolda izohli HTML kodlai' tizimi keltirilgan:

<BODY BACKGROUND=img/back.gif>
<!—HTML hujjat boshlanishi~>
<TABLE BORDER=0 CELLPADDING = 0 CELLSPACING = 0

WIDTH= 100%>

<!-Tashqi jadval boslilaiiishi~>
<TR>

<TD WIDTH=«1%» VALIGN = «top»>
<IMG SRC = «img/p.gif» WIDTH=«160» HEIGHT=«1» ALT=

= « »><BR>

<!—Sahifaning chap ustuni~>
<FONT COLOR=white>Sayt menyusi:</FONT>
<!~CHap ustun yakuiii~>
</TD>

<TD WIDTH=«2%»></TD>

<TD WIDTH=«94%» VALIGN = «top»>
<!—Sahifaning markaziy ustuni~>
web sahifaning asosiy matni.
<BR><BR><BR><BR><BR><BR><BR><BR><BR><BR><BR>

<!—Markaziy ustun yakuni—>
</TD>

<TD WIDTH=«2%»> </TD>

<TD WIDTH=«!%» VALIGN = «top»>
<IMG SRC = «img/p.gif» WIDTH=«IOO» HEIGHT=«1» ALT=

= « »><BR>

<!~Sahifaning o'ng ustuni~>
<TABLE BORDER=«0» CELLPADDING = «1» CELLSPACING=

= «0» WIDTH=«100» BGCOLOR=«#336699»>

<!—O'ng ustundagi reklamali jadval~>
<TR>

■<!—Reklama sarlavhasi~>
<TD><FONT COLOR= «#eOeOff»>Reklama:</FONT></TD>
</TR>
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<TR>

<TD>

<TABLE BORDER = «0» CELLPADDING=«0» CELLSPACING=

= «0» WIDTH = «100%» BGCOLOR=«#fOfOfO»>

<TR>

<TD BGCOLOR=«#cccc33»>

<!~RekIama matni~>

<FONT SIZE=«2»>Reklama matni va tasvirni shu yerga joylash-
tirishingiz mumkin

</FONT>

</TD>

</TR>

</TABLE>

</TD>

</TR>

</TABLE>

<!~0'ng ustun yakuni—>
</TD>

</TR>

</TABLE>

<!~Tashqi iadval yakuiii">

</BODY>

^<!~HTML hujjat yakuni—>
Bu ifodalar sizga jadvalli sahifani oson tahlil qilish imkonini

beradi hamda turli o'zgarishlar kiritgan taqdiringizda, uni qaysi joyda
bo'lishini aniq belgilay olasiz.

Ba'zida o'zingiz ham mana shunday sxemalarni tuzishingiz mumkin
va sahifa tayyor bo'lgach, kiritilgan izohlarni o'chirib tashlang. Bunda
kiritilgan izoh quyidagi tartibda yozilishi iozim: izoh

Freymlar bilan ishlash imkoniyatlari

Freym — brauzer oynasidagi mustaqil to'g'ri to'rtburchak shaklidagi
maydon bo'lib, u o'z ichiga boshqa alohida mustaqil HTML hujjatlarni
birlashtira oladi.

Endi siz bar bir oynasida alohida mustaqil HTML hujjatlarni ochish
imkonini beruvchi freymlarni tuzish usullari bilan tanishib chiqasiz.
Freymlar brauzerdagi yangi oyna emas, balki bu alohida oyna yoki
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ramka bo'lib, u brauzerning ochilib turgan oynasi ichida aks ettiriladi
Bu bo'limda, bir freymdan ikkinchi freymlarni bir-biriga havolala
yordamida bog'lash usullarini tahlil qilib chiqamiz.

Freymlar tuzish

Siz internetdan foydalanish jarayonida freymlar ishlatilgan web
sahifani ko'rgansiz. Aytaylik bu sahifada uchta freymdan foydalanilgan.

Ko'rib turganingizdek bu sahifa uchta freymdan iborat ustunlarga
bo'lingan. CHap ustunda joylashgan freymda navigatsion menyu
yuqoridan o'ngdagisida reklama va o'ngdan pastdagi freymda esa web
sahifa asosiy matni o'rin oladi. Chap ustunda joylashgan havolalarga
bosish bilan, havolalari hujjatning o'ngdan pastlda joylashgan freymda
ochiladi.

Ushbu freymlar qo'llanilgan sahifaning umumiy tuzilishini ko*rib
chiqsak:

<FRAMESET> — freymlar tuzilishini belgilovchi ochuvchi teg
(freymset)

<FRAME> — birinchi freym
<FRAME> — ikkinchi freym
</FRAMESET> — freymsetni yopuvchi teg
Sxemada ko'rinib turganidek, har gal <FRAMESET> tegi yor

damida freymlar tuzilishini belgilash lozim. Shundan so'ng bevosita
freymlar <FRAME> tegiga navbat keladi. Oxirgi navbatda </
FRAMESET> freymset yopuvchi teg yoziladi.

Hozircha bu oddiy sxemani eslab qoling. Murakkab freymlar
qo'llanilgan sahifalar haqida ushbu bo'limda keyinroq ma'lumot
beramiz.

Freymlar — oddiy misol

Xullas, freymlar bilan ko'rsatilgan oddiy misolni ko'rib chiqamiz.
Ishni boshlashdan oldin, oddiy HTML formatida ikkita hujjat yarating.
Birinchi hujjatga «Freym-1» ikkinchisiga esa «Freym-2» deb yozing va
ularni freml.HTML va frem2.HTML deb nomlang. Bu ikkita fayllar
bizning misolimizda ikki freymlar uchun asosiy manba bo'lib xizmat
qiladi. Endi esa HTML formatida keyingi hujjatni yarating.
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<HTML>

<HEAD>

<TITLE>freym lar</TITLE>
</HEAD>

<FRAMESET COLS = «200»,*>
<FRAME NAME=left SRC = «framel.HTML»>

<FRAME NAME=right SRC=«frame2.HTML»>
</FRAMESET>

<NOFRAMES>
Sizning brauzeringiz freymlarni tushunmaydi.
</NOFRAMES>
</HTML>

Demak siz ham o'zingizning birinchi sahifangizni freymlar
yordamida yaratdingiz. Endi shu yaratgan sahifangizni frameset.html
deb nomlab oldin yaratilgan framel.html va frame2.html fayllar turgan
papkada saqlang va frameset.html faylini o'z brauzeringizda oching.

Birinchi navbatda, e'tibor bergan bo'lsangiz HTML formatidagi
freymlardan iborat sahifada <BODY> tegi mavjud emas. Bu esa juda
muhimdir. Agar siz <BODY> tegini ishlatsangiz u holda, hamma
<FRAMESET> va <FRAME> teglari brauzeringiz tomonidan
o'chiriladi. Undan tashqari <NOFRAMES> tegi shunday holatga
mo'ljallangan-ki, bu holatda sizning brauzeringiz freymlarni qoMlab-
quvvatlamaydi.

Freymlar - oddiy freyni

Bizning misolimizda <FRAMESET> va <FRAME> teglarini oddiy
o'lchamlarda ishlatgan edik. Endigi navbatda biz freymlar yordamida
o'z sahifamizda nimalarni o'zgartira olishimizni ko'rib chiqaylik.'
frameset.html sahifasini brauzerda yoki HTML teglarni tahrirlovchi
dasturda oching. Foydalanuvchi sizning freymlaringizni o'lchamlarini
o'zgartira olmaydigan qilishingiz mumkin. Siz hozir freym
chegaralariga sichqoncha ko'rsatkichini belgilab uning o'lchamlarini
xohlagan tarzda o'zgartirishingiz mumkin.

NORESIZE

<FRAME> tegining parametr ushbu freymni o'zgartirib bo'l-
masligini anglatadi.
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Misol;

<FRAME NAME=left SRC = «framel.html» NORESIZE>
<FRAME NAME=right SRC = «frame2.html» NORESIZE>
Keying! holatlarda, agar siz freymlar orasidagi chegaralarni

belgilash uchun siz <FRAMESET> tegining quyidagi atributini ish-
latishingiz zarur.

BORDER

<FRAMESET> tegi freymlar chegaralari orasidagi masofani
piksellarda ifodalaydi. Freym orasidagi chegarani umuman bo'lmasligi
uchun shu o'lchamni nolga tenglashtiramiz.

Misol:

<FRAMESET COLS = «200»* BORDER=«0»>

<FRAME> tegining yana bir muhim atributi
SCROLLING

<FRAME> tegi mavjud freymda sahifalash chizig'ini mavjudligi
yoki mavjud emasligini belgilaydi. Bu parametrning yes, no va auto
belgilari bu freymda sahifalash chizig'ini borligini, yo'qligini va agar
kerak bo'lsa ishlatilishini ko'rsatadi.

Misol:

<FRAME NAME=« left» SRC=«ffamel.html» NORESIZE SCROL

LING =«auto»>

<FRAMENAME=«right» SRC=«frame2.html»NORESIZE SCROL
LING =«yes»>

<FRAMESET> tegining quyidagi atributlarini siz bilishingiz za
rur:

COLS

<FRAMESET> tegining bu parametri gorizontal freymlarning
chapdan o'ngga tuzilishini ko'rsatadi. Freymlarning kengligi piksellarda
yoki foizlarda beriladi va bir-biridan tinish belgisi bilan ajratiladi.
'*' simvol shuni. ko'rsatadiki, qolgan umumiy maydon shu freymga
ajratilishini anglatadi.

Misol:

<FRAMESET COLS=«200», *100>

Bu misolda uchta freym mavjud bo'lib, birinchisi-200 piksel,
oxirgisi -100 piksel, ikkinchisi (o'rtadagi freym) - qolgan maydonning
hammasi shq freym uchun ajratilgan.
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<FRAMESET COLS=20%, ICQ, 50, ♦>
Bu misolda esa to'rtta freym bo'lib, birinchisi maydonning 20%ni,

ikkinchisi - 100 pikselli, uchinchisi - 50 pikselli, to'rtinchisi esa qolgan
maydonni tashkil etadi.

ROWS

<FRAMESET> tegining bu parametri freymlarning vertikal
tepadan pastga boMgan tuzilishini ko'rsatadi. O'lchami raqamlar bilan
beriiadi. Bu freymlarning balandligi piksellarda yoki foizlarda beriladi
va bir- biridan tinish belgisi bilan ajratiladi. simvol shuni ko'rsatadiki
u umumiy qolgan maydonni shu freymga ajratilishini anglatadi.

Misol:

<FRAMESET ROWS = 50%, 50%>
Balandligi ekranning 50% tashkil qiluvchi ikkita freym. Anglash

qiyin emaski, bu ifodani ROWS parametrida, simvol orqali quyidagicha
yozish mumkin 50%, *

Freymlar - murakkab freymlar tuzish

Ushbu bo'limning boshida siz tanishib chiqqan, freymlarga
bo'lingan sahifaga yana bir bor murojaat qilsak (1.3-rasm). Berilgan
sahifada uchta freym bo'lib, bu freymlar tarkibida gorizontal hamda
vertikal holatdagi freymlar mavjud. Bu sahifani yaratish uchun biz
nima qilishimiz kerak? Demak hammasini bir boshdan boshlaymiz.

Murakkab tarkibli freymlarni yaratishimiz uchun, biz jadvallarni
qanday yo'l bilan yaratgan bo'lsak shu yo'l bilan yaratishimiz
qulayroqdir. Oq qogo'zga freymlar tuzilishi
andozasini chizib oling va shu freymlarnf
raqamlab chiqing. Bizning misolimizda
freymlar tuzilishi quyidagicha bo'ladi:

Freymlarni quyidagicha raqamlaymiz;
chapdan o'ngga, tepadan pastga qarab. Endigi
navbatni yangi sahifani yaratishga bersak.
Bizning misolimizda yolg'iz <FRAMESET>
tegi orqali freymlar strukturasini bel-
gilay olmaysiz, nega deganda birgina
<FRAMESET> tegida freymlarni birgalikda
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gorizontal (COLS) va vertikal (ROWS) joylashtirishning iloji yo'q. Gap
shundaki bir nechta <FRAMESET> teglarni quyidagicha ishlatiladi

<HTML>

<HEAD>

<TITLE>freymlar</TITLE>
</HEAD>

<FRAMESET COLS= 150 * BORDER=0>

<FRAME SRC=ieft.html SCROLLING=yes NORESIZE>
<FRAMESET ROWS=70* BORDER=0>

<FRAME SRC=top.html SCROLLING=auto NAME=top
NORESIZE>

<FRAME SRC = content.html SCROLLING=yes NAME=content
NORESIZE>

</FRAMESET>

</FRAMESET>

<NOFRAMES>

Sizning brauzeringiz bu freymlarni qo'llab quvvatlamaydi.
</NOFRAMES>

</HTML>

Birinchi <FRAMESET> tegi ekranni ikkita freymga, ya'ni o'ng va
chap freymlarga ajratadi. Ikkinchi <FRAMESET> tegi esa o'ng qisra
(o'ng freym)ni yana ikkita tepa va past freymga ajratadi. Ketma-ketlik
tartibi HTML formatida oldin ko'rsatib o'tilganidek bo'Iishi sliart.
Birinchi navbatda birinchi <FRAMESET> tegi. Birinchi freym (o'ng
freym). Undan keyin ikkinchi freym kelishi kerak edi. Ammo biz
ikkinchi <FRAMESET> tegi yordamida uni yana ikkiga bo'ldik, ya'ni
biz ikkinchi freym (chap freym)ga yana ikkita freymni vertikal holda
(ROWS = 70,*) joylashtirgan bo'lamiz. Keyin ikkita freym keladi va
ikkala <FRAMESET> teglari yopiladi. Mana endi natija quyidagicha
bo'ladi, ya'ni chap freymda left.html o'ng tomondagi freymning yuqori
qismida top.html va undan yuqori qismida content.html freyntlar
yuklanadi.

Freymlar - havolalar tuzish

Belgilangan raaxsus freymda HTML hujjatni ochilishi uchun
havolani qanday tuzish lozim? Bu juda ham oson. Buning uchun, freym
ishlatiladigan sahifa yaratilganda, freym nomini berib o'tish lozim.
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NAME

<FRAME> tegiiiing bu atributi mazkur fi-eym nomini belgilaydi.
Freym nomlari ushbu freymga boshqa freymdan havola tuzish uchun
qo'llaniladi.

Bizning misolimizda quyidagi kodlar qo'llanilgan:
<FRAMESET COLS= 150* BORDER=0>

<FRAME SRC = left.htinl NAME=left SCROLLING=yes NORE-
SIZE>

<FRAMESET ROWS = 70* BORDER=0>

<FRAME SRC=top.html NAME=top SCROLLING=auto NORE-
SIZE>

<FRAME SRC = content.html NAME=content SCROLLING=yes>

</FRAMESET>

</FRAMESET>

Natijada quyidagi nomlardagi freymlar vujudga keladi; left, top
va content. Endi chap freymdagi havoladan asosiy freymda hujjatni
ochilishi uchun <A> tegining TARGET parametrini content teng qilib
belgilash lozim, ya'ni:

<A HREF= l.html TARGET=content>l-Punkt </A>

Shakllar hosil qilish (Форма)
Siz internetda ko'p marta shakllarga duch kelgan boisangiz kerak.

Bu qog'ozdagi anketaning elektron varianti, o'zida matn kiritish
maydonlarini, savollarga javob variantlari va boshqa shakl elementlarini
mujassam qiladi. Shakllar sayt egasi va foydalanuvchilar orasida aloqa
o'rnatish uchun kerak.

Shakllar yordamida saytingiz prqali, misol uchun, ovoz berish,
foydalanuvchilarning ayrim savollar bo'yicha fikrini bilish va shunga
o'xshash masalalarni hal qilishingiz mumkin.

Shakllarning umumiy sxemasi
Quyida bar qanday shaklni yaratish umumiy sxemasi berilgan.
<FORM>
shakl maydonidagi teglar
</FORM>
Ko'rib turganingizdek, ochuvchi <FORM> va yopuvchi</FORM>

teglari orasiga shakl maydonlari teglarini qo'yish yetarlidir. Keyingi
sahifada turli shakl maydonlari bilan tanishamiz.
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Turli shakl maydonlari

Shakl maydonlari qanday bo'ladi va ular nima ish bajaradi?
Matn qatori (TYPE=TEXT)
Bu qator ko'p bo'Imagan simvollardan iborat erkin ko'rinishdagi

ma'lumotni (matnni) kiritish uchun foydalaniiadi.
Misol:

<INPUT TYPE=TEXT NAME=Tekst SIZE=20 VALUE = «Siz-

ning matn»>
Shunday qilib matn qatori <INPUT> tegi va TYPE = TEXT para-

metrlari yordamida yaratiladi. Shu tegning boshqa parametrlari nimani
bildiradi?

NAME

Serverga jo'natiladigan o'zgaruvchining nomi. Foydalanuvchi ki-
ritgan matn natijada shu nomli o'zgaruvchiga beriladi. HTMLda
shakllar yaratish serverda dasturlash biian uzluksiz bog'liq. Serverda
foydalanuvchilaringizdan maTumotlarni shu dastur orqali qabul qi-
iishingiz mumkin.

SIZE

Matn qatorining simvol ko'rinishdagi kengligi. Bizning misolda
bu parametrning ifodasi 20 ga teng. Buning ma'nosi kiritilayotgan
matnning kengligi 20 simvoidan iborat. Foydalanuvchi undan ko'p
simvollardan iborat bo'Igan matnni kiritishi mumkin, lekin 20 tadan
ortiq simvol ko'rinmaydi. Klaviaturadagi yo'naltiruvchi tugmachalar
yordamida matnni boshi yoki oxiriga o'tish mumkin.

VALUE

Bu parametr ifodasi oldindan matn maydoniga kiritilgan bo'ladi.
Uni o'zgartirish yoki o'chirish mumkin.

Javob varianti (TYPE=RADIO)
Foydalanuvchi bir qancha javob variantlari orasidan faqat bitta

variantni tanlashi mumkin.

Misol:

Jinsi:

<INPUT TYPE=RADIO NAME=Jins VALUE=«Erkak»>Er.

<INPlJT TYPE=RADIO NAME= Jins VALUE=«Ayol»>Ay.
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Natija:
Jinsi: Er. Ay.

Ko'rib turganingizdek javob variantlari <INPUT> tegi TYPE=
=RADIO atributi orqali yaratiladi. Diqqat qiling, javob variantlaridagi
NAME atributining ifodalari bir xil bo'lishi kerak, aks hoida brauzer
bularni bar xil savoi deb qabul qiladi.

VALUE

Bu ifoda o'zgaruvchining ifodasi ko'rinishida Jo'natiiadi (bizning
misolda, agar Er. tanlansa Jins o'zgaruvchining ifodasi 'Erkak' ga teng
bo'ladi).

Tasdiqlash (TYPE=CHECKBOX)
Ayrim ifodalarni yoki javob variantlarini belgilash uchun ishlatiladi.
Misol:

Jinsi:

<INPUT TYPE = CHECKBOX NAME=AddMe VALUE=«Obuna
bo'lish»>

Ha, men sizning saytingizdan yangiliklar olishni istayman
Natija:
Ha, men sizning saytingizdan yangiliklar olishni istayman
Tasdiqlash <INPUT> tegi TYPE=CHECICBOX atributi yordamida

yaratiladi. Bizning misolda, agar foydalanuvchi kvadratga belgi
qo'ysa (tasdiqlasa) AddMe o'zgaruvchining ifodasi «Obuna bo'lish»ga
teng bo'ladi. Aks holda AddMe o'zgaruvchisiga hech qanday ifoda
berilmaydi.

Harakatlanuvchi menyu (SELECT)
Bir qancha javob variantlaridan birini taniash uchun harakatlanuvchi

menyu ko'rinishida ifodalanadi.
Misol:

Yoshi:

<SELECT NAME=Age>
<OPTION VALUE= 10>10 dan kam

<OPTION VALUE = 11-20>11-20

<0PTI0N>21 dan ko'p
</SELECT>

Natija:
Yoshi:
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Harakatlanuvchi menyu <SELECT> tegi, menyuning javob va-
riantlari esa <OPTION> tegi yordamida yaratiladi.
NAME

<SELECT> tegining atributi, o'zgaruvchining nomini ifodalaydi.
Bu o'zgaruvchiga tanlangan javob variantining ifodasi beriladi. Bizning
holatda o'zgaruvchining nomi Age.

VALUE

<OPTION> tegining atributi, shu variant tanlanganda parametr
ifodasi o'zgaruvchiga beriladi. Agar bu atribut belgilangan bo'l-
masa (uchinchi <OPTION> tegiga o'xshab), o'zgaruvchining ifodasi
<OPTION> tegidan keyin kelgan matn bo'ladi. Agar bizning miso-
limizda uchinchi variantni tanlasak Age o'zgaruvchining ifodasi 2! dan
ko'p, agar birinchi variantni tanlasak ifoda '10' bo'ladi.

<OPTION>tegidan so'ng berilgan matn ekranda harakatlanuvchi
menyu varianti sifatida ko'rinadi. Keyin <OPTION> tegini yopish shart
emas.

Matn maydoni (TEXTAREA)

Matn maydoni foydalanuvchi tomonidan ko'p sonli simvollardan
iborat matnni kiritish uchun foydalaniladi.

Misol:

Sizning mulohazalaringiz:
<TEXTAREA NAME = Comments COLS=20 ROWS = 5>

O'z mulohazalaringizni kiriting
</TEXTAREA>

Natija:
Sizning mulohazalaringiz:
Matn maydoni <TEXTAREA> tegi orqali yaratiladi. Ochuvchi va

yopuvchi teglar orasidagi hamma matnlar shu matn maydoni ichiga
yoziladi.

COLS

Matn maydonining simvol ko'rinishidagi kengligi.

ROWS

Matn maydonining qator ko'rinishidagi balandligi.
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Shaklni tozalash va jo'natish tugmachasi

Foydalanuvchi to'ldirilgan shaklni jo'natish uchun tasdiqlovchi
tugmacha yaratish kerak. hamda shakl maydonini tozalash tugmasini
yaratishi mumkin. Shu bo'lim boshida Jo'natish va tozalash tugmasini
qanday ko'rinishga ega ekanligini ko'rdingiz.

Jo'natish tugmachasi (TYPE=SUBMIT)
Foydalanuvchining shaklda belgilangan ma'lumotlarini tasdiqlab,

shu ma'lumotlarni serverga jo'natish uchun qo'llaniladi.
Misol:

<1NPUT TYPE=SUBMIT VALUE=«Shaklni jo'natish)»
Natija;

'Shaklni jo'natish' nomli tugmacha
Jo'natish tugmachasi <INPUT> tegi yordamida TYPE=SUBMIT

atributini ishlatgan holda yaratiladi. Natijada VALUE parametrida
belgilangan yozuv bilan tugmacha yaratiladi. Tugmacha bosilganda
shakldagi ma'lumotlar serverga jo'natiladi.

Tozalash tugmachasi (TYPE=RESET)
Shakl maydonidagi ma'lumotlarni tozalash uchun qo'llaniladi.
Misol:

<INPUT TYPE = RESET VALUE=«Shaklni tozalash)»

Natija:
'Shaklni tozalash' nomli tugmacha
Shakl maydonini tozalash tugmachasi <INPUT> tegi yordamida

TYPE=RESET atributini ishlatgan holda belgilanadi. Natijada VALUE
atributida belgilangan yozuv bilan tugmacha yaratiladi. Tugmacha
bosilganda shakldagi ma'lumotlar to'la o'chiriladi.

Ko'rinmas shakl maydoni

Yana bir turdagi shakl maydoni bor - bu ko'rinmas shakl maydoni.
Bu maydon ma'lumotlar almashinuvi uchun ishlatiladi. Ko'rinmas
maydonni foydalanuvchi ko'ra va o'zgartira olmaydi.

Ko'rinmas maydon (INPUT TYPE=mDDEN)
Shakl maydoni ekranda ko'rinmaydi, uning ifodasi sahifa yara-

tilishida beriladi va foydalanuvchi shaklni to'ldirish jarayonida
o'zgartirib bo'lmaydi.
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Misol;

<INPUT TYPE=fflDDEN NAME=Page VALUE=«1 sahifa»>
Ko'rinmas shakl maydoni <INPUT> tegi yordamida va TYPE=

=HIDDEN atributini ishlatgan holda yaratiladi. Berilgan misolda
shaklni jo'natish vaqtida Page o'zgaruvchisiga '1 sahifa' ifodasi
beriladi. Buning natijasida, agar to'ldiriladigan sahifalaringiz ко p
bo'lsa, qaysi sahifadagi shakldan ma'lumot jo'natilganini aniqlashingiz
mumkin.

FORM tegining atributlari va shaklni jo'natish
Shu bo'lim boshida eslatib o'tganimizdek, shakl yaratish dastur-

lash bilan uzluksiz bog'liq. Boshqacha qilib aytganda shakldagi
ma'lumotlarni qayta ishlash dasturlashsiz iloji yo'q. Ma'lumotlarni
qayta ishlash natijasi siz ko'rsatgan email manzili bo'yicha jo'na-
tiladi.

Keling, sizning saytingizdagi shakl ma'lumotlari dastur orqali qayta
ishlanishi uchun nima qilishni ko'rib chiqaylik. Natija siz ко rsatgan
email manzili bo'yicha shu formatda jo'natiladi.

O'zgaruvchi; Kiritilgan ma'lumot
Buning uchun saytingizda xohlagan shaklni shu ko'rinishda yara

tish ingiz zarur:
<FORM METHOD=POST ACTION=http://.....com/mail.php3>
<INPUT TYPE=HIDDEN NAME=recipient VALUE=EMAIL>
<INPUT TYPE=HIDDEN NAME=subject VALUE=MAVZU>
<INPUT TYPE=HIDDEN NAME=type VALUE=TUR>
<INPUT TYPE = HIDDEN NAME=return VALUE=MANZIL>
<INPUT TYPE=fflDDEN NAME=alpha VALUE=a>
Sizning shaklingiz
</FORM>
Endi shu HTML kodni o'z sahifangizga ko'chiring va keyingi

so'zlarni o'zgartiring;
EMAIL — natija jo'natiladigan email manzil;
MAVZU - Xat mavzusi (Subject);
TUR - Sizning pochtangiz turi, HTML deb yozing, agar aniq

bilmasangiz TEXT deb yozing;
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MANZIL — foydalanuvchi shaklni to'ldirgandan keyin ko'rishi kerak
bo'lgan sahifa manzili;

Keyin, 'Sizning shaklingiz' so'zini o'rniga o'z shaklingizni qo'ying.
Dastur qanday ishlashini ko'rish uchun o'zingizni email manzilingizni
kiriting va 'Tekshiruv' tugmasini bosing.

HTMLda simvoliar jadvali

Ay rim simvollarni to'g'ridan-to'g'ri yozib bo'lmaydi. Chunki ularni
brauzer aks ettirib bera olmaydi. Undan tashqari ko'plab simvoliar
klaviaturada mavjud emas. Bu ikki turdagi simvollarni brauzerda
aks ettirish uchun son va shriftlar kombinatsiyasidan foydalaniladi.
ASCII simvoliar deb ataluvchi simvollarning son va shriftlardan iborat
kombinatsiyasi mavjud.

Savol va topshiriqJar:

1. Web-dizayn nima?
2. Dizaynning qanday turlari bor?
3. Web-dizaynda qanday dasturing vositalar ishlatiladi?
4. NTML nima? Uning asosiy strukturasi nimalardan iborat?
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Il-bob. DREAMWEAVER DASTURINING IMKONIYATLARI

Dreamweaverning MX versiyasi bu nafaqat interfeysning tashqi
ko'rinishi yangilangani, balki radikal texnologik yangilangan, gi-
permatnli belgilash tili imkoniyatlari kengaygan. Unda Web-sahifa
maketlarini yaratish uchun yangi ashyolar paydo bo'ldi. Jumladan,
tizimga Flash obyektlarni qo'yish buyruqlari qo'shilgan va WEB uzellar
bilan boshqarish va turii jamoaviy ishlarni loyihalashda rivojlanishga
imkon beradi. Endi Dreamweaver MX bilan batafsil tanishib chiqamiz.

Belgili kodlar bilan ishlash vositalari sezilarli darajada rivojiandi.
MX—versiyasi bu ixtiyoriy murakkablikdagi dastlabki matn bilan ishlash
uchun kuchli bazaga ega bo'lgan gipermatnli dasturlashning to'laqonli
qobig'idir. Asosiy imkoniyatlarini sanab chiqamiz:

1) Hujjatning oynasi endi har xil rejimlarda ishlashi mumkin.
Design View (Режим планировки) rejimida, foydalanuvchi HTML
sahifa maketini taxminan shunday ko'rinishda ko'rish mumkin.
Code View (Режим разметки) rejimida esa hujjatning oynasida
belgili matn sahifasining barcha deskriptorlari, senariylari va
kommentariyalari tasvirlanadi. Dasturning bu rejimlari orasida kichik
koordinatsiya mavjud. Kodlarni o'zgartirish maket modifikatsiyasiga,
vizual rejimda rejalashtirish yoki formatlashga o'zgartirish kiritish
imkonini beradi;

2) Dreamweaver tizimi qobig'iga barcha zaruriy qurilmalarga ega
bo'lgan to'laqonli kodlar tahrirlagichidan iborat dastur integratsiya
qilingan. Unda HTML hujjatlarining dastlabki matnlari bilan ishlashni
yengillashtiruvchi vositalar: kiritilgan teglarning sarlavhalari, turli
kodlarni rangli belgilash, tez qidirib topish vositalari aks etgan.
Sintaktik noto'g'ri loyihalarni aniqlash, uzun qatorlarni avtomatik
ko'chirish, avtokorreksiya rejimi yo'lga qo'yilgan. Dastur vositalari
yordamiida nafaqat gipermatnli sahifalarni, balki matnli ko'rinishga ega
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har qanday hujjatlarni, dasturlar, senariylar, oddiy matnlar, XML belgili
hujjatlar va boshqalarni tahlil qilish miimkin.

3) Gipermatnlarni belgilash kodlari bilan ishlashni ma'lumot
paneli ancha soddalashtiradi. Bu dastur ichiga.qurilgan interfaol ma'lu-
motnoma gipermatnli belgilash tilining barcha standart loyihalarini va
u bilan bog'langan vositalarni: diskreptorlar, atributlar, ierarxik stildagi
o'ziga xosliklarning deklaratsiyalari (Cascading Style Sheet), Java Script
tilining sintaktik loyihalarini qisqa va lo'nda shaklda tavsiflaydi.

Tajribadan ma'lurnki xatto eng tajribali, HTML tilini chuqur
biladigan Web-ustasi ham bu til standartiga kiruvchi yuzlab kodlar va
atributlarni eslab qolishga qodir emas. Ma'lumotlar paneli deskriptorni
aniq va ravshan tavsiflab beradi, uning atributlari hamda ko'rib chiqish
dasturining turli versiyalari bilan mos tushishi haqida ma'lumot beradi.

4) Java Script senariylar
Java Script dasturlash tilida yozilgan senariylardagi yashirin xa-

tolarni aniqlash imkoni beriladi. Bu vosita nafaqat hozirgi vaqtda
WEB-dasturlash sohasida qo'llaniladigan ko'p sonli analizatorlar uchun
qiyin bo'lmagan, sintaksis xatolarni aniqiashga qodir. Kodlarni tuzatish
vaqtida dastur ichiga qurilgan nazorat nuqtalari va qadamba-qadam
bajariladigan dastur ko'rsatmalari hamda o'zgaruvchilarning holatini
nazorat mexanizmlariga ham ega.

Doimo sezilarli potentsialga ega bo'lgan vizual loyihalash tah-
rirlagichining uskunalari yana bir vosita bilan boyitildi. Bu gipermatnli
sahifalarni rejalashtirish va yaratish uchun mo'ljallangan maxsus dastur
ishchi rejimidir. U sahifani aks ettirishning maxsus rejimi (Layout Viev)
va ikkita uskuna ko'rinishida amalga .oshirilgan bo'lib, ular yordamida
maket elementlarini chizish mumkin.

Tahrirlagichning oldingi versiyalari vektorli animatsiyalashgan
tasvirlar sohasida birinchilar qatorida bo'lgan Flash dasturi bilan juda
yaxshi o'zaro aloqada bo'lishi bilan ajralib turgan. Dasturning joriy
versiyasiga animatsiyalashgan obyektlarni generatsiya qilishning
ikkita asosiy buyrug'i integratsiya qilingan. Endi bevosita dastur
oynasida interfaol tugma yoki «jonli matn» yaratish mumkin. Bunga
o'xshash obyektlarni kiritishning texnik tomoni o'ta soddalashtirilgan
va loyihalashtirishdan ko'ra ko'proq anketalashtirishga o'xshab
ketadi. Foydalanuvchidan Flash — texnologiya sohasida chuqur
5 - Pedagogik web-Jizayn 55



bilimlar talab qilinmaydi. U faqat muloqot oynasi sohasini toidirishi
kerak. Zamonaviy dasturlarning ko'pchiligi animatsiyalashgan Flash
- grafikani aniq aks ettiradi. Bu tipdagi obyektlar аМо darajada
masshtablanishi bilan ajralib turadi va tarmoq bo'ylab uzatishda ham,
diskda saqlashda ham juda kam resurs talab qiladi. Dasturga kiritilgan
yangiliklarni qisqacha sanab o'tamiz:

— ierarxik stildagi o'ziga xosliklar (CSS) bilan ishlash vositalari
sezilarli darajada takomillashtirilgan.

— Macromedia firmasi tomonidan ishlab chiqilgan Fire woks
grafik muharriri bilan Dreamweaver dasturining integratsiyasi yanada
rivojlantirildi.

— yangi Assets (resurslar) palitrasi yaratildi. U dasturda bitta WEB
— tugunning bir necha sahifasi tomonidan birgalikda ishlatiladigan
turli xildagi ma'lumotlarning omborxonasi vazifasini bajaradi. Bular
tasvirlar, animatsiya roliklari, ranglar, senariylar, kutubxonalar va
boshqalar bo'lishi mumkin. Saqlanayotgan resurslarni turli sahifalarning
talab qilinadigan sohalarida joyini o'zgartirish (yoki surish) yo'li bilan
joyiashtirish mumkin.

Site Report (Отчет о сайте) buyrug'i loyiha holati haqidagi batafsil
hisobotni hosil qiladi. Hisobot o'ziga ko'p sonli giperbog'lanishli
hujjatlarni biriktiradi:

— tahrirlagichga versiyalarni va dasturiy ta'minotni yangilashni
boshqarishni nazorat qilishning yetakchi dasturiy vositasi bo'lgan
Microsoft Source Safe paketli integratsiya vositalari qo'shilgan. Bu
narsa Dreamweaver tizimini Internet uchun murakkab loyihalarni
ishlab chiquvchi jamoalar uchun asosiy uskuna sifatida qo'llanilishiga
asos boiadi.

— dasturning bu versiyasi WEBDav bayonnomasini to'laqonii
qo'llab-quvvatlaydi. Bu versiyalarni boshqarish va taqsimlangan ishni
tashkil qilish bo'yicha kengaytirilgan imkoniyatlarga ega bo'lgan klassik
bayonnomasidir.

— interfeysni standartlashtirish va sayqal berish bo'yicha kat-
ta ish qilindi. Macromedia fi rmasi ko'pgina dasturlarning tashqi
ko'rinishi noturg'un palitralarning yagona konsepsiyasiga asoslanadi.
Muharrirning oxirgi versiyasida palitralarning ko'rinishi standart-
lashtirilgan. darning deyarli hammasi tarkibiy majmuaviy palitralarga
66



birlashish imkoniyatiga ega bo'ldilar. Oldingi versiyalarning ro'yxatga
olishdagi ba'zi kamchiliklar bartaraf etildi.

— klaviatura kombinatsiyalari bir shaklga keltirildi. Ular web-
dizayn uchun Macromedia firmasi tomonidan ishlab chiqilgan, bar-
cha dasturlash vositalari uchun umumiy bo'lgan ichki standartga
moslashtirilgan. Ichiga qurilgan boshqaruv tizimi yordaraida tugma-
larning bar qanday tuzilishini o'zgartirish mumkin.

Savol va topshiriqlar:

1. Dreamweaver MX dasturi nima maqsadda qo'llaniladi?
2. Dasturning qanday yangi imkoniyatlari mavjud?
3. Dastur avvalgi web-muharrirlaridan nimasi bilan farq qiladi?

2.1. Dasturni o'rnatish va ishga tushirish

Tajribali foydalanuvchi dasturni o'rnatish jarayonida o'zi uchun
hech qanday yangilik ko'rmaydi. Distributiv diskda Dreamweaver MX
Installer.exe (инсталятор) faylini qidirib topish va ishga tushirish lozim
(avto yuklanish bo'lmagan holatda). Windowsning ko'pchilik ilovalari
kabi bu dastur ham bir necha bosqichda o'rnatiladi. Ularning bar biri
alohida muloqot oynasidan iborat.

Dasturni o'rnatishning asosiy bosqichlarini ketma-ket sanab o'tamiz
[3], [4]:

— Extracting Files. Bu bosqichda DREAMWEAVER tizimdagi
qurilmalar va dasturning instalyatori ishlashi uchun zarur bo'lgan
fayllar arxivdan ochiladi. Bosqich foydalanuvchining aralashuvini talab
qilmaydi.

— Welcome (Xush kelibsiz). O'rnatishning birinchi bosqichi boiib,
unda foydalanuvchi tanlangan dastur va uni installyatsiya qilish
qoidalari haqida asosiy ma'lumotlarni oladi.

— License Agreement (Litsenziya shartnomasi). Ikkinchi bosqichda
litsenziya shartnomasi va muallifning dasturiy mahsulotiga huquqlari
bilan tanishish taklif etiladi. Foydalanuvchi taklif qilinayotgan
majburiyatlarni qabul qilishi yoki rad etishi kerak.

— Macromedia Dreamweaver Serialization (dasturni ro'yxatdan
o'tkazish). Uchinchi bosqichda muloqot oynasi hosil bo'ladi, uning
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yordamida foydalanuvchining rekvizitlari va dasturning serial nomerini
kiritish zarur bo'ladi.

— Choose Destination Location (joylashuv). Bu bosqichda dasturni
o'rnatish uchun disk va papkani olish zarur bo'ladi. Taklif qilinganidan
farq qiluvchi manzilni ko'rsatish Windows tizimi uchun standart boigan
faol disk va katalogni tanlash yo'li bilan berish muinkin. Buning uchun
Browse tugmasini bosish kerak.

— Default Editor o'rnatishning bu bosqichida Dreamweaver dasturi
key in ishlatiladigan asosiy tahrirlash fayllarini tanlashni taklif qiladi.

— Select Program Folder (Dastur papkasini tanlash). Bunda foy-
dalanuvchi dasturni ishga tushiruvchi yorliq joylashgan papkani
ko'rsatish kerak bo'ladi. O'rnatishning keyingi barcha operatsiyalari
foydalanuvchining aralashuvini talab etmaydi. Instalyator arxivlarni
ochadi, kataloglar va kichik kataloglar tizimini yaratadi, unga ish uchun
zarur bo'lgan barcha fayllardan nusxa ko'chhadi va ekranga gipermatnli
faylni dastur imkoniyatlarining tavsifi, foydali ma'lumotlar manbalari
haqida qisqacha ma'lumotlar bilan chiqarib beradi.

Dasturni ishga tushirisb

Paket o'rnatilgandan keyin Windows bosh menyusiga Dream-
weaverni yuklash va unga tegishli fayllar maxsus bo'limi qo'shiladi. Har
qanday holatda ham dasturni yuklash buyrug'i; Пуск > Программы >
Macromedia > Dreamweaver MX ko'rinishida bo'ladi.

Dasturni yuklashni bir nechta universal usullari mavjud. Bu bizga
oddly Microsoft Office paketi dasturlaridan ham ma'lum.

Savol va topshiriqiar:

1. Dreamweaver MX dasturini o'rnatish ketma-ketligini aytib bering?
2. Dasturni o'zingiz mustaqil ravishda o'rnating?
3. Dasturni ishga tushirish ketma-ketligini aytib bering?
4. Dasturni ishga tushirishning yana qanday usullari bor?

2.2. Interfeys. Dastur oynasi qismlari

■ Interfeys deganda informatikada dasturdagi turli komponentlar
va foydalanuvchi o'rtasidagi o'zaro aloqani ta'minlovchi vositalar va
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qoidalar yig'indisi tushuniladi. Dreamweaver paketi taklif etadigan
muomala usuli zamonaviy foydalanuvchi uchun odatiy bo'lib qolgan
grafik oynali interfeys prinsiplariga asoslanadi. Dreamweaver paketi
o'sha sinfdagi boshqa dasturlar bilan taqqoslaganda ancha aniq,
moslashuvchan va shu bilan bir paytda kuchli interfeys hisoblanadi.
Palitralar, ko'p sonli klaviatura kombinatsiyaiari va menyu qatori uning
asosiy vositalari hisoblanadi. Barcha operatsiyalar to'xtatilgach ekranda
qoladigan oynalarni palitralari (Palette) yoki panellar (panel) deb atash
qabul qilingan. Ekranning maxsus ajratilgan pozitsiyalarida emas, balki
ixtiyoriy joyida joylasha oladigan oynalar ko'chib yuruvchi palitralar
(floating plette) deb ataladi. Dreamweaver dasturi muloqot oynalarining
ko'pchiligi ko'chib yuruvchi palitralar ko'rinishida ishlaydi. Palitralar
va panellar orasidagi kichik farqlar dasturni tavsiflash uchun sezilarli
ahamiyatga ega emas. Shuning uchun kelgusida bu atamalarni
sinonimlar sifatida qo'llaymiz.

Deyarli barcha palitralar birlashish xususiyatiga ega. Bu har xil
palitralarni bitta muloqot oynasida joylashtirish mumkinligini bildiradi.
Birlashtirish amali turli mavzu yoki buyruqlarga tegishli boshqaruv
vositalariga ega bo'lgan ko'p funksiyali terma palitralarni olish
imkoniyatini beradi. Birlashish xususiyatiga ega bo'lgan palitralarni
(ular dasturda ko'pchilikni tashkil etadi) modulli (dockable) palitralar
deb ataymiz. Bir nechta alohida modullardan iborat murakkab palitralar
terma (tabbed) palitralar deb ataladi.

2.1-rasmda to'rtta ochiq muloqot oynali dasturning tashqi ko'rinishi
ko'rsatilgan. Boshqaruvning eng talab qilinuvchi vositasi so'zsiz.
Properties inspector (xossalar nazoratchisi) palitrasi hisoblanadi. Uning
yordamida HTML sahifalarida obyektlarni formatlash va HTML
sahifasidagi obyektlarni tahrirlash bo'yicha ko'plab amallar bajariladi.
Behavieros (rejimlar) palitrasi - bu modul ko'chib yuruvchi palitraga
misol bo'ladi. Dreamweaver dasturi turli loyiha masalalarini hal qilishga
mo'ljallangan obyektlarga ega.

Rasmda ikkita oddiy modulli Layers va History palitralardan
iborat bo'lgan terma palitraga misol keltirilgan. Objekts palitrasi
tashqi obyektlar: rasmlar, jadvallar, qatlamlar, freymlar va boshqa
obyektlarni qo'yish uchun mo'ljallangan. Rasmda ko'rsatilgan boshqa
barcha boshqaruv elementlari hujjat oynasining ajralmas tashkil etuvchi
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08 gdit Y»w Insert Мо<Л(У le>«^ Corranands Site i^indow ИвЬ

fCommon '

J-avQul

In ^1

Format | Wow
Link
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HTML Styles for Site 'Lessons ■ Огёап@И

1'3 НТМ151у1е8Ш@»»Ш ̂ 1л1
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Book: j O'REILLY HTML Reference 3
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HTML. JavaScript, and CSS.
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• Reference button on the Toolbar
• Help > Reference (Shift^FI)
• Window > Reference

Dynamic HTML: The Definitive
Reference, written and copyrighted by ^ i
Dannu Goodman, is the source of JU XiT

2.1-rasm. Dastur oynasining ko'rinishi.

qismi hisoblanadi. Texnik tizimlarning ishonchli ishlashi, dasturiy
mahsulotlarni interfeyslarining qulayligi asosida to'g'ri tashkil qilingan.
Dreamweaver paketi formatlash va tahrirlashning deyarli barcha
asosiy buyruqlari uchun amalga oshirishning bir necha xil usullarini
taklif etadi. Keng formatli ekranlarning egalari barcha buyruqiarni
palitralar va panellar yordamida bajarishlari mumkin. Bundan mahrum
foydalanuvchilarga esa dastur menyu qatori buyruqlarini va klaviatura
tugmalari kombinatsiyalaridan foydalanishadi.
70



Hujjat oynasi

Hujjat oynasi - bu gipermatnli hujjatlar yaratiladigan ish may-
doni hisoblanadi (2.2-rasm). U HTML sahifasi o'z ichiga olgan
matnlar, rasmlaa-, jadvallar, shakllar va boshqa"obyektlarni saqlaydi.
Dreamweaver, WYSIWYG sinfiga kiruvchi tahrirlagich dastur
hisoblanadi. Bu uzun atama inglizcha What you see is what you
get (siz nimani ko'rayotgan bo'lsangiz shuni olasiz) iborasining bosh
harflaridan tuzilgan. Bu narsa HTML sahifasining hujjat oynasida
aks ettirilishi uning yanada ommaviyroq ko'rib chiqish dasturlari
- Microsoft Internet Explorer va Netscape Navigator brauzerlarida
ifodalanishidan uncha farq qilmasligini bildiradi. HTML kodlari
bilan to'g'ridan-to'g'ri ishlash yuqori professionallik hisoblanishiga
qaramay. hatto eng tajribali WEB-dizayner ham grafik interfeys va
WYSIWYG rejimida hujjat yaratishda beradigan qulayliklardan voz
kecha olmaydi.

Ko'pchilik Windows ilovalaridan farqli ularoq Dreamweaver dasturi
bitta dastur oynasida bir necha hujjatlar bilan ishlay olmaydi. Tanlab
olingan parametrlarni o'rnatishdan kelib chiqib yangi hujjat dasturning
alohida oynasiga joylashtiriladi yoki joriy oynada avval ochilgan hujjat
o'rnini egallaydi. Bunday ish rejimida dastur oynasi va hujjat oynasi
orasida deyarli farq yo'q. Shuning uchun ham biz kelgusida bu nomlarni
sinonimlar sifatida ishlatamiz.

l^^iUnlitled Document (Untitied-I) - Preamweaver,v»
File Edit View Insert Modify lext Commands Site iVindow Help

Title: Entitled Document . С Ф U J

1

<boc(y> .[447"й90 VliRTTsea dfe, Ш 'dl 1) 0 E> 4

2.2-rasin. Hujjat oynasi.
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Ish rejimlari

WYSIWYG rejimida gipermatnli hujjat yaratish oddiy matn mu-
harriri bilan ishlashdan ko'p farq qilmaydi.

Matnni kiritish va formatlashning bazaviy amallari, obyektlarni
joylashtirish buyruqlari, navigatsiya va tanlash texnikasining barcha
amallari Dreamweaver dasturida so'nggi bir necha yi! davomida
vizual muhitda ustunlik qilish usulida amalga oshirib kelinmoqda.
Foydalanuvchi loyihalash yechimlarini HTML till vositalari tomonidan
qanday yo'lga qo'yilishi haqida o'ylab o'tlrmasdan tahrirlash va
formatlashning odatdagi vositalaridan foydalanib ishlashi mumkin.
Dreamweaver paketi dastlabki matnni avtomatik ravishda yaratadi,
unda hujjatning ma'lumot bilan to'ldirilishi va ro'yxatga olinishi bilan
gipermatnni belgilash tilining kodlari yoziladi.

Yaratuvchanlik ishining katta qismi WYSIWYG rejimida baja-
rilishi mumkinligiga qaramay ba'zan to'g'ridan-to'g'ri kodlashga
murojaat qilishga to'g'ri keladi. Buning bir nechta sababi bor. Asosan,
bu belgilash kodlarini juda ehtiyotkorlik bilan sozlash zarurligidir.
Bundan tashqari HTML tili standartida yuzdan ortiq deskriptorlar
haqida eslatib o'tiladi. Ularning har biri bir nechta atributlar va
modifikatorlarga ega bo'lishi mumkin. Gipermatnli belgilashning
eng ko'p talab qilinadigan vositalari Dreamweaver tizimi interfeysi
doirasida joylashtirilgan.

Dreamweaver dasturining hamma versiyalari, birinchisidan boshlab,
foydalanuvchiga belgilash kodlarini to'g'ridan-to'g'ri tahrirlash imkonini
beradi. Bu ish uchun qanday vositalar qo'llaniladi?

Birinchidan, bu maxsus ichiga qurilgan Code Inspector (kodlar
inspektori) tahrirlagich bo'lib, u Dreamweaver dasturini eng bi-
rinchi versiyalarida ham mavjud edi va bu oxirgi versiyalarda vaqt
davomida faqatgina dizayniga o'zgartirishlar kiritildi. Ikkinchidan,
foydalanuvchi HTML tiliga tashqi tahrirlagichlarni ulash imkoniyatiga
ega. Turli dasturlar: universal vazifali (masalan, Bloknot) oddiy matn
tahrirlagichlaridan boshlab, to murakkab gipermatnli hujjatlar bilan
ishlashga mo'ljallangan (Allaire Home Stile) yuqori darajali dastur
vositalarigacha bu rolni bajarishi mumkin. Dasturning MX versiyasida
juda qulay yangilik - hujjat oynasining ish rejimi paydo bo'ladi. Hujjat
oynasi uchta rejim yoki ko'rinishlardan birida bo'lishi mumkin.
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1.Ыт -.Code Ihspectdr

y^^Code Inspector I

I о m (b -1.
в bpoysepe </hUN l XIXhUN I UULUK="niUUUUU">d.gi' </TOm></l><hUN ^
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(Правка </FONT><l><FONT COLOR="/000000">&gl' </font></l><FONT F/
В любом случае на экране появится диалоговое окно </FONT><FOh '
(Настро1>]ки).</1ог|1></р>

<Р>
<Р>
<p><FONT FACE="Tir7ies Nevi/ Roman" COLOR="#000000">BbinonHHTe вс.
в этом диалоговом окне и введите их в действие щелчком на кнопк

<р>
<FONT FACE="Time£ New Roman" COLOR="#000000"> - ..■i

<P ALIGN="JUSTIFY'">PaccMOTpnM эти настройки (рис. 2.23).</P> д1
imI

2.3-rasm. Hujjatning belgili rejimida ko'rinishi.

2.3-rasm. Belgilash rejimidagi hujjat oynasi Code and View
(belgilash va rejalashtirish rejimi). Bu aralash rejim bo'lib, unda hujjat
oynasi ikkita qismga bo'linadi. Bir qismda gipermatnli belgilash kodlari
aks etadi, boshqasida dastur sahifani barcha obyektlar va formatlash
atributlari bilan rejaiashtirishni ko'rsatadi. 2.4-rasnida bo'sh sahifali
ajratilgan hujjat oynasi ko'rsatilgan.

Ish rejimini o'zgartirishning bir necha usuli bor. Birinchidari, bu
menyu qatori buyruqlari: View > Code, View - Design, View - Code
and Design. Ikkinchidan, uskunalar panelida bir rejimidan boshqasiga
tez o'tish imkonini beruvchi tugmalar bor. Va nihoyat, Ctrl + Tab
tugmalar kombinatsiyasi yordamida rejalashtirish rejimidan belgilash
rejimiga va aksincha, yoki ajratilgan oynaning bir qismidan boshqasiga
o'tish mumkin.

Ajratilgan hujjat oynasi qismlarining o'lchamlarini o'zgartirish
mumkin. Buning uchun ko'rsatkich yordamida ajratuvchi chiziqni
ko'chirish kerak bo'ladi. Oxirgi paytlarda dasturchilar orasida «dastlabki
matn» atamasi paydo bo'ldi. Yuqori saviyali dasturlash tilida yozilgan
dastur ishlab chiqishning dastlabki bosqichlarida shunday deb ataladi.
Bu atama gipermatnli hujjatning kodli qismi va ko'rinadigan obrazi
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2.4-rasm. Bo'sh sahifali hujjatning aialash rejimda ko'rinislii.

o'rtasida mavjud bo'lgan munosabatlardan tashkil topadi. Hujjatning
HTML tilida yozilishini dastlabki matn deb ataymiz.

Menyu qatori

Menyu qatori - bu Windowsning ixtiyoriy ilovasining zaruriy
atributidir. U buyruqlar yordamida, muloqot oynaiariga, tugmalarga
yo'l ochadi, ular yordamida hujjat yaratish, dasturni sozlash.
vizuallashtirish jarayonini boshqarish kabi dasturning barcha
funksional imkoniyatiarini o'z ichiga olgan samarali ishlar bajariladi.
Menyu qatorining bar bir bandi vazifasi jihatidan bir-biriga yaqin
kiritilgan menyu va kichik menyuiar ierarxiyasini hosil qiluvchi
buyruqlar guruhini birlashtiradi. Bu bandlarning qisqacha tavsifini
keltiramiz.

• File menyusi (Файл) fayllar bilan bog'liq buyruqlarni, gipermatnii
hujjatlar shablonlari bilan ishlash, eksport qilish, import qilish va
brauzer dasturlarida ko'rish buyruqlarini o'z ichiga oladi.

• Edit (Правка) menyusiga tahrirlash va qidirish bilan bog'liq
buyruqlar kiradi.
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• View (Вид) menyusi interfeysning yordamchi elementlaiini
va gipermatnli hujjat obyektiarining ko'rinishlari ustida ishlovchi
buyruqlarni o'z ichiga oladi. .

•  Insert (Вставка) menyusiga har-xil obyektlarni import qiiis
buyruqlari kiradi: rasmlar, jadvallar, shakllar, qatlamlar, maxsus belgilar
va boshqalar. • i, ••

• Modify (Изменить) menyusi o*z ichiga gipermatnli ujjat
obyektlari atributiarini o'zgartirish buyruqlarini oladi. .

• Text (Текст) menyusi matnli fragmentlarni hosil qilish va u arm
formatlash bilan bog'liq buyruqlarni o'z ichiga oladi.

• Commands (Команды) menyusi gipermatnli hujjatlarni avtomati
43yta ishlash buyruqlarini o'z ichiga oladi. . , u ч i -■

• Menyu qatorining Site (Сайт) bo'limi sayt bilan ish as yosi a an
va gipermatnli hujjatlar bilan bog'liq murakkab tizimlar vosita anm о
ichiga olgan. „

• Window (Окно) menyusi dasturga tegishli
Huloqot oynaiarini o'rnatish va aksincha olib tashlas i an
buyruqlarni o'z ichiga oladi. , , . .

• Help (Справка) menyusida dasturdan foy a ams
interfaol ma'lumotlarni chaqirish, elektron qo llanmani с aq
buyruqlar joylashgan.

Uskunalar paneli

Uskunalar paneli dasturning asosiy Lhrirlash
bajaradi (2.5-rasm). U eng ko'p isblatiladigan buyruqlar
resurslarini chaqirish tugmalarini birlashtiradi. Bu ixc bog'liq
kiritilgan menyu va kichik menyular tizimi naviga siya
sarf-harajatlarni anchagina qisqartiradi. _ . , n'tamizUnda joylashgan barcha boshqaruv elementlarra. saaab otam.z
fchapdan o-ngga): ЫмгтаюИ hujjatnmg faqat

• Code View (Режим разметки) ёФ
bclgili kodlari tasvirlanadi (dizayni tasviilanmay !)•

,  ̂ ^7- M a l-eTitle: iUntitied Document T ... ——

2.5-rasm. Uskunalar paneli.
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• Code and Design View (Режим разметки и планировки).
Tugmasi bosilganda hujjat oynasi ikki qismga ajraladi: birinchi oynada
belgili kodlar beriladi, ikkinchi oynada esa gipermatnli sahifaning
dizayni, ya'ni tashqi koTinishi beriladi.

• Design View (Режим планировки). Dasturda ishlashning vizual
— WYSIWYG rejimiga o'tish tugmasi.

• Title (Заголовок) — bu matnli maydon hujjatning sarlavhasini
kiritishga mo'ljallangan.

• File Management (Управление файлами) — tarmoqda ma'lumot
almashish uchun xizmat qiladigan fayllar bilan ishlash buyruqlaridan
tarkib topgan menyuni ochish tugmasi.

• Preview/Debug in Browser (Просмотр/отладка в браузе
ре) — tugmasi gipermatnli hujjatni ko'rish va undagi Java Script
kodlarini tanlangan brauzerda ishlash yoki ishlamasligini tekshiruvchi
buyruqlaridan iborat menyuni ochadi.

• Refresh Design View (Обновить страницу) - bu buyruq beril-
gandan so'ng, hujjatning belgili matnlarida bo'lgan barcha o'zgarishlar
loyihalash rejimiga uzatiladi. Ana shu vaqtda kodlarni interpritatsiyasi
va sintaksik tekshiruv boshlanadi. Xato fragmentlari sariq rangda
ko'rsatiladi. To'g'rilari esa sahifada tasvirlanadi.

• Reference (Справка) — tugmasi elektron ma'lumotli qo'llanmani
ekranga chiqarib beradi. Bu qoMlanmada gipermatnli belgilash tili
deskriptorlari ifodalangan.

• Code Navigation (Навигация no кодам) - tugmasi Java Script
tilida yozilgan belgili kodlarni tuzatishni boshqaruv buyruqlaridan
tarkib topgan menyuni ochadi.

• View Options (Параметры отображения) - tugmasi hujjat
oynasining qo'shimcha elementlari vizualizatsiyasini boshqaruvchi buy-
ruqlar menyusini ochadi. Bu menyuga asosiy menyu qatoridagi View
menyusining bir necha buyruqlari kiradi.

Sahifalar o'Ichamlarini belgilash

Virtual to'plam hech qanday tartib-qoidalarga va standartlarga
bo'ysunmasdan, tarqoq holda rivojlanadi. Bu esa ishlab chiquvchilar
va dasturchilar uchun ko'p sonli qiyinchiliklar manbai boMishi
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«Internet almashuvi»ning juda tez o'sishi sabablaridan biridir. Aslida
sahifaga yoki saytni ishlayotganda muallif o'z asarini turli kompyuter
tizimlarida aks etishi mumkinligini yodda tutishi kerak. Agar u tashrif
buyuruvchilarini (foydalanuvchilarini) yo'qotishni istamasa, u holda bar
xil o'lchamli va bar xil texnologiyalarni qo'llovcbi (elektron-nur trubka
bazasida bo'lishi shart emas) monitorlarda hujjatning aniq va qisqa
ifodalanishi haqida o'ylab ko'rish kerak.

Onlaynii hujjatlarni ko'rib cbiqishda brauzer oynasi o'lcbamlarini
o'zgartirisbga majbur qiluvchi bosbqa sabablar bam bor. Наг bir savodli
inson o'qisb tezligi bosbqa sabablardan tasbqari qator uzunligiga bam
bog'Iiqligini tusbunadi. Agar qatorlar biror me'yordan sezilarli farq qilsa
o'qilganning qabul qilinishi murakkablashadi. Psixologik tadqiqotiar
ko'rsatishicha, matn qatorining optimal uzunligi alfavit simvollari
soul bilan uzviy bog'iiq. Quiay o'qisb zonasini aniqlasb uchun alfavit
o'lcbamini 1,5 dan 2 gacha qiymatni qabul qiladigan koeffitsiyentga
ko'paytirish kerak. Bu narsa rus tilida matn qatorlari 70 simvoldan
uzun bo'lmasligini bildiradi. Ko'p foydalanuvcbilar bunday formulaning
mavjudligi haqida o'ylab ko'rmaydilar va xaddan tasbqari uzun qatorlar
paydo bo'lisbining oldini olisb ucbun brauzer oynasining o'lcbamlarini
cheklab qo'yadilar.

Dreamweaver paketini yaratuvcbilari dasturni turli o'lcbamdagi
monitorlarda bujjat qanday ko'rinishga ega bo'lisbini tasavvur qilisb
imkonini beruvchi maxsus vosita bilan ta'minlab qo'yganlar.

Holat qatorining o'rta qismida (2.2-rasm) bujjat oynasining joriy
o'lcbamlari piksellarda chiqariladigan maydon joylasbgan. Birincbi
son-kenglik qiymatini, ikkincbi son balandlikni o'lcbamini ifodalaydi.
Agar maydonning ixtiyoriy nuqtasida sicbqoncba tugmasini bosilsa, u
holda Windows va Macintosh platformalarida bisoblasb tizimlarining
eng ommaviy konfiguratsiyalari ucbun yettita standart o'lcbamga
ega bo'lgan yetti muloqot oynasi chiqadi. O'lchamni belgilash uchun
oynaning tegishli qatorini tanlash yetarli.

Menyuning birincbi bandi bujjat sohasining 592 pikselga teng
boigan kengligini belgilaydi va sohaning joriy balandligini o'zgarishsiz
qoldiradi. Edite Sizees (O'lcbamlarni to'g'rilasb)ning oxirgi bandi
bujjat oynasining o'lcbamlarini tanlasb va ularni standartlar ro'yxatiga
kiritish imkonini beradi. Ekranda Preferences (Sozlashlar) muloqot
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oynasi paydo bo'ladi, unda Width (kengiik, eni) maydonida kenglik,
HEIGHT (balandlik) maydonda esa soha balandligi belgilanadi.
Yangi standartning matnli tavsifi Description (tavsiya) maydonida
ko'rsatiladi.

Barcha o'lchamlar dastur oynasining xizmat elementlarini: o'lchov
chiziqlari va menyu qatorini inobatga olmasdan hisoblab chiqiladi.
Faqatgina hujjat va uning obyektlari uchun ajratilgan ishchi soha
hisobga olinadi.

Palitra va tez yuklanish paneli

Tez ishga tushirish palitrasi (Launcher) - bu asosiy muloqot
oynalari va dasturlar panellarini ekranga chiqarish uchun mo'ljallangan
yordamchi, xizmatchi palitra. Palitrani aks ettirish uchun Windows >
Launcher buyrug'ini bajarish kerak. Bu buyruqning takroran bajarilishi
palitrani ekrandan olib tashlaydi.

Palitraning Launcher (tez ishga tushirish) tugmasini bosish natija-
sida ekranga shu nomdagi muloqot oynasi chiqadi. Agar ochilgan
palitra ekranning oldingi qavatida joylashgan bo'Isa, buyruq tugmasini
takroran bosish uni yopilishiga olib keladi. Agar faol palitra hech
bo'lmaganda qisman boshqa obyektlar bilan to'silgan bo'Isa, u oldingi
qavatga o'tadi.

Palitra yettita eng ko'p talab qilinadigan dastur komponentlarining
tez ishga tushirish tugmalarini birlashtiradi:

Site (Сайт) - katta saytlarni boshqarish uchun muloqot oynasi,
murakkab kesishuvli bog'lanishlarga ega gipermatnli hujjatlar tizimi
uchun mo'ljallangan.

• Assets (Библиотека) - bu nom harfma-harf tarjimada faollar
yoki fondlar ma'nolarini beradi. Bu panel dasturda kutubxona rolini
o'ynaydi. U gipermatnli hujjatlar dizayniga tegishli elementlarni o'zida
saqlaydi. Bu elementlarga: tasvirlar, ranglar, tashqi bog'lanishlar, Flash
- roliklari, shablonlar va boshqalar kiradi.

. HTML Styles (Стили HTML) - bu palitra matnli qator va
abzatslar uchun HTML belgili stillar bilan ishlashga mo'ljallangan.

. CSS Styles (Каскадные листы стилей) - bu palitra stillarni
kaskadli sahifalar bilan boshqarish uchun xizmat qiladi. Keyinchalik
bu jumlani '«ierarxik stillar spetsifikatsiyasi» ko'rinishida ham
qo'llaymiz.
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• Behaviors (Режимы) - palitrasi gipermatnli sahifalarni inter-
faolligini boshqarish vositalarini o'zida birlashtirgan. Senariy sahifani
ko'rish jarayonida ro'y beradigan hodisalar asosida quriladi. Bu
jarayonning chizmasida ko'plab interfaol effektlar "yig'iladi: oddly
animatsiyalashgan tugmalardan tortib ma'lumotlar bazasini qayta
ishlashning murakkab protseduralarigacha.

• History (Предыстория) - palitrasi foydalanuvchining ЬП'МЬ
hujjatni tahrirlashdagi xatti-harakatlarini yozib boradi va saqlaydi.
Tahrirlash jarayonidagi operatsiyalarni bekor qilish imkonini beradi va
ayrim zanjirli ketma-ketliklarni buyruq ko'rinishida saqlaydi.

• Code Inspector (Инспектор кода). Dasturning eng muhim
palitralaridan biri. HTML kodining ichki tahrirlagichi bo'lib Dream-
weaverning grafikli rejimiga o'zaro bog'langan.

Tez ishga tushirish palitrasining o'ng tomondagi pastki burchagida
to'g'ri burchakli tugma joylashgan. Bu vosita palitraning yo'nalishini
o'zgartirishga mo'ljallangan. Tez ishga tushirish palitrasini o'zgartirish
mumkin. Buning uchun Edit > Preferences buyrug'ini berish kerak.
Dasturning asosiy sozlashlariga ega bo'lgan muloqot oynasi ochiladi.
Unda Panels (panellar) kategoriyasini tanlab oling va palitra ichidagi
Show in Launche (tez ishga tushirish palitrasida ko'rsating) bo'limida
beriladigan vositalar yordamida o'zgartiring. Holat qatorining o'ng
qismida (2.2-rasm) joylashgan.

Kontekstii menyu

Kontekstli menyu Windows operatsion tizimining boshlovchi
foydalanuvchilari uchun ham yaxshi tanish. Boshqaruvning bu
standart usuli ushbu operatsion tizimi boshqaruvida ishlovchi
ko'pchilik ilovalar (dasturlar) tomonidan ko'p qo'llaniladi. Uning
mohiyati sodda. Sichqonchaning o'ng tugmasini hujjat oynasining
obyekti ustida bosilsa, ekranga obyekt turiga bogiiq bo'lgan
mazmundagi menyu chiqadi. Bu menyuda shu obyektga tegishli yoki
ushbu holatda talab qilinishi ko'proq ehtimolligi bor bo'lgan buyruqlar
to'plangan.

Dreamweaver dasturining barcha versiyalarida kontekstli menyu
mavjud. Kontekstli menyuning o'lchami ya'ni buyruqlari safi kengaydi,
qo'shimcha darajalarga ega bo'ldi va endi har qanday holatda
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Paragraph Format

List

Align

Font

Style

CSS Styles

Size

Templates

Element View

Edit Tag <body>... Shift+F5

Quick TagEcfitor...

MakeLN^

Target Frame

ЛН ♦ г , • '

Create New Snippet

Paste Ctrl+V

Paste Special...

Design Notes for Page...
Page Properties...

2.6'rasm, Kontekstli menyu.

chaqirilishi mumkin. 2.6-rasmda oyna
ixtiyoriy bo'sh nuqtasida sichqonchaning
o'ng tugmasi bosilsa dastur chiqarib
beradigan kontekstli menyuga misol
keltirilgan.

Property Inspector palitrasi

Property Inspector (Инспектор
свойств) palitrasi — bu dasturning aso-
siy uskunasidir. HTML sahifasida
joylashgan obyektlar atributlarini o'z-
gartirish ishlarining asosiy qismini
uning yordamida bajariladi. (2.7-rasm).

Property Inspector palitrasi ko'chib
yuruvchi palitradan iborat bo'lib, uning
tarkibi bajarilayotgan operatsiyaga, tan-
langan obyekt turiga va kursorning
holatiga qarab, mos ravishda o'zgarib
turadi. Palitrani ekranga chiqarish uchun
quyidagi Window > Properties (Окно
> Свойства) buyruqni berish yoki
CTRL+F3 tugmalar kombinatsiyasini
bosish kerak. Bu buyruqni qaytadan
berish palitrani ekrandan olib tashlaydi.

Format I None
Link I

2  3 10

Default Font sU|N(Sr.e .■! rLl'
1] 4'Lij Г"; 3 Mii

12 13 14 15 16

2.7'rasni. Property Inspector palitrasi.
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Palitraning asosiy maydonlari va tugmalarini sanab o'tamiz.
Palitraning shu boshqaruv elementlari matnni formatlash va gipermatnli
bog'lanishlarni hosil qilishga tegishli vazifalarni o'z ichiga oladi;

• Format (Формат) ro'yxati matnning standart strul^turali tiplaridan
birini tanlash imkonini beradi (1).

• Link (Ссылка) ushbu hujjatga tegishli giperbog'lanishlar
ro'yxatini o'zida saqlaydi. Har bir bog'lanishni bir necha marta qo'llash
mumkin. Ya'ni bir marta tuzilgan bog'lanishni, boshqa fad hududlarga
ham takror qo'llash mumkin (2).

• Matn fragmenti shriftini belgilash imkonini beradi. Bu ro'y-
xatning punktlari shriftlar to'plamidan iborat bo'lib, qo'llanilishiga
qarab joylashgan (3).

• Size (Размер) ro'yxati shrift o'lchamini tanlash uchun mo'l-
jallangan (4).

• Standart ranglar palitrasini chaqirish tugmasi. Bu palitra tan-
langan matnli fragment rangini tanlash imkonini beradi (5).

• Tanlangan rangning kodi tasvirlangan yoki kiritiladigan maydon
(6).

• Shriftni holatini tanlash tugmasi. Ko'rinishi va funksiyasi standart
boshqa dasturlardagidek (7).

• Matnni tekislash tipini tanlash tugmalari (8).
• Interfaol yordamni chaqirish tugmasi (9).
• Marker-ko'rsatkich. Uni tegishli fayl yoki simvolga surish bilan

gipermatnli bog'lanish hosil qilinadi (10).
• Select File (Выбрать файл) muloqot oynasini ochish tugmasi.

Fayllar tizimida harakatlanish va gipermatnli bog'lanishlarni asosi
bo'lib xizmat qiladigan hujjatni tanlash (11).

• Target (Назначение) ro'yxati gipermatnli bog'Ianishda ko'r-
satilgan hujjatni ekranda yuklanish usulini tanlash imkonini beradi. Shu
bo'limda havolali hujjat chiqish oynasi yoki freymni belgilanadi (12).

• Ko'pchilik tahrirlagich dasturlarda standart ko'rinishda, matnli va
HTML, ro'yxatlarni belgilash va nomerlash tugmasi (13).

• List Item (Раздел списка) tugmasi List Properties (Свойства спи
ска) muloqot oynasini ochish uchun ishlatiladi. Bu oyna barcha tipdagi
ro'yxatlarni tahrirlashga mo'ljallangan (14).

•  Ikkita tugma, matnli fragmentlarni gorizontal surilishini bosh-
qaradi (15).
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• Kodlarni ekspress-tahrirlash oynasini chaqirish tuginasi (16).
• Expander arrow (Расширение) palitra o'lchamlarini o'zgartirish

uchun xizmat qiiadi. Lining yordamida Property Inspector (Инспектор
свойств) palitrasini ochish va yopish mumkin (17).

Property Inspector paneli yordamida bajariladigan buyruqlarning
ko'pchiligi qayta ishlanayotgan obyektlar: rasm, matn yoki jadvallarga
tegishlilari paydo bo'ladi. Xossalar panelida harakatlanish uchun TAB
tugmasini bosish yoki kerakli qismga sichqonchani chap tugmasini
bosish kerak. Tanlangan bo'limda kerakli ko'rsatkichni kiritib, ENTER
tugmasini bosish uni o'rnatilishi uchun yetarli.

Property Inspector panelining ko'plab boshqaruv elementlari
o'zida matnli yoki raqamli maydonlar kombinatsiyasi va bekiladigan
ro'yxatlaridan iborat. So'ralgan qiymatni klaviaturadan terish yoki
menyudan tanlash yoUi bilan tegishli parametrlarni o'rnatish uchun eng
quiay usul hisoblanadi.

Dreamweaver o'zining bir qancha qo'shimcha funksiyalari bilan
foydalanuvchilarga manzur bo'ldi: birinchidan, Dreamweaver barcha
palitralari erkin holatda turadi. Ularni qayerga surib qo'ysangiz
o'sha joyda joylasha oladi. Bu esa monitorning ish maydoni xududini
boshqaruvning xizmatchi elementlari va hujjatning oynasiga eng
optimal bo'lish imkonini beradi. Ikki monitorli tizimda ishlaydigan
foydalanuvchilar barcha yordamchi oyna va palitralarni bitta monitorga
joylab. ikkinchisida esa hujjatlar bilan ishlashi mumkin. Ikkinchidan,
dastur palitralari birlashish xususiyatiga ega. Uchinchidan, barcha
ochiq palitralarni dastur ish stolidan olib tashlovchi buyruq mavjud.
Bu operatsiyalarni F4 tugmasini bosish bilan ham bajarish mumkin. Bu
tugmani takror bosish esa yana tiklash imkonini beradi.

Obyektlar palitrasi

Faqatgina eng oddiy gipermatnli hujjatlar o'zida havola bo'yicha
boshqa hujjatlarga o'tuvchi buyruqlar biriktirilgan gipermatnli
fragmentlarni birlashtiradi. Ammo ko'pchilik zamonaviy HTML
sahifalari multimedialashib bormoqda. Ya'ni ularning tarkibiga quyidagi
tashqi obyektlar kiradi: multimediali fayllar, ijro etish vositalari,
kartinkalar, animatsiya fayllari va boshqalar. Objects (Палитра объек-
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2.8-rasm. Obyektlar palitrasi.

tob) palitrasi ana shunday tashqi obyektlarni yaratish va qo'yish uchun
xizmat qiiadi. Bu paiitrani ekranga chiqarish uchun Window > Objects
(Окно > Объекты) buyrug'ini bajarish kerak. Xuddi shu buyruqni
klaviaturadan CTRL +F2 tugmalar kombinatsiyasini bosish bilan ham
berish mumkin. Bu buyruqni takror berish paiitrani ekrandan olib
tashlaydi.

Palitra yettita nomdagi qismlardan iborat. Bular; Characters, Com
mon, Forms, Frames, Head, Invisibles, Special.

• Characters (Специальные символы). Klaviaturada uchramay-
digan maxsus simvollarni qo'yish (savdo markasi, kopirayt va bosh-
qalar).

• Common (Общие) — bo'limi eng ko'p qo'llaniladigan obyektlarni
birlashtiradi. Bu jadvallar, rasmlar, gorizontal chizg'ich, joriy ka-
lendardagi sanalar va boshqaiar.

• Forms (Формы). Formalar va elementlar, ularning tashkil qiluv-
chilari: yoqib-o'chiruvchilar, ro'yxatlar, matn maydonlai-i va boshqaiar.

• Frames (Фреймы). Freymlar tizimini yaratish. Har xil
ko'rinishdagi freymlar qismlaridan tarkib topgan freymlar tizmini hosil
qilish. Ya'ni yaratilayotgan saytni sahifasini freymlarga boiib olish.

• Head (Заголовок) - gipermatnli hujjatning sarlavha qismiga tav-
sif berish.

• Invisibles (Скрытые объекты). HTML sahifani brauzer dastur-
larida namoyish qilishda, ko'rinmaydigan yashirin obyektlarni joylash.
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Bu palitraning eng kichik qismi bo'lib, u faqat uchta tipdagi obyektlarni
qo'shib beradi: simvollari, izohlar va senariylar.

• Special (Специальные объекты) — bu bo'lim o'zida maxsus
obyektlarni qo'yish tugmalarini birlashtiradi. Bularga appletlar. ActiveX
obyektlari va boshqa tashqi to'ldiruvchiiarni (plagins) kiritish mumkin.

Palitraning pastki qismida ikki guruhga boiingan to'rtta tugnia
joylashgan: Layout (Компоновка) va View (Вид). Ular maketlash
rejimiga o"tish va sahifannig strukturasini tezda yaratishga imkon
beradi. Bu elementlar bilan qisqacha tanishib o'tamiz:

• Draw Layout Cell (Создание макетной ячейки) — maketli ka-
takcha yaratish uskunasini faollashtiradi.

• Draw Layout Table (Создание .макетной таблицы). Maketli
jadval yaratish uskunasini faollashtiradi.

• Standard View (Стандартный режим). Hujjat bilan ishlashning
standart rejimiga o'tish.

• Layout View (Режим макетирования) - Hujjatni maketlash reji
miga o'tish.

Ushbu bo'limni nomi palitra sarlavhasi qatori ostida tasvirlanadi.
Bo'limni ochish uchun shu nomni sichqoncha chap tugmasi bilan
bosing. Ochilgan menyudan foydalanuvchi kerakli qismni tanlashi
mumkin. Palitraning ayrim bo'limlarida hamma tugmalar ham
tasvirlanmaydi. Masalan, Common (Общие) bo'limi yigirmaga yaqin
tugmani o'z ichiga oladi, ularning hammasi ham palitra oynasiga
sig'maydi. Boshqa tugmalarni ko'rish uchun prokrutkadan foydalanish
(prokrutkani vazifasini palitraning chetida joylashgan strelkali tugmalar
bajaradi) yoki muloqot oynasining o'lchamini kattalashtirish kerak.

Aksariyat hollarda obyektlarni qo'yish uchun qo'shimcha para-
metrlarni kiritishga to'g'ri keladi. Bunday holatlarda ekranda foy
dalanuvchi tanlashi yoki ma'lumot kiritishi mumkin bo'lgan muloqot
oynasi paydo bo'ladi. Bu oynaga foydalanuvchi obyektning kerakli
obyektlarini tanlashi yoki kiritishi kerak.

Kodlar nazoratchisi bilan ishlash

Ko'p sonli HTML tahrirlagichlari sinfi orasida Dreamweaver dasturi
gipermatnli hujjatlar kodlari bilan ishlash imkoniyatlari jihatidan keskin
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farq qiladi. Foydalanuvchining HTML kodlarni qo'lda tahrirlashdan
qutilishi eng katta yutuq va tezkorlikni ta'minlab berdi.

Kodlar bilan to'g'ridan-to'g'ri ishlash, yashirin ° xatolarni iden-
tifikatsiya qilish. ortiqcha kodni bartaraf etish, gipermatnning
tanlangan fiagmentiga tezkor o'zgartirish kiritish, hujjatning struk-
turasini yoki uning formatlanishini optimallashtirish imkoniyatlari
mavjud.

Dreamweaver paketi tarkibida gipermatnli hujjatlarni belgilash
kodlarini ko'rish va tahrirlashga mo'Ijallangan maxsus vositasi mavjud.
Bu vosita Code Inspector (Инспектор кода) deb nomlanadi. Uni
quyidagi usullar bilan o'rnatish mumkin: birinchidan. Window > Code
Inspector (Окно > Инспектор кода) buyrug'ini berish yo'li bilan,
ikkinchidan. bu FIO tugmasini bosish yo'li bilan. Bu buyruqlar takror
bosilganda Code Inspector yana ish stolidan yo'qoladi.

2.9-rasmda Kodlarni nazorat qilish oynasi ko'rsatilgan. Palitrada
kodlarning belgilanishini tanishtirishni View Options (Параметры ото
бражения) tugniasi yordamida ochiladigan buyruqlar boshqaradi. Bu
buyruqlarni ko'rib chiqamiz:

1.Ыт' Code Inspector.

I к Code Inspector] '

т. о <?'> {}.

</HEAD> •
<body background=. /FON JPG>
<ul>

<li>j<b><forit fa.ce="Tif7ies New Roman CrR" :. ize = 3>< ^ "#1 ">2. С
оздан ие we b-y з л a</a > </tont> </b >
</li>
<ul>

<li><fonttace="Times New Roman C^r'R" siz0=3><a hr0f="#2">2.1.
Про0ктиро вами e </n > <./f о nt>

<ul>

<li><torit face="Times Nev\/ Roman CVR" size=3><a hret="#3">C

jJ 2Ш
2.9-rcism, Kodlar nazoratchisi.
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• Word Wrap (Перенос по словам). Kod qatorini ko'chirish rejimi.
Agar u yoqilgan bo'lsa, HTML tili bayonnomasi tahrirlagich oynasining
o'lchamiga yetganda avtomatik ravishda yangi qatorga o4adi.

• Line Numbers (Номера строк) — nomerlashni o'rnatlsh buy-
rug'i. Agar bu rejim o'rnatilgan bo'lsa, bar bir qator tartib bilan
nomerlanadi.

• Highlight Invalid HTML (Пометка некорректных кодов). Bu
buyruq sintaktik xatoga ega konstruktsiyalarni Property Inspector
panelida va hujjatning oynasida sariq rangda ajratish rejimini faol-
lashtiradi. Shundan so'ng Property Inspector xato haqida xabar beradi
va ayrim hollarda uni tuzatish uchun ko'rsatmalar beradi.

• Syntax Coloring (Раскраска синтаксических конструкция). Bu
rejimda belgili kodlar turli xil ranglarga ajratiladi. Bu esa hujjatning
kiritiladigan matni va belgili kodlarini tez ajratib olishga imkon
beradi. Bundan tashqari Dreamweaver dasturi HTML tilining har bir
deskriptori uchun alohida rang belgilash imkoniyatiga ega. Ranglarni
belgilashning dastur asosiy ko'rsatkichlarini Code Colors (Цвета кода)
bo'limida amalga oshiriladi.

• Auto Indent (Автоматический отступ) buyrug'i kodlar na-
zoratchisi oynasiga kiritilgan belgilash diskreptorlari uchun avtomatik
joy qoldirish rejimini faollashtiradi.

Kodlar nazoratchisi oynasining o'ng qismida uchburchak formada
tugma joylashgan. U hujjatning mavjud matnlariga xizmat qiladigan
buyruqlardan iborat menyuni chaqiradi. Bu buyruqlarni sanab o'tamiz:

• Find and Replace (Найти и заменить). Qidirish va almashtirish
vazifasini bajaradi.

• Find Next (Найти далее). Avval qidirilgan namunani mavjud
parametr asosida qidirish. Bunda qidirish va almashtirish muloqot
oynasi chiqmasdan to'g'ridan-to'g'ri amalga oshiriladi.

• Reference (Справочное руководство). HTML, JavaScript va CSS
manbalari asosidagi ma'lumotli qo'Ilanmani chaqiradi.

• Set Breakpoint (Вставить контрольную точку). Matn kursori
pozitsiyasida nazorat nuqtasini belgilaydi.

• Remove All Breakpoint (Удалить все контрольные точки).
Hujjatning mavjud matnidan barcha nazorat nuqtalarini olib tashlaydi.

• Cut (Вырезать). Tanlangan kodli fragmentni buferga qirqib olish.
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• Copy (Копировать). Tanlangan kodli fragmentni nusxasini bu-
ferga olish.

• Paste (Вставить). Buferga olingan fragmentni qo'yish.
Kodlar nazoratchisini matn muharriri uchun biroz g'ayri oddiy

holda muvaffaqiyatli qo'ilash mumkin. Dreamweaver dasturi ASCII
simvollarini qoMlash bilan yozilgan fayllarni, masalan oddiy matnli
fayilarni yoki dasturning dastlabki matnini muvaffaqiyatli o'qiydi.
Bunday hujjatlar Open (Открыть) buyrug'i yordamida ochiladi va kodli
rejimda ishlaydigan oyna hujjatiga yuklanadi. Bunda dasturning ba'zi
resurslariga kirish mumkin bo'lmay qoladi.

Dasturning kutubxonasi

Kutubxonalar — bu gipermatnli sahifaning dizayniga tegishli ko'p
marta qo'Hani lad igan elementlarni saqlash vositasidir. Bu elementlarga:
tasvirlar. bog'lanishlar. matn bo'laklari va boshqalar kiradi. Dream
weaver dasturida esa kutubxonaning ishlash prinsipi biroz boshqacha.
Dastlab kutubxonaga saqlashning bitta elementi hisoblangan,
obyekt yoki obyektlarga tegishli gipermatnli belgilash fragmentlari
saqlanadi. Dreamweaver dasturida kutubxona elementlari maxsus
Library papkasida saqlanadi. Bu papka saytning asosiy papkasi ichida
joylashadi. Har bir Web-uzel o'zining standart elementlari va ularni
saqlash papkasini tashkil qiluvchi shaxsiy kutubxonasiga ega. Ular bilan
ishlash uchun palitraning Assets (Ресурсы) bo'limidan foydalaniladi
(2.10-rasm). Kutubxonalar bilan boshqarish ishlarining asosiy qismini
palitraning Assets (Ресурсы) bo'limi buyruqlari yordamida amalga
oshiriladi.

Dreamweaverda kutubxonalarning asosiy imkoniyatlarini sanab
o'tamiz;

• Kutubxona elementi deb <body> deskriptori orasida yotgan har
qanday fragmentni aytish mumkin;

• Kutubxona elementlari qo'llanilishida cheksiz imkoniyatlarga
ega. Ularni gipermatnli sahifalarga hech qanday tahrirlashsiz qo'yish
mumkin;

• Kutubxona elementlariga o'zgartirish kiritilsa, ularni boshqa
gipermatnli sahifalar va hujjatlarda qo'llashda saqlanib qoladi.
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2.10-rasm. Palitraning Assets bo'limi.

• Sahifalardagi kutubxona namunasi va uning nusxalari orasidagi
aloqani uzishga ruxsat etiladi.

• Dastur alohida saytlar o'rtasida kutubxona elementlarini almashish
buyruqlariga ega.

• Kutubxonalar dinamik xususiyatga ega bo'lgan obyektlarni
saqlash xususiyatiga ega.

• Vaqt diagrammalari (timeline) va stillarning kaskadli saliifalari
kutubxonada saqlanishi mumkin emas.

Holat qatori va uni o'rnatish

Status Bar (Строка состояния) bu kichik bo'lim dasturning holat
qatori ko'rinishi ko'rsatkichlarini belgilaydi (2.11-rasm). Bu element
hujjat oynasining pastki qismida joylashgan. Odatda bu qatorda
joriy oyna o'lchami haqidagi ma'lumotlar va uning yuklanishi uchun
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Status Bar

Window Sizes; Width Height 1 Description 1*1
GOO 300 (640 X 480, Max...
760 420 (800 X 600, Max
795 470 (832 X 624, Max...
955 600 (1024 X 768, M...
544

1
378

—I

(WebTV)

1 1

Connection Speed: [Жв^ Kilobits per Second
Launcher; 17 Show Launcher in Status Bar

2.7/-rasm. Status Bar bo'limi.

ketadigan vaqt ko'rsatiladi. Undan tashqari holat qatorining o'ag qismini
tez yuklanish paneli egallaydi:

Window Sizes (Размеры окна). Gipermatnii sahifalar har xil
o'lchamdagi oynalarda tasvirlanishi mumkin. Window Sizes (Раз
меры окна) paneli standart o'lchamlar ro'yxatini to'ldirish uchun
mo'ljallangan. Barcha tahrirlash amallari klaviaturadan shu panelning
tegishli maydonlariga kiritish yordaraida bajariladi.

Connection Speed Kilobits Per Second (Скорость соединения,
Кбит/с). Bu maydonga server bilan bog'Ianishning taxminiy tezligi
kiritiladi. Bu joriy sahifani taxminiy yuklanish vaqtini belgilaydi.
Odatda 28,8 Kbit/s teziik o'rnatilgan bo'ladu

* Show Launcher in Status Bar (Панель быстрого запуска в
строке состояния) bu bayroqcha tez yuklanish panelini holat qatorida
chiqishini boshqaradi.

Savol va topshiriqlar:

1. Dreainweaver dasturida kodlar bilan ishlashning qanday imkoniyatlari
bor?

2. Kodlar nazoratchisini o'rnatish usullarini sanab bering?
3. Kodlar nazoratchisi nima va uning vazifalari nimalardan iborat?
4. Dasturning kutubxonasi nima?
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2.3. Fayllar bilan ishlash

Dasturning fayllarni ochish texnikasi Windows tizimida ishlaydigan
boshqa dasturlardan farqi yo'q. Buning uchun File > Open (Файл
> Открыть) buyrug'ini berish kerak. Bu buyruqni kiaviaturadan
CTRL+0 tugmalar kombinatsiyasini bosish bilan ham bajarish mumkin.
Bundan tashqari dasturda fayllarni ochishning surib kelish usuli ham
mavjud. HTML fayl belgisini sichqoncha yordamida surib kelib, hujjat
oynasining ixtiyoriy yeriga tashlansa fayl ochiladi. Dasturda bir vaqtda
bir nechta супа bilan ishlash imkoniyati faqatgina kompyuterning bo'sh
xotirasi bilan mos ravishda cheklanadi. Agar dasturda bo'sh sahifa bilan
ish boshlangan bo'lsa, u holda yangi fay! bar qanday holatda uni o'rnini
egallaydi.

Dreamweaver dasturi ochiladigan HTML sahifalarida sintaktik
xatolarni tekshiradi. Dastur standart HTML gipermatnli belgilash
tili asosida yozilgan barcha kengaytmali fayllarni ocha oladi. Ularga
quyidagilar kiradi: .HTM, .HTML, .ASP, .CFM, .CFML, .TXT, .SHTM,
.SHTML, .STM, .LASSO, .XML. .CSS, .PHP.

Fayllarni saqlash

Dreamweaverda fayllarni saqlash ham Windows tizimining boshqa
standart dasturlaridagi singari amalga oshiriladi. Buning uchun: File
> Save (Файл > Сохранить) yoki File > Save as (Файл > Сохранить
как) buyruqlarini berish kerak. Birinchi buyruqni CTRL+S tugmalar
kombinatsiyasini bosish bilan ham bajarish mumkin. Bu buyruq
shu nomdagi muloqot oynasini hosil qiladi. Oynada foydalanuvchi
tomonidan faylning nomi, tipi va saqlash joyi belgilanadi.

Gipermatnli hujjatlar fayllari Windows operatsion tizimida .htm
kengaytma oladi, Macintosh platformasida esa .html kengaytma oladi.
Ammo bu kengaytmadagi fayllarni dasturlarda ochish va saqlash
buyruqlari bajarilishi teng kuchli. Dasturda ochilishi mumkin bo'lgan
barcha tipdagi fayllar, xuddi shu dasturda saqlanadi ham.

Tabiiy sharoitda yoki ilmiy laboratoriyalarda o'tadigan ko'pgina fizik
Jarayonlar qaytmas hisoblanadi. Bu tabiatshunoslikda olamning butun
ilmiy manzarasini shakllantiruvchi fundamental qoidalaridan biridir.
Zamonaviy hisoblash mashinalari insonni bu falsafiy kategoriyadan
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qisman qutqarishga qodir. Ko'pchilik zamonaviy dasturlar qoniqarsiz
natijani bekor qilishga imkon beradi. Ya'ni hujjatning awalgi holatiga
qaytish, qabul qilingan qaroriarni qadamba-qadam-orqaga qaytarish
imkonini beradi.

Dreamweaver dasturida buning uchun Edit > Undo (Правка > От
мена) buyrug'ini bajarish yoki CTRL+Z tugmalar kombinatsiyasini
bosish yetarli.

Dastur bekor qilishni bir nechta o'zaro bog'langan ketma-ket
qadamda amalga oshiradi. Bu ketma-ketlik qadamlarining soni
dasturning tegishli ko'rsatkichida ifodalangan songa teng; odatda bu
son 100 ga teng.

Bu sonni quyidagicha o'zgartirish mumkin:
1. Edit>Preferences (Правка>Настройки) — buyrug'ini bering;
2. General (Обшие) kategoriyasini oching;
3. Maximum Number of History Steps (Максимальное число

записей журнала) maydoniga o'zingiz saqlamoqchi bo'lgan ketma-
ketiiklar maksimal sonini kiriting.

Tahrirlash ishlari va buyruqlarini yozish va saqlash foydalanuv-
chidan qo'shimcha hisoblash manbalarini talab qiladi.

Undo (Отмена) buyrug'i «eng muhim izlarni» bekor qilish
imkoniyatini beradi. Ammo bu usul bilan jarayonni bir necha bor
bajarib «bekor qilish» buyrug'idan yaxshi natija olib bo'lmaydi. Chunki
uning yordamida faqatgina eng muhim izlarni bekor qilish mumkin
xolos. Bundan tashqari, ayrim buyruqiarni bu usul bilan bekor qilib
bo'lmaydi. Bekor qilib bo'lmaydigan buyruqiarni orqaga qaytarish
yoki ancha oldin bajarilgan operatsiyalarni qaytarish uchun File >
Revert (Файл > Вернуться к сохраненному) buyrug'idan foydalanish
mumkin. Bu buyruq hujjatni oxirgi saqlangan holatini tiklab beradi.

Buyruqni ishlatish yo'li oddiy. Qaytarib bo'lmaydigan buyruqlar
mavjud ketma-ketlikni tiklashga berishdan oldin hujjatni diskka saqlab
olish kerak. Agar ish yaxshi natija bermasa, u holda Revert (Файл > Вер
нуться к сохраненному) buyrug'i hujjatni o'sha holatida tiklab beradi.

Dasturda bajarilgan operatsiyalarni takrorlash ham mumkin.
Edit > Redo (Правка > Повторить) buyrug'i oxirgi buyruqni yoki
tahrirlash ishlarini takroran bajaradi. Bu buyruqni CTRL+Y tugmalar
kombinatsiyasi yordamida ham berish mumkin.
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Shuni esda tutish kerakki, dasturning ish bayonnomasiga faqa a
«atuaviy ap^ratslyamr П1ШП|(1П; 3111^01131111 l(j|jljfi fl
o'cnirlsli, obyektlarni qo'yish, formatlash buyruqiari va bosh .
Faqat shunday holatlarni bekor cjilish yoki takrOllaSh miimkill. Ко
yofdamchi ti'pdagi buyruqlarni bekor qilib yoki takrorlab bo'lm i.
Kursorni surish, obyektlarni belgilash, hujjatni saqlash va bosh r
shular jumlasidan.

Savol va topishiriqlar:

1. Dasturda fayllarni ochish yo'llarini sanab bering?
2. Dastur yordamida qanday kengaytmali fayllarni ochish mumkin?
3. Dasturning fayllarni saqlash usullarini aytib bering?
4. Dasturning bekor qilish va takrorlash imkoniyatlarini sanab berin

2.4. Web-uzel yaratish

Jahon o'rgimchak uyasining (World Wide Web) barcha informat
manbalarini ikkita katta sinfga bo'lish qabul qilingan; sahifala
uzellar yoki saytlar. Biz yuqorida web — sahifalar taVifi bilan tanish

Web-uzellar ya'ni saytlar - deganda o'ziga sahifalarni birlashtir
tizim tushuniladi. Boshqacha aytganda uzel deganda minglab hujjatl
o'zida birlashtirgan, ko'psonli bog'lanishga ega, multimediali murak
tizim tushuniladi.

Dreamweaver paketi - bu ko'p qirrali dastur. Uni alohida sahif
yaratish uchun oddiy gipermatnli hujjatlar tahrirlagichi sifatida 
ishlatish mumkin. Bundan tashqari dastur har qanday murakkablikd
Web-uzellarni ham yarata oladi.

Chiziqli struktura

Kompyuter paydo bo'lgunga qadar barcha chop etiladigan; ba
kitoblar, qo'llanmalar, ma'lumotnomalar, texnik ko'rsatmalar chiz
strukturaga misol bo'la olar edi. Bugungi kunga kelib bularni multimed
qo'llanmalar va elektron ko'rsatmalar ko'rinishida qo'llanmoq
Chiziqli zanjir elektron magazinda buyurtma berishni rasmiylashtir
qadamlari, ayrim tarmoq manbalariga kirish uchun ro'yxatdan o'tish y
rasmiylashtir ish ketma-ketliklarini tushunish mumkin.
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2.12-rasm. Chiziqli struktura.

Chiziqli strukturaga kirish nuqtasi bo'lib birinchi sahifa xizmat
qiladi. Bu bosh sahifa odatda index.htm yoki main.htm deb nomlanadi.
Bu esa kitob yoki jurnaliardagi muqova rolini bajaradi. Bu sahifa bir
vaqtning o'zida ham namoyish bob, ham tanishtiruv sahifasi, ham
ma lumotli sahifa bo'lmog'i lozim. Qidiruv mashinalari har bir sahifani
alohida indekslaydi. Shuning uchun barcha ichki sahifalami bosh
sahifaga o'tkazadigan harakatlanish tugmalari bilan to'ldirish kerak.

lyerarxik struktura

Saytlar yaratishning zanjirii prinsipi sahifalar joylashuviga va ular
orasidagi bir-biriga o'tishlarga qat'iy cheklashlar qo'yishga asoslanadi.

2.13-rasm. ly erarxik struktura.
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lyerarxik bo'ysunish prinsipi bo'yicha qurilgan tugunlar ancha katta
moslashuvchanlikka ega. Ko'plab korxonalar, tashkilotlar lyerarxik
struktura chizmasi asosida qurilgan. Bu esa lyerarxik strukturanmg
kamchiliklari va yutuqlari yaxshi o'rganilganidan darak beradi. Bu
strukturani ba'zan daraxtsimon struktura ham deyilib, bitta bosh o'zak
(butun saytga kirish nuqtasi hisoblangan) sahifaga ega bo ladi.

Har qanday ichki sahifa informatsion manba hisoblanib bosh sahifa
bilan mantiqiy bog'langan bo'ladi.

Ko'p bog'Ianishli struktura

Ko'p bog'Ianishli strukturada hech qanday cheklanishlar bo'lmaydi.
Ya'ni har bir sahifa boshqa barcha sahifalar bilan bog'langan bo'lishi
kerak. Katta saytlarda tashrif buyuruvchilarning mo'ljal olishi uchun
maxsus indeksatsiya tizimlari yoki saytning aylanish kartasi ifodalanishi
kerak.

2.14-rasm. Ko'p bog'Ianishli struktura.

Materialning taqsimoti

Materialning Web-uzelda bo'limlar bo'yicha taqsimoti mantiqiy
ravishda amalga oshirilishi kerak. Har bir sahifaga faqat belgilangan
predmet yoki mavzudagi material joylanishi kerak. Tanlangan
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gipermatn ostida aynan shu mavzudagi hujjat borligi foydalanuvchining
ishonchini yanada orttiradi. Ay rim hollarda buning aksini, ya'ni
tanlangan gipermatnga xos boimagan hujjatning ochilishinl ham ko'rlsh
mumkin.

Saytni qismlarga bo'lislida ham ma'lumotning katta-kichikligiga,
ma lum mavzu yoki predmetga xosligiga qarab bo'lish ham maqsadga
muvofiqdir. Yuqorida aytilgandek biror sahifada bir predmet yoki
mavzuga xos bo'igan matnlar bilan birga, rasmiar, jadvallar, ani-
matsiyaiar va boshqa ko'rinishdagi materiallarning ham shu bo'Iimga
xosligi katta ahamiyatga ega. Ma'iumotlarning mos kelmasligi foyda-
lanuvchiiarning ishonchini yo'qotib, ularning sonini keskin kamaytirib
yuboradi. Bunday holatga tushib qolmaslik uchun Web-dizaynerdan
qunt bilan ishlashni talab qiiadi. Agarda tayyorlanayotgan saytdagi
materiallar Web-dizaynerga notanish mavzuda bo'isa, u holda o'sha
sohadagi biror yetuk mutaxassis bilan hamkorlikda ishlashga to'g'ri
keladi.

Web-saytiarni internetga joylash uchun manzil berish

Saytlarga internetda manzil berish uchun URL (Uniform Resource
Locator) deb nomlanadigan ibora qo'llaniladi. URL-intemetga mu-
rojaat qilishning eng oddiy usuli bo'lib, u manzilni ifodalaydi. URL
manzilidan ixtiyoriy sondagi foydalanuvchi bir vaqtning o'zida
foydalanishi mumkin. URL manzili qat'iy format asosida yoziiadi (2.15-
rasm).

Протокол: // хост :порт / путь / файл #фрагмент
2.15-rasm. URL manzili struktiirasi.

Manzilni to'liqroq tushunish uchun quyidagi misolni ko'rib chi-
qamiz;

http://www.pedagog.uz/index.php
bu URL manzili tarkibiy qismlari quyidagicha:
http - resursdan foydalanishda gipermatn bayonnomasi ishlati-

layotganini bildiradi.
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www.pedagog.uz — ma'lumotlar joylashgan Internet sayt nomini
biidiradi.

Index.php — faylning kompyuterdagi to'la nomini biidiradi.
Manzilning asosiy tashkil qiluvchilarini ko'rib chiqamiz:
• Протокол — bayonnoma. Internet — mijozlari va serverlarining

bog'Ianishi usulini tavsiflovchi qism. Odatda http (HyperText Transfer
Protocol) gipermatnli uzatish maxsus bayonnomasidan foydalaniladi.
Manzil kichik lotin harflari bilan yoziladi (http://).

• Имя сервера. Bunda joylanadigan ma'lumotlarni saqlaydigan
hisoblash tizimining (bu hisoblash tizimini server deb nomlash qabul
qilingan) nomi ko'rsatiladi. Serverga berilgan ta'rifda ham — tarmoq
ishini nazorat qiluvchi kompyuter deb aytilganligi bejiz emas. Server
nomi domen nomi kabi www bilan yoki usiz yozilishi mumkin.
Masalan, www.macromedia.com. Boshqacha usulda nomni IP — adres
ko'rinishida ifodalash mumkin. Masalan, 199.227.52.143.

• Порт. Port raqamini ko'rsatish bitta server ichidagi jarayonni
adresatsiya qilish uchun talab etiladi. Biroz vaqtdan keyin port
ishlatiladi va uning raqamini tushirib qoldirish mumkin.

• Путь поиска. Kataloglar va ostki kataloglar zanjiri, faylning
joylashgan o'rnini belgilaydi. Bu zanjirning elementlari «/» simvoli
bilan ajratiladi.

• Файл. Faylning nomi uning kengaytmasi bilan birga yoziladi
(faqat kengaytma so'ralgan platformada). Agarda faylning nomi tushirib
qoldirilgan bo'lsa, u holda Web-brauzer ko'rsatiladigan faylni qidiradi.
Brauzer reaksiyasi va uning keyingi harakatlari faylning nomini
kengaytirishga bog'liq bo'ladi. Masalan, grafik fayllari GIF yoki JPG
ko'rish dasturiga tasvirlarning yuklanishini boshlab beradi. Arxiv
fayllar (ZIP, RAR va boshqalar) bilan uyg'unlashgan kengaytmalar -
mijoz kompyuterida faylning saqlanishini boshlab beradi.

• Фрагмент. URL adresining fakultativ qismi. U # (panjara)
maxsus simvoli bilan boshlanadi. Bu belgi gipermatnli hujjatning
lavhasini ajratib ko'rsatuvchi maxsus belgidir. Tarkibga qo'shib qo'yish
simvoli nomining kiritilishi butun sahifaga emas, balki uning ma'lum
bir qismrga murojaat qilish imkonini beradi.

http bayonnomasi bo'yicha bog'lanish Internet tarmog'ida eng ko'p
tarqalgan usul. Internetdagi obyektlarning manzillari, aloqaning boshqa
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uslublarini va bayonnomalarini o'z ichiga olishi mumkin. Ulardan bir
^nechtasini sanab o'tamiz.

2.1-Jadval

Bayonnoma
nomi

Yozish

qoidasi
Qo'llanish sohasi

FTP ftp:// Fayllarni uzatish bayonnomasi. FTR-serveri bilan
bog'lanish uchun qo'llaniladi

File file:// Kompyuter yoki lokal tarmoqda berilgan fayl-
larga bog'lanish bayonnomasi

Gopher gopher:// Gopher serveriga bog'lanish bayonnomasi

JavaScript javascript: JavaScript tilida yozilgan dasturni chaqirish

Mailto mailto: Elektron pochta manzili

Newt news: Telekonferensiyalarga bog'lanish bayonnomasi

Telnet telnet: kompyuterga bog'lanish bayonnomasi

Internetning bugungi ommaviyligini tushuntiruvchi sabablardan
biri HTTP bayonnomasi imkoniyatlarinipig kengligidir. O'zidan awalgi
avlodiarining ba'zi bayonnomalarini u butunlay yutib yuboradi.
Ba'zilarini esa shunchaki siqib chiqaradi va koTgazmali grafik inter-
feys yordamida qo'llab-quvvatlash yo'li bilan yaxshiroq imkoniyat
yaratadi.

Lokal uzel yaratish. Uzel kartasi

Dreamweaver dasturida saytlar va sahifalar yaratishning bar
xil yo'llari bor. Bulardan saytlarni yaratish bo'yicha eng mashhur
texnologiyani ko'rib chiqamiz. Buning uchun quyidagi ketma-ketlikni
bajaramiz;
• saytning lokal versiyasini yaratish;

7 - Pedagogik web-dtzayn gy



•  lokal versiyani Internet tarmogMga joylash.
Lokal uzel - bu foydalanuvchi yoki foydalanuvchilarning kompyu-

terida joylashgan haqiqiy virtual Web-uzelning versiyasidir. Lokal uzel
tarmoqdan ko'rinmaydi, unga faqat mualliflarigina bog'lana olishlari
mumkin.

Lokal uzelning rna'lumotlari diskdagi belgilangan katalog ichida
saqlanadi. Bu katalog vazifasini diskdagi bar qanday katalog bajarishi
mumkin. Yangi lokal uzel hosil qilish uchun quyidagi ketma-ketliklarni
bajaring:

1. Site > New Site (Сайт > Создать) buyrug'ini bering. Ekranda
2.16-rasmda ko'rsatilgan Site Definition (Определение сайта) muloqot
oynasi hosil bo'ladi.

2. Gynaning chap qismidan Local info (Информация о локальном
узле) bo'limini tanlang. Maydonning qiymatini kiriting.

3. Remote Info (Сведения об удаленном сервере) kategoriyasiga
sayt saqlanayotgan server haqidagi ma'lumotlarni kiriting.

Site Definition for Unnamed Site 1 ■>. -f. V

Categoiy Local Info

Remote Info
Design Noles
Site Map Layout
File View Columns

SileHame: Unnamed Site 1

Local Pool Folder: |C:\Program FilesVMacromediaVDfeamweav
P" fiefresh Local File List Automatically

HTTP Address: |hUp./7
This address enables the Link Checker to
detect HTTP links that refer to your own
site.

Cache: P Enable Cache
The cache maintains file and asset
information in the site. This speeds up the
Asset panel, link management, and Site Map
features.

OK Cancel Help

2.16'rasm. Lokal uzelni sozlash.
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4, Muloqot oynasining yuqorida sanalgan maydonlar to'ldirilishi
shart. Site Map Layout (Планировка карты узла), Design Notes
(Комментарии разработчика) va File View Columns (Колонки ото
бражения файловых атрибутов) maydonlari to'ldirilishi shart emas
(foydalanuvchi o'z xohishiga qarab to'ldirishi mumkin).

5. Barcha kerakli ma'lumotlar kiritilgach OK tugmasini sichqoncha
yordamida bosing yoki ENTER tugmasini bosing.

Uzel kartasi

Uzel kartasi — lokal uzel yaratishning qulay interfaol vositasi
hisoblanib, unda ko'plab texnik qiyinchiliklarga ega bo'lgan topshiriqlar
grafikli ko'rinishda yengillik bilan amalga oshiriladi. Bu rejimda
saytning kartasi tasvirlanadi. Uzel dispetcheri oynasi ikki qismga
bo'lingan. Chap tomonda uzelning kartasi kiritiladi (Kartada - sahifa
belgilari HTML fayllarni ifodalaydi). Hujjatlar orasidagi gipermatnli
bog lanishlarni strelkalar ifodalaydi.

О ng tomonda esa uzelning fayllar va kataloglar ro'yxati beriladi.
Kartaning ko'rinishi organizatsion diagrammani eslatib yuboradi. Kartada
ikki darajani ko'rish mumkin. Yuqori darajani uzelning asosiy sahilasi
egallaydi. Quyi darajada esa unga tegishli va o'zaro giperbog'lanishga ega
sahifalar tushuniladi. Uzelning gipermatnli hujjatlaridagi bog'lanishlar
ко к rangda tasvirlanadi. Agar bog'lanishda ko'rsatilgan fayl kengaytmasi
.HTM, .HTML va boshqa shu formatdagilardan farq qilsa u holda yashil
rangda tasvirlanadi. Agar bog'lanishda qo'ppl xatoliklar bo'lsa, u holda
bog lanish qizil rangda ifodalanadi. Tashqi fayllar, boshqa fayllarda
joylashgan fayllar va maxsus bog'lanishlar (masalan, mailto: yoki
javascript:) globus ko'rinishidagi maxsus belgi oladi. Bulardan tashqari
agar ko'k rangli belgi qo'yilgan bo'lsa - bu fayl foydalanuvchining o'zi
tomonidan taqiqlanganini bildiradi. Qulf belgisi ostidagi belgi feqat
о qish uchun mo'ljallangan fayllarni bildiradi.

Savol va topshiriqlar:

1. Lokal uzel nima?
2. Lokal uzel hosil qilish ketma-ketligini aytib bering?
3. Uzel kartasi nima?
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2.5. Hujjatlarga havolalar o'rnatish va olib tashlash

Tegishli hujjatga havoia o'rnatish unchalik murakkab emas. Bun-
da foydalanuvchini chalkashtiradigan eng asosiy muammo — bu ope-
ratsiyani bajarish usul va uslublarining ko'pligidir. Qachonki biror
hujjatga yoki sahifaga havoia o'rnatmoqchi bo'lsangiz. buning uchun
quyidagi uch hoiatdan birini beigilash kerak. Ular blr-biridan fayining
holati va yuklanish texnikasi biian farq qiiadi.

• Havoia uchun ko'rsatilgan hujjat uzelning hisobidagi obyekt
sanaladi. Ya'ni fayining nomi fayllar va papkalar ro'yxatidan iborat
uzelning kartasi va panelida ifodalzuiadi. Sunday faylga havoia o'rnatish
uchun asosiy hujjatni tanlash, sichqoncha yordamida marker ko'rsat-
kich bog'lab olib, uni tegishli hujjatga olib o'tish lozim. Marker-
ko'rsatkich — bu havoia o'rnatish uchun maxsus interfaol vosita hi-
soblanadi. Markerni uzel dispetcherining har qanday paneliga (kartaga
yoki fayllar ro'yxatiga) surib kelish mumkin.

• Butun hujjat saytning tarkibiga kiradi, ammo uning ro'y
xatidan o'tmagan. Ya'ni uning nomi o'ng paneldagi fayllar ro'yxatida
mavjud, ammo u uzel kartasida yo'q. Bunday holatlarda marker ko'r-
satkichni o'ng panel ustiga surish va uni fayl nomi ustiga tashlash
kerak.

• Butun hujjat saytga kirmagan. Bunday holatda marker-ko'rsat-
kichini surishni teskari yo'nalishini qo'llash kerak.

Havolani o'zgartirish

Havolalarni o'zgaitirish uchun eski bog'lanishga tegishli ko'rsat-
kichlarni o'chirib tashlab, yangi faylga tegishli ko'rsatkichlarni kiritish
mumkin. Ammo Dreamweaverda buni o'zgartirish uchun maxsus
vositalar mavjud:

1. Uzel kartasidan hujjat belgisini tanlang;
2. Uzel dispetcheri oynasidan Site > Change Link (Сайт > Из

менить ссылку) buyrug'ini bering. Xuddi shu buyruqni — CTRL+L
tugmalar kombinatsiyasi yordamida ham berish mumkin;

3. Select HTML Files (Выбор гипертекстовых файлов) muloqot
oynasi ochiiadi. Unda yangi fayining nomi va joylashgan katalogini
ko'rsatish kerak;
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Change Link Site wide (Site - Unnamed Site^ 3 QQPy) ' tt 1 j! i'

Change All Links To:

U

Into Links To:

flK I

Cancel

Help I

2.17-rasm. Bog'ianishni yangilash.

4. Fayl tanlangandan keyin, Dreamweaver dasturi Update Files
(Обновление файлов) muloqot oynasi ochiladi. Barcha o'zgarishlarni
qo'shish uchun Update (Обновить) tugmasini bosing.

Agar bir nechta hujjatlar bilan bitta hujjat o'rtasida bog'lanish
o'rnatmoqchi bo'lsangiz buning uchun maxsus buyruq mavjud. Bu
buyruq yordamida barcha obyektlardagi havolalarni global tarzda
o'zgartirish mumkin. U barcha gipermatnli havolalardagi ko'rsatilgan
faylni nomini o'zgartirib chiqadi.

1. Uzel dispetcheri oynasini oching;
2. O'zgartirilishi kerak bo'lgan hujjatni oling;
3. Site > Change Link Sitewide (Сайт > Изменить связи по всему

сайту) buyrug'ini bering. Shu nomdagi muloqot oynasi ochiladi (2.18-
rasm).

Change Link Sitewide (Site ; Unnamed

Change All Links T o:

Into Links To:

a,

a ;

OK I
Cancel

Help j

2. IS-rasm, Havolani global o'zgartirish.

101



1. Tanlangan faylning nomi Change All Links To (Изменить все
ссылки на) maydonida ifodalanadi. Yangi faylning nomini Into Links
To (Ha ссылки на) maydoniga kiritish yoki standart protseduralar
yordamida tanlash mumkin.

2. OK tugmasini (кнопка) bosing yoki ENTER (клавиша) tug-
masini bosing.

3. Update Files (Обновление файлов) muloqot oynasi ochiladi,
bunda bog'lanishga ega va ayni vaqtda yangilanishni talab etadigan,
fayllar nomi aks etadi. Fayllarni tanlang va ularga tegishli havolani
o'rnating.

Change Link Sitewide (Изменить связи по все.му сайту) buyrug'i
ham havolalarni ommaviy almashtirish uchun juda qulay. Masalan,
bunday almashtirishlarni ko'pincha saytning barcha sahifalaridagi
elektron pochta adresini almashtirish uchun qo'llash mumkin.

1. Change All Links To (Из.менить все ссылки на) maydoniga
o'zgartirilishi kerak bo'lgan havolani to'liq kiriting.

2. Into Links To (Ha ссылки) maydoniga to'liq yangi havolani
kiriting.

3. OK tugmasini bosing.

Havolani olib tashlash

Havolani olib tashlashni bir nechta usullari mavjud. Masalan,
havolaga tegishli, ya'ni manba hisoblangan hujjat faylini ochish va
uni oddiy yo'l bilan o'chirib tashlash mumkin. Bu usul balki noqulay
tuyulishi mumkin, ammo maksimal aniqlikda bo'ladi. Uzel dispetcheri
orqali amalga oshiriladigan bog'lanishni olib tashlash usulini ko'rib
chiqamiz;

1. Uzel dispetcheri oynasini oching;
2. Uzel kartasidan bog'lanishni ko'rsatuvchi hujjat belgisini oling;
3. Site > Remove Link (Сайт > Удалить ссылку) buyrug'ini bering.

Bu buyruqning klaviaturada ikkita ekvivalenti bor: CTRL+SHIFT+L
tugmalar kombinatsiyasi yordamida ham berish mumkin.

Sarlavhani o'zgartirish

Dreamweaver dasturi HTML hujjatining sarlavhasini uzel dis
petcheri oynasida almashtirish (o'zgartirish) imkonini beradi. Shuni esa
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tutish kerakki gipermatnli hujjatning sarlavhasini <title> deskriptori
belgilaydi. Bu matn qatori hujjatning nomi hisobianadi va qidiruv
tizimlarida hujjatni indeksatsiyalashda muhim rol o'ynaydi. Eng
mashhur Internet Explorer va Netscape Navigator brauzerlar sarlavhani
dastur oynasining sarlavha qatoriga chiqarib beradi.

Sarlavhani o'zgartirish uchun quyidagilarni amalga oshirish kerak:
1. Uzel dispetcherini oching (ALT+F8).
2. View > Show Page Titles (Вид > Показать заголовки стра

ниц) buyrug'ini bering. Bu buyruqni CTRL+SfflFT+T tugmalar
kombinatsiyasi yordamida ham berish mumkin. Natijada uzel kartasida
gipermatnli fayllar nomi o'rnida ularning sarlavhasi beriladi.

3- Hujjatni tanlang va File > Rename (Файл > Переименовать)
buyrug'ini bering yoki klaviaturadan F2 tugmasini bosing.

4. Yangi sarlavhani kiriting va ENTER tugmasini bosing.

Savol va topsliiriqlar:

1. Giperhavola nima?
2. Gipermatn nima?
j. Ixtiyoriy hujjatga havola o'rnatish tartibini aytib bering?
4. Havolani o'zgartirish ketma-ketligini aytib bering?

2.6. Dasturning HTML bilan ishlasb imkoniyatlari

Dreamweaver dasturining foydalanuvchilari gipermatnli hujjatlar-
ning ko'plab tahrirlash operatsiyalairini to'g'ridan-to'g'ri HTML
deskriptorlari yordamida bajarishi mumkin. HTML tili haqida
biz yuqorida batafsil maTumot oldik. Bu tilning elementlarini
deskriptorlar yoki teglar deb nomlash qabul qilingan. Ingliz tilidan
tag (yorliq, belgi va boshqa ma'nolarni beradi). Deskriptorlarni
saqlash uchun ASCII belgilari qoMlaniladi. Shuning uchun har
qanday gipermatnli hujjatni belgilashni har qanday oddiy matn
muharrirlarida bajarish mumkin. Buning uchun xatto Блок
нот dasturi ham yetarli. HTML tilining kodlari hujjatning matnli
massivlari qismi hisobianadi.

Endi deskriptorlar bilan tanishib chiqamiz. Deskriptorlar ikki xil
boTadi. Yakka va juft deskriptorlar. Juft deskriptorlar ayrim xollarda
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konteynerlar deyiladi. Hujjatga tegishli matnlar va lining belgili
kodlarini ajratish uchun, HTML till kodlari burchakli qavsiarda
yoziladi. Masalan, <br> yoki <p>. Juft deskriptorlar (konteynerlar)
o'z ichiga deskriptorlar juftligini, ochiladigan (boshlang'ich) va
yopiladigan (oxirgi) deskriptorlarni oladi. Bu juftliklar <tag> </tag>
ko'rinishida yozilib, o'z qiymatini juftlik orasidagi hujjat fragmentiga
o'tkazadi. Boshqacha aytganda konteyner juftliklari orasiga hujjat
fragmenti yoziladi. Deskriptorlar ana shu fragment uchun ishlaydi
xolos. Yakka deskriptorlarda yopiladigan teg bo'lmaydi. Masalan,
<hr> deskriptori gorizontal chiziq hosil qiladi, <br> — esa matnli
qatorni ifodalaydi, eng muhim yakka deskriptorlardan biri <irng>
maxsus kodi hisobalanadi. U rasmlarni qo'yiladigan holatini va
joylashuvini belgilaydi.

Endi Dreamweaver dasturida shablon asosida yangi hujjat hosil
qilamiz. Yangi hujjatning bo'sh (to'ldirilmagan) bo'lishi hammamizga
ma'lum. Quyida bunday sahifaning Dreamweaver dasturidagi
gipermatnli belgilari keltirilgan:

<html>

<head>

<title>Untitled Document</title>

<meta http-equiv-»Content-Type» content-»text/html; charset=iso-
8859-1»>

</head>

<body bgcolor=«#FFFFFF»>
</body> </html>
Bundagi deskriptorlarning vazifalari bilan HTMLda tanishib

chiqdik. Undan tashqari <meta> deskriptorining charset atributi
internetda tanlangan simvollarni namoyishini ta'minlovchi kodirovkani
ifodalaydi. Odatda yangi shablondagi (iso-8859-1) kodli to'plam kiril
simvollarini ifodalay olmaydi.

Deskriptorlarni kiritish qoidalari

Belgilash kodlarini to'g'ridan-to'g'ri kiritish hujjatning faqat max
sus rejimida amalga oshiriladi. Bu rejimga o'tishning bir nechta
imkoniyatlari bor. Ulardan ayrimlarini ko'rib chiqamiz:
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^ • Window > Code Inspector buyrug'ini baring. Xuddi shu buyruqni
FIO tugmachasini bosish yordamida ham berish mumlcin;
• Uskunalar panelining chap qismida joylashgan Code View (Ре

жим разметки) tugmasini bosib kodlarni tasvirlash rejimiga o'tish
mumkin;

• Uskunalar paneiidagi chapdan ikkinchi Code and Design View
(Режим разметки и планировки) tugmani bosish bilan hujjat oynasini
ikki qismga bo'lish mumkin.

Kodlar nazoratchisida joriy hujjatning kodlari tasvirianadi. Bel-
giiashda qo'llaniladigan ko'pchilik deskriptorlar alohida rangda
tasvirianadi. Deskriptoriarning ranglari dastuming asosiy ko'rsat-
kichiariga kiradi. Ranglarni foydalanuvchining xohishiga qarab
o'zgartirish mumkin. Agar foydaianuvchi hujjat ustida biror tahrirlash
ishlarini olib bormoqchi bo'Isa u holda F5 tugmasini bosish yoki View
> Design View (Вид > Обновить) buyrug'ini berish kerak. Bu buyruq
hujjatning kodlarni belgilash rejimidan tahrirlash rejimiga o'tkazadi.
Tahrirlash rejimidagi obyektlarni qo'yish, formatlash buyruqlari va
har qanday o'zgarishlar darhol kodlar inspektoriga ko'chadi. Agar
tahrirlash rejimida biror obyekt yoki fragmentni belgilasangiz,
kodlarni belgilash rejimida ham shu obyekt yoki fragmentga tegishli
kodlar belgilanadi. Bu esa dasturda ikki yoqlama ishlash imkoniyatini
ta'minlab beradi.

Kodlardan nusxa olish

Dreamweaverda boshqa HTML tahrirlagichlari bilan gipermatnli
belgilashdagi kodlarni almashish imkoniyati- mavjud. Buning uchun
Windows operatsion tizimining ko'pchilik dasturlarida mavjud bo'l-
gan, belgilangan fragmentdan nusxa olish va qo'yishning standart
buyruqlaridan foydalaniladi. Aytaylik HomeSite dasturida ochilgan
gipermatnli hujjatning belgilash kodlaridan nusxa olishimiz kerak:

Nusxa olish uchun Edit > Copy (Правка > Копировать) yoki
CTRL+C tugmalar kombinatsiyasidan foydaianamiz;

Buferga olingan nusxani qo'yish uchun Edit > Paste (Правка >
Вставить) yoki CTRL+V tugmalar kombinatsiyasidan foydaianamiz.

Matn muharrirlarida tanlangan fragmentni sichqon yordamida surish
yo'li bilan ko'paytirish imkoniyati mavjud. Bu imkoniyat Dreamweaver
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dasturida ham ishlaydi. Buning uchun CTRL tugmasini bosgan holda
belgilangan fragmentni sichqon koTsatkichi bilan kerakli joyga surib
ko'paytirish mumkin.

Savoi va topshiriqlar:

1. HTML so'zining lug'aviy ma'nosi qanday?
2. Deskriptorlar nima?
-5- Deskriptorlarning qanday ko'rinishlari mayjud?
4. Deskriptorlarni kiritishni tushuntirib bering?

2.7. Hujjatning o'lchamlarini belgilash

Dasturda yaratilgan bar qanday yangi hujjat bo'm-bo'sh
rangdagi fonli sahifadan iborat boiadi. Hujjatda ish boshlashdan oldin
uning bir qancha muhim parametrlarini kiritib olish kerak. Bular ish
maydonining o'lchami, fon rangi, hujjat sarlavhasi, havola ranglaridir-
Bu parametrlarni ish jarayonining ixtiyoriy vaqtida ham o'zgartirish
mumkin. Sanalgan barcha parametrlarni \'agona Page Properties (Свой
ства страницы) muloqot oynasi yordamida kiritiladi (2.19-rasm). BU
muloqot oynasini bir necha yo'llar bilan ochish mumkin:

• Dastur menyu qatoridan Modify > Page Properties (Изменить ^
Свойства страницы) buyrug'ini berish bilan;

• CTRL+J tugmalar kombinatsiyasini bosish bilan;
• Kontekstli menyudan Page Properties (Изменить > Свойства

страницы) buyrug'ini berish bilan.
Endi Page Properties (Свойства страницы) muloqot oynasininS

boshqaruv elementlari bilan tanishib chiqamiz:
Title (Заголовок). Sahifaning sarlavhasini kiritish uchun xizrnat

qiladi.
• Background Image (Фоновый рисунок). Hujjatga fon sifatida

qo'yiladigan rasm ko'rsatiladi.
• Background (Фоновый цвет). Sahifaning fon rangini tanlash

imkoniyatini beradi.
• Text (Текст). Shriftning rangini tanlash imkoniyatini beradi.
• Links (Ссылки). Bu bo'limda giperhavolalar rangi va grafikl'

havolalar ramkasi rangi belgilanadi.
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Magic Eraser menyusi sichqoncha tugmasi bilan o'chirish imkonini
beradi. U siz ko'rsatgan rangga yaqin bo'lgan piksellarni o'chiradi. Buni
aksini esa Paint Bucket (Ведро с краской) uskunasi bajaradi. Agar siz
shaffofsizlikni 100%dan pastrog'ini tanlagan bo'Isangiz unda Magic
Eraser uskunasi orqali kerakli joylarni shaffof ko'rinishga keltirishingiz
mumkin.

Background Eraser uskunasi bu fondagi keraksiz joylarni o'chiradi
yoki kerakli ranga bo'yaydi. Bu uskunaning ustunligi shundaki u
bilan aralash foniarni yakdil holatga va o'chirilayotgan maydonni yoki
chegaralarni hamohangligini nazorat qiladi.

1. Xohlagan qatlamni tanlang. Eraser (o'chirgich) uskunasi yor-
damida qatlamdagi keraksiz joylarni o'chirmoqchi bo'Isangiz unda
Lock transparent pixels (Зафиксировать прозрачные точки)
bo'limiga bayroqchani o'rnating. Shunda o'chirilayotgan qatlam undan
oidingi qatlam foniga ega bo'ladi. Agar Lock transparent pixels (За
фиксировать прозрачные точки) bo'limidagi bayroqcha olib tashlansa
unda o'chirilgan qism shaffof holatga o'tadi.

2. Eraser (o'chirgich) uskunasini E tugmasi yoki Shift+E tugma-
larini birga bosib uni ishga tushiring.

3. Opsiyalar panelidan Brush (Кисть) bo'limiga kiring va kerakli
bo'lgan muyqalamni tanlang.

Mode (Режим) bo'limidan kerakli rejimni tanlang: u yerda Brush
(кисть). Pencil (карандаш) yoki Block (Блок)п1 tanlang. Xo'l bo'yoqni
akslantiruvchi Brush (Кисть) effektini tanlang. Opacity parametrlarini
ko'rsating.

Avtomatik tozaiash rejimi

Auto Erase (Автоластик) o'z-o'zidan avtomatik tarzda ishiashga
mo'ljallangandir. Agar siz uni o'z xohishingizga ko'ra ishlatmoqchi
bo'Isangiz quydagilarni bajarishingiz shart:

1. Kerakli bo'lgan fon rangini tanlang. Bunda Eyedropper (Пипет
ка) uskunasidan rang tanlashda foydalanishingiz mumkin;

2. Kerakli bo'lgan qatlamni belgilang;
3. Pencil (Карандаш) uskunasini faollashtiring, buning uchun V

tugmasi yoki Shift+B tugmalarini birgalikda bosing;
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4. Opsiyalar panelidan Auto Erase (Автоластик) uskunasi ustiga
bayroqni o'rnating;

5. Tasvirga shtrixlarni chizing. Asosiy pikseldan boshlab kerakli
hududgacha kursorni tortib boring.

Savol va topshiriqlar:

1. Brush uskunasi imkoniyatlarini sanab bering?
2. Background Eraser buyrug'i nima uchun ishlatiladi?
3. Obyekt rangi qanday o'zgartiriiadi?

4.4. Matnlar bilan ishlash

Adobe PhotoShop dasturi tasvirlar ustiga matnlarni kiritish
uchun yana bir keng imkoniyatni ochib beradi. Tasvir ustiga matn
kiritish uchun uskunalar panelida maxsus Текст uskunasi mavjud. Bu
uskuna, asosan, tasvirga turii matnlarni kiritish uchun xizmat qiladi.
Текст uskunasi tarkibida Текст-маска, Вертикальный текст kabi
uskunalar yashiringan. Bu uskunalar faollashtirilib, kursor tasvir
ustida bir marta bosishi bilan yangi Текстовый инструмент darchasi
hosil boTadi. Bu uskunalar faqat matnlarni tuzish uchun xizmat
Qiladi. Uning yordamida mavjud matnlarni tahrir qilishning imkoni
yo'q.

Photoshop 7.0 dasturida matn vektor ko'rinishiga ega. Dasturda matn
o'zining aniq chegara va konturlariga ega. Chunki dastur matnlarni
ishlatayotganda vektor konturini qo'llaydi. Shu bilan bir qatorda matn
ham rasm sifatlarini o'zida mujassamlashlirgan. Bu matn printerdan
chiqarilishiga qaramay u PDF yoki EPS formatlarida saqlanishida o'z
tiniqligini saqlab qoladi.

Photoshop dasturi faqatgina matnlarni kiritibgina qolmasdan, balki
ularni yozilayotgan vaqtida va yozilgandan so'ng ham ulami tusini,
rangihi, ko'rinishini hamda yo'nalishini o'zgartirish mumkin.

Matnni kiritish

Photoshop dasturida matn yozish uchun Текст tugmasi tanlanadi
va avtomatik tarzda kerakli joyda o'z maxsus qatlamiga ega bo"lgan
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fonda yozila boshlaydi. Istalgan paytda uning ko'rinishini o'zgartirish
mumkin masalan: shrift, uslub, kegl, rang, kerning, treking, oraliqdagi
interval, to'g'irlash, chiziqlarni hajmi. Bundan tashqari bir tekstni o'ziga
bir qancha atributlarni kiritish mumkin.

Shu bilan bir qatorda matnning ma'nosini mexanik tarzda
o'zgartirish unga har xil effektiar qo'llash va u joylashgan qatlam
ustida bir qancha imkoniyatlarni qo'llash mumkin. Matn qatlami
ustida qanday amallar qo'llash mumkin? Unga filtrni qo'llash, matndan
tozalash mumkin. Bu amallarni bajarish uchun eng avvalo matn
qatlamini Layer > Rasterize > Ture (Слой > Преобразовать в рас
тровый формат > Текст) uskunasi orqali belgilab undagi buyruqni
tanlash kerak.

Eslatma. Bitmap, Indexed Color va Multichannel rejimida yaratilgan
matn o'z qatlamiga ega bo'lmaydi va to'g'ridan-to'g'ri ekran foniga
tushadi hamda uni tahrirlash imkoniyati yo'qoladi.

Turli xildagi matnlar (tahrirlanadigan va tahrirlanmaydigan) ko'-
rinishlari Tare (Текст), Layer (Слой), Character (Шрифт), Paragraph
(Абзац) uskunalari va Opsiyalar paneli orqali yaratiladi.

Tahrirlanadigan matn qatlamini yaratish:

1. Eng avvalo Ture (Текст) uskunasini T tugmasini bosish bilan
faollashtiring.

2. So'ngra matnni joylashtirish kerak bo'lgan ekrandagi qismning
o'lchamlarini sichqoncha orqali belgilang (so'zlar va matnlar bir-biriga
to'qnashib ketmasligi kerak). Yaxshisi har bir so'zni alohida qatlamga
yozing shunda ularni bir-biridan mustaqil ravishda siljitish inikonini
qo'lga kiritaslz.

3. Opsiyalar panelida quyidagi amallarni bajaring:
о Ttire tugmasiga bosing va matnning yo'nalishini ko'rsating (go-

rizontal, vertikal);
° Shrift va uning o'lchamini tanlang;
о Shuningdek Anti-aliased (Moslashtirish) menyusidan matn

qatlam chegarasini ko'rsating; Sharp (Tiniq) Crisp (qattiq). Strong
(kuchli) yoki Smooth (yumshoq). Bu matnni soyasi ko'rinishlarini
tubdan o'zgartiradi va tasvirga moslaydi. Alignment (Выключ-
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ка) tugmalaridan biriga hosing va kerakli bo'lgan matnni yozilish
chegarasini ko'rsating (o'ngdan, chapdan, o'rtadan).^

Opsiyalar paneljdan matnni rangini ko'rsating. Bundan tashqari
matn rangini Swatches (Образцы) va Colors (Цвета) palitralaridan
ham belgilash mumkin.

4. Ekrandagi oynada matnni kiriting.
5. Yangi matn qatlamini yaratish uchun Enter tugmasini bosing.

Agar sizga boshqa qatlam kerak bo'lmasa Esc tugmasini bosing.
Eslatma: Agar siz matnlar bilan ishlayotganda kompyuter

to'xtab qolaversa yoki tezligi pasaysa unda ochilgan qolgan kerak
bo'lmagan oj'nalarni yoping. Shunda dastur tezligi o'z holiga
keladi.

Eslatma: Har safar matn yozishda yangi qatlamdan foydalan-
ganingiz ma'qul va xatolikka ega bo'lgan qatlamlarni o'chirib tash-
lang.

Matnni tahrirlash. Matnni o'zgartirishdan oldin uni faollashtiring
va matndagi so'z, jumla va harfni beigiiab o'zgartirish kiriting.
Shuningdek matnni belgilash uchun uning ramkasini ustiga bosish
kifoya.

Matnni masshtablash

Horizontal Scale (Масштаб no горизонтали) va Vertical Scale
(Масштаб no вертикали) buyruqlaridan. matnni joylashish shaklini
0 zgartirish uchun foydalaning. Bir xil to'g'ri ko'rinishdagi masshtablash
uchun quydagi amallarga rioya qiling:

Matn uchun maxsus effektlar

Eng avvalo quyidagilarni eslab qoling. Agar siz matnni ram
kasini masshtabini, hajmini va tuzilishini o'zgartirish uchun uni
tahrirlanadigan ko'rinishda bajarishingiz kerak bo'lsa va so'ngra matnga
maxsus effektlar qo'shish uchun uni rasm sifatiga keltirib undan keyin
effektlarni qo'llashingiz mumkin.

V tugmasi orqali ishga tushiriluvchi Move uskunasi orqali matimi
trasformatsiya qilish mumkin.
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Show Bounding Box (Показать габаритную рамку) uskunasiga
bayroqchani o'rnating Layers (Слои) uskunasi orqaii kerakli qatlamni
belgilang. Ekranda matn qatlami aks etadi.

Yakka holda kiritilgan jumla va so'zlarni quyidagicha o'zgartirish
mumkin:

• Layers (Слои) oynasiga jutnlani kiriting va Edit (Прав
ка) menyusidan Free Transform (Произвольная трансформация)
buyrug'ini tanlang;

• Sichqoncha bilan matn oynasini kerakli shaklni olguncha
surib boring. Bu vazifani boshqa uskunaiar yordamida ham bajarish
mumkin.

Matnni rasmli qatlam ustiga joylashtirish:
1. Matnli qatlamni yarating.
2. Shu matn qatlamidan nusxa oling va uni saqlab qo'ying.
3. Matn nusxasini belgilang va Layer > Type > Convert to Shape

(Слой > Текст > Преобразовать в фигуру) buyrug'ini bering. Matn
qatlami avtomatik rasmga aylanadi va uni tahrirlash endi mumkin emas.

4. Layer > Change Layer Content > Levels (Слои > Изменить
содержимое слоя > Уровни) buyrug'ini bering. Yozilgan qatlam siz
boshqa qatlamni kiritmaguningizga qadar buferda qoladi va faol bo'lib
turadi.

5. Yozilgan matn boshqa tasvirlar bilan hamohangligini jigarrang
tusga ega bo'lgan piktogramma Input (Ввод) ustiga bosing va matn
rangini ochartiring yoki to'qlashtiring;

6. OK tugmasini bosing. Ekran fonining bir qismiga bosing.

Ko'rinmaydigan matnlar yaratish:
1. Matn kiriting va uni qatlamini faol holatda qoldiring.
2. Layers oynasining pastki qismidan Add a mask (Добавить

маску) tugmasini bosing. Belgilangan joy yonida kichik belgi (маска)
paydo bo'ladi.

3. G klavishasini yoki Shift+G tugmalar kombinatsiyasini bosgan
holda Gradient (Градиент) uskunasini ishga tushiring.

4. Gradient uskunasi yonidagi strelkani bosing va kerakli rangni
tanlang. Linear gradient (Линейный градиент) tugmasiga bosing va
166



Normal (Нормальный) rejimini tanlang shaffofsizlik qiymatini bering
(1% dan 100% gacha).
"  5. Matnni ustiga kerakli boMgan hududni ramka sif^tida sichqoncha
bilan belgilang va shu qisi»lar ocharadi yoki to'qlashadi.

Matnni effekt bilan ko'chirish uchun u joylashgan qatlamni
faollashtiring va Move (Перемещение) uskunasini ishga tushiring.

Agar siz effektni o'zgartirmoqchi boMsangiz matn joylashgan qatlam
ustiga hosing shunda Layer Style muloqot oynasi paydo bo'Iadi. Undan
boshqa effektlarni tanlashingiz mumkin.

Matn qatlamini chegaralarini o'rash:
1. Blending Options (Опции смешивания) oynasidan Layers

(Слои) buyrug'ini tanlang.
2. Style (Стиль слоя) oynasining chap tarafida joylashgan Stroke

(Обводка) buying'i ustiga bosing va Preview (Предварительный
просмотр) uskunasiga bayroqcha o'rnatilganligini tekshiring. U yerdan
quyidagi bo'limlarni ko'rib chiqing va kerakli o'lchamlarni bering:
Structure (Структура) Size (Размер), Position (Joylashish holati)
(ular tashqaridan va ichkaridan bo'lishi mumkin Outside (Снаружи),
Inside (Внутри) yoki Center (markaz)). Blend Mode (Режим сме
шивания), Opacity (Shaffofsizlik), Fill ТУре (bo'yash usuli) va Color
(rang).

OK tugmasini bosing (yoki Enter tugmasini bosing).

Saval va topshiriqlar:

1. Dasturda matn konturini o'zgartirish uchun qaysi buyruqlardan foy-
dalaniladi?

2. Qaysi uskuna yordamida Photoshop dasturida matnlarni yaratish
mumkin?

3. Gradient (Градиент) uskunasi qaysi tugmalar yordamida ishga tu-
shiriladi?

4.5. Adobe Photoshop dasturida tasvirga ishlov berish. Qatlamlar

Qatlamlar xuddi oyna qatlamlariga o'xshagan bo'lib, faqat tasvir
bo'lgan joylarigina ko'rinishga egadir. Har bir qatlam uchun о zining
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shaffoflik darajasi bo'lib undan oldingi va keyingi turgan qatlamlar
bilan hamohangligini moslash mumkin. Qatlamlarni joylashish o'rnini
almashtirish yoki ularni yagona qatlamga birlashtirish mumkin. Bir
vaqtni o'zida bar xil qatlamlarda turgan tasvirni birgalikda o'zgartirish
va bir qatlamda turgan rasmni faqat bir qismini o'zgartirish mumkin
emas.

Layers (Слои) oynasida qatlamlar ustida turgan qatlamdan eng
tagidagi qatlamgacha aks ettirilgan. Bunda fon qatlami oxirida
joylashadi. Hozirda belgilangan qatlam faol bo'lib ko'rinadi va faqat shu
qatlam ustida amallar bajarish mumkin.

Istalgan qatlamni faollashtirish uchun Layers oynasidan kerakli
qatlam ustiga bosish kerak. Faol bo'lgan qatlam nomi dastur nomi
yonida akslanib turadi.

Eslatma: Katta hajmdagi tasvirlar bilan ishlayotganda bajarilib
bo Igan qatlamlarni birlashtirish yoki o'chirib tashlagan ma'qul. Shunda
dastur ishlash tezlik unumdorligi oshadi va tasvir hajmi kamayadi.

Yangi qatlam hosil qliish
1. Eng avvalo 100% shaffof qatlam hosil qilish uchun Create New

Layer tugmasi ustiga hosing.
2. Agar qatlamni o'lchamlarini o'zingiz bermoqchi bo'lsangiz unda

t tugmasini bosib turgan holda Create New Layer tugmasini bosing;
3. Name (Имя) bo'limida qatlamni nomini kiriting Group With

Previous Layer (Сгруппировать с предыдуши.м слоем) bo'limiga
bayroqchani o'rnating;

4. Layers (Слои) palitrasidan ko'z va muyqalam ko'rinishidagi
piktogrammalarga bayroqchani o'rnating;

Mode (Режим смешивания) va Opacity (Непрозрачность)
parametilaridan tasvir uchun yangi parametrlarini bering (keyinchalik
bu parametrlar o'zgartirilishi mumkin).

5. OK tugmasini bosing. Yangi qatlam ishlatilayotgan qatlam ustida
paydo bo'ladi.

Eslatma: Tasvir hajmini kamaytirish uchun Layers (Слои)
menyusidan Palette Options (Опции палитры) buyrug'ini tanlang va
shu tasvirga to'g'ri keladigan eng kichik hajmni tanlang.
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Belgilangan qismni qatlamga aylantirish

1. Belgilangan qismni hosil qiling;
2. Layer > New > Layer Via Soru (Слой > Новый > Посред

ством копирования) menyusidan buyruqni baring (Ctri+J tugmalari).
3. Tasvirni belgilangan qismini qirqib olib tashlash uchun Layer

> New > Layer Via Cut (Слой > Новый > Посредством вырезания)
buyrug'ini bering (Ctrl+ Shift+J tugmalari).

Qatlamni siljitish

1. Layers (Слои) oynasida o'zgartirish kiritmoqchi bo'lgan qatlamni
belgilang;

2. Move (Перемешение) uskunasini faollashtiring (V klavishasi);
3. Qatlamni kursorni ushlab turgan holatda siijiting.
Eslatma: Auto Select Layer (Автовыделение слоя) bo'limida

bayroqcha turgan bo'lsa Move (Перемещение) uskunasi yordamida
tezda qatlamni siljitish mumkin, ammo bu siljitish shafFofligi 50% dan
каш bo'lgan qatlamlar uchun ishlamaydi.

Qatlamlar bilan ishlash uchim uskunalar

Barcha uskunalar qatlamlar bilan ishiaydi. Lekln bu bilan qat-
lamning shaffofsizligiga katta tasir o'tkazadi. Shuning uchim qatlam
shaffofsizligini doimo nazorat qilib turing.

Qatlamni o'chirish

Qatlamni uchirishdan oldin uni nomini faolligini tekshiring va uni
belgilab o'chirib tashlang.

Qatlamga effektlar qo'llash

Qatlamga quyidagi maxsus effektlarni qo'llash mtunkin: Drop
Shadow (Отбросить тень), Inner Shadow (Внутренняя тень), Outer
Glow (Внешнее свечение). Inner Glow (Внутреннее свечение). Bevel
and Emboss (Скос и рельеф). Satin (Атлас), Color Overlay (Нало
жение цвета). Gradient Overlay (Наложение градиента) va Pattern
Overlay (Наложение узора). Effektlarni istalgan paytda istalgancha
xohlagan qatlamga qo'llash mumkin.
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Eslatma: Uslublar va effektlarni bir-biri bilan chalkashtirib

yubormang. Uslub (Стиль) — bu bir qancha qatlam effektlarini ha-
mobangligidir.

Effektlarni qo'yish Layer Style (Стиль слоя) muioqot oynasi orqaii
araalga oshiriladi.

Effekt yonidagi belgi bu effekt shu qatlamga qo'llanilganini
ko'rsatadi. Qatlam effektlarini asosiy fon uchun qoMlash mumkin emas.

Hamma qatlamlarni birgalikda ishlatish

Agar Opsiyalar panelida quyidagi uskunalar ishlatilayotgan bo'lsa:
Blur (Размытие), Sharpen (Резкость), Smudge (Палец), Paint Bucket
(Ведро с краской). Magic Eraser (Волшебный ластик) yoki Magic
Wand (Волшебная палочка) unda Use All Layers (Использовать
все слои) bo'limiga bayroqchani o'rnating shunda rang va boshqa
o'lchamlar olinayotganda mavjud boMgan ranglarga yaqin bo'lgan
tuslar birinchi navbatta ko'rinadi. Faqat faol boMgan qatlamda ranglar
o'zgaradi.

Ikki qatlamni birlashtirish

1. Birlashtirmoqchi bo'lgan ikki qatlamdan qaysi birisi oldinroq
bo'lsa uni belgilang.

2. Layers (Слои) menyusidan Merge Down (Слить с ниж
ним) buyrug'ini bering yoki Ctrl+E tugmalarini birgalikda bosing.
Faol qatlam o'zidan pastda turgan qatlam bilan birlashadi. Bir qancha
belgilangan qatlamlarni birlashtirish uchun Merge Layer Set (Слить
набор слоев) buyrug'ini bering.

Qatlamlarni birlashtirish

Eslatma: Flatten Image (Плоское изображение) buyrug'i qat
lamlarni pastdan boshlab birlashtiradi va yashirilgan qatlamlarni
avtomatik tarzda o'chiradi.

Hamma qatlamlar ko'rinib turganligiga amin bo'ling va qaysi
qatlam faol bo'lishi muhim emas. Layers (Слои) menyusidan Flatten
Image (Плоское изображение) buyrug'ini bering. Agar dasturda
bekitilgan qatlamlar bo'lsa unda ogohlantirish beriladi va OK tugmasini
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bosing va birlashtirishni davom ettiring. Agarda pastki qatlamlarda
ko'rinmaydigan nuqtalar bo'lsa ular oq ranga kiradi.
,  Layers (Слои) menyusidan keraksiz qatlam nomini tanlang. So'ngra
Trash (Корзина) tugmasjni bosilgandan keyin Yes (Да) tugmasini ham
bosing.

Qatlamni o'chirishni yana bir usuli keraksiz qatlam nomi ustiga
olib borib sichqonchani o'ng tugmasini bosing va menyudan Delete
Layer (Удалить слой) buyrug'ini tanlang hamda Yes tugmasini
bosing.

Savol va topshiriqlar:

1. Qanday usulda qatlamlar hosil qiiinadi?
2. Qatlamlarga qanday effektlar qo'llash mumkin?
3. Ajratilgan qismda yangi qatlamni hosil qilishni ko'rsatib berlng.
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V-bob. COREL DRAW DASTURI

5.1. COREL DRAW dasturi bilan tanishuv

Kanadaning Corel nomi bilan ataluvchi firmasi dasturiy ta'rninot
bilan shug'ullanuvchi peshqadamlardan biri hisoblanadi. Corel
firmasining dasturiy ta'minoti asosini tashkil etuvchi CorelDRAW
11 2002-yilning avgustida ishlab chiqarildi. U reklama mahsulotlarini
ishlab chiqarishda, nashrlarni tayyorlashda, hamda Web-saliifalari
uchun tasvirlarni yaratishda katta imkoniyatga ega.

Corel DRAW — bu grafikli dastur bo'lib, uning yordamida vektorli
tasvirlarni, grafikli matnlaini, hamda sizning tassavvuringizdagi barcha
ijodiy g'oyalaringizni amalga oshirishga yordam beradi.

Corel DRAW dasturi ishlaydigan barcha tasvirlar ikki sinfga
bo'linadi: nuqtali va vektorli. Vektorli grafikada tasvirning asosiy
elementi sifatida chiziq qaraladi. Rastrli grafikada bunday chiziqlar
nuqtalar (piksellar) yordamida yaratilsa, vektorli grafikada esa
tasvirlar yaratishda nuqtaga nisbatan umumiyroq bo'lgan chiziqlardan
foydalaniladi va shuning hisobiga tasvirlar aniqroq bo'ladi.

Vektorli grafikaning ixtiyoriy tasviri chiziqlardan tashkil
topadi va oddiy chiziqlardan murakkablari hosil qilinadi. Vektorli
grafikaning matematik asosini geometrik figuralarning xossasini
o'rganish tashkil qiladi. Vektorli tasvirlarni kompyuter xotirasida
ifodalanishi nuqtaliga qaraganda murakkabroq. Nuqtali tasvirning
kamchiligi — kompyuter xotirasida ularni saqlash katta joy talab
etiladi. Nuqtali tasvirlar bilan yuqori aniqlikda ishlashda, ularga mos
fayllarning o'lchami yuzlab megabaytlarni tashkil etadi. Ko'pincha,
bunday katta obyektlar bilan ishlaganda zamonaviy kompyuterlarning
tezligi yetmay qoladi. Vektorli tasvir bilan ishlash juda ham oson.
Uni katta yoki kichik qilish uchun, faqat uni boshqaradigan tasvir
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parametrini o'zgartirish mumkin. Bunda vektorli tasvir faylining
o'lchami bir baytga ham oshmaydi.

Ma'lumotlar tasvirlar orqali berilganda ularni tahlil qilish va
qabul qilish tezligi," ma'iumotni eshitish kanallari orqali berilgan
maMumctlardan ko'ra ancha yuqori bo'ladi. Shuning uchun ham
tasvirdan iborat birgina reklama plakati (osongina kerakli ta'sirni bera
oladigan) toniosha qilayotgan odamga bir necha qator e'iondan ko'ra
kuchli ta'sir ko'rsatadi.

Har qanday hajmdagi ma'lumot ko'rish kanali orqali uzatilsa odam
tomonidan yaxshi qabul qilinadi (bolalai'ga rasmlardan iborat kitoblar
yoqadi). Boshqa formatda esa bunday ma'iumotni qabul qilib bo'lmaydi
(birjalardagi jadvallar). Shu sababli ham grafikli ma'lumotlarga bo'lgan
ehtiyoj kundan kunga ortib bormoqda.

Bunday grafiklar va tasvirlar bilan ishlashga mo'ljallangan dasturiy
vositalar juda ham ko'p va xilma-xil. Ana shunday dasturlardan biri
CorelDRAW dasturidir.

CorelDRAWning 12 versiyasi o'zida zamonaviy imkoniyatlarni
birlashtirgan bo'lib 2004-yilda ishlab chiqarilgan. Bu dastur sanoat
dizaynida, reklama mahsulotlarini ishlab chiqishda, nashriyot tizim-
larida va web sahifalar uchun turli tasvirlar yaratishda ishlatiladi.
Corel DRAW dasturi paket dastur hisoblanib o'z ichiga bir nechta qism
dasturlarni oladi. Bu dasturlar o'zaro ma'lumot almashishning yengil
kechishini ta'minlaydi.

Paketiiing yaxlitligi uning tarkibiga kiruvchi dasturlarning ma-
lumotlarni yengil almashinishi yoki shu ma'lumotlar ustida ketma-ket
turli xil vazifalarni bajarishi bilan belgilanadi.

«Obyektga yo'naltirilgan» — atamasi tasvirlarni yaratish va o'zgar
tirish jarayonidagi barcha operatsiyalar, rasmning o'zi yoki uni tashkil
qilgan piksellar bilan emas balki tasvirni tashkil qilgan semantik
belgilangan elementlar ustida boradi. Standart obyektlarni qo'llagan
holda (aylana, to'g'ri to'rtburchak, matn va boshqalar) foydalanuvchi
inurakkab obyektlar qurishi va ularni birlashtirib yagona butun obyekt
sifatida qarashi mumkin. Shu tarzda, rasm iyerarxik tuzilishga ega
bo'lib, eng yuqorisida butun vektorli tasvir bo'lgan, eng quyida esa
standart obyektlardan iborat bo'ladi.
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Paket obyektga yo'naltirilishining yana bir afzalligi bar bir
obyektlarning standart sinfiga boshqaruv parametrlari yoki atributlar
o'matiladi. Masalan, to'rtburchak balandligi 200 mm va eni 300 mm,
ko'k rang bilan to'Idirilgan, qalinligi 3 punkt boMgan sariq rangdagi
chiziq bilan chegaralangan. Joylashuvi vertikal bo'yicha 150 mm,
gorizontal bo'yicha 250 mm, 32 gradusga burilgan kabi boshqaruv
parametrlariga ega.

Paketning obyektga yo'naltirilishining uchinchi afzalligi obyekt
larning bar bir standart sinfiga standart operatsiyalar ro'yxati bel-
gilangan. Masalan, yuqoridagi to'rtburchakni burish, o'lchamlarini
o'zgartirish, burchaklarini o'zgartirish, boshqa sinf obyektlariga
aylantirish kabi amallar. CorelDRAWning obyektga yo'naltirilganligi
foydalanuvchiga ish vaqtida obyektlar ustida cheksiz o'zgaruvchanlik
amallarini bajarish imkonini beradi. Agar buyurtmachi ishning oxirgi
bosqichida o'z fikrini o'zgartirsa va reklama plakatidagi olma o'rniga
anorni tasvirlashni xohlab qoldi, bunday holatda ishni boshidan
boshlash shart emas. Buning uchun ayrim obyektlarni almashtirish
kifoya. Bunday holatda bir marta qurilgan obyektni saqlab qo'yib
keyingi yangi ishlarda foydalanish mumkin.

CorelDRAW paketi quyidagi dasturlardan iborat; Corel CAPTURE,
Corel BARCODE WIZARD, CorelDRAW, Corel Photo-PAINT, Corel
OCR-TRACE, CorelTRACE, Corel VENTURA, Corel SCRIPT Editor,
Corel SCRIPT Dialog Editor.

Corel CAPTURE dasturi CorelDRAW dasturi oynasi va uning
qismlarini rasmga olish uchun ishlatiladi. Uning yordamida dastur
oynasi ayni ko'rinishini to'liq yoki menyu ko'rinishini hamda biror
qismni to'rtburchak shaklda, aylana yoki ellips shaklida va ixtiyoriy
shaklda aylantirib belgilab olish mumkin.

Corel BARCODE WIZARD das-

^  1 turi esa shtrix-kod bilan ishlashgatoo/о V nio'ijaliangan. Unda berilgan standart-[53
rn
D J Corel CAPTURE lardan birini tanlab, so'ng keltirilgan
^ Corel B.ARGODE WIZARD namuna bo'yicha raqam va xarflarni

^  kiritamiz.О CorelDRAW ^ ^»X.V ТГТ- j ^ •
Corel Photo-PAINT dasturi esa

13 Corel PHOTO-PAINT rasmlar chizishga mo'ljallangan.
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CorelDRAWni ishga tushirish. Corel DRAW 12 grafik muharririni
ii^hga tushirish uchun Пуск > Программы > Corel DRAW 12 buyrug'i
beriladi yoki Windows XP ish stolida uning yorlig'i ustida sichqoncha
chap tugmasi ikki marta bosiladi.

CoreroRAW dasturini ishga tushirish Windowsning standart
usuilari singari: asosiy menyu orqali (unda paketni o'rnatganda
CorelDRAWni yuklash buyrug'ini o'z ichiga olgan yangi buyruqlar
guruhi paydo bo'ladi) yoki ish stolida joylashgan yorliq yordamida
hamda CorelDRAW dasturida yaratilgan fayllar ustida sichqoncha
chap tugmasini ikki marta bosish yo'li bilan ishga tushiriladi. Sunday
fayllarni biz albatta uning kengaytmasidan bilib olamiz. CorelDRAW
dasturida yaratilgan fayllar .CDR, .CMX, WMF kabi kengaytmalarini
oladi.

Kengaytmalar haqida 5.2-jadvaIdan batafsil ma'lumot olishingiz
mumkin.

5.2-Jadval

CorelDRAW dasturida kengaytmalarning ro'yxati

№ Kengaytma Izoh

1. CDR CorelDRAW

2. COT CorelDRAW shabloni

3. COM Kompyuter grafikasi metafayli

4. CMX Corel Presentation Exchange 5.0.

5. CMX Corel Presentation Exchange

6. CSL Corel simvollari kutubxonasi

7. DES Corel DESIGNER

8. DWG AutoCAD

9. DXF AutoCAD

10. EMF Kengaytirilgan Windows metafayli

11. FMV ■ Vektorli freym metafayli

12. GEM GEM fayli
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13. PAT Uzor fayli

14.
f t'

PCT Macintosh PICT rasmlari

15. PLT HPGL plotter fayli

16. SVG Masshtablanadigan vektor grafikasi

17. SVGZ Siqi SVG

18. WMF Windows metafayli

19. WPG Corel WordPerfect grahkasi fayli

20. CLK Corel R.A.V.E.

Dastur yuklangandan so'ng ekranda foydalanuvchi interfeysining
asosiy elementlaridan iborat CorelDRAW oynasi paydo bo'ladi (5.1-
rasm).

Menyu qatori Standart uskunalar paneli Atributlar panel!
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Sahifadan-sahifaga o'tish Holat qatori

5.}-rasm. CorelDRAW oynasining ko'rinishl.
12 - Pec/agogik web-dizayn

Palitra -■
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CorelDRAWda ishchi muhitni sozlash mexanizmi juda rivojlangan.
Windows standartidan farqii oynaning sarlavha satri ostida menyu
qatori joyiashgan.

5.2. Corel DRAW dasturi oynasi qismlari

□ Sarlavha satri. Bu yerda: Corel DRAW 12 — dasturning nomi.
[Risunok 1] - hujjatning formal nomi. Ish yakunida formal nomga

real (haqiqiy) nom beriladi.
□ Menyu satri.
Windows standartlariga mos bo'lgan menyu satri. CorelDRAWda

menyu satri murakkab bo'lib, qism menyu va ularga mos buyruqlardan
iborat. Boshqa dasturlardagi kabi bu menyu ham Corel Drawning
ko'pchilik funksiyalariga kirishni ta'minlaydi. Lekin ko'pchilik ha-
rakatlar u siz ham bajarilishi mumkin. Menyuni sozlashning
chegaralanmagan imkoniyatlari foydalanuvchini chalkashtirib yuboradi.
Foydalanuvchi xohlagan vaqtda CorelDRAWning har qanday buyruq
va uskunalarini boshqa menyuga ko'chirish mumkin. Shuning uchun
keyingi paragraflarda birinchi navbatda menyusiz ishlash yo'llarini,
zarur bo'lganda uning buyruqlariga murojat qilishni o'rganamiz.
Menyu satri 11 ta menyudan iborat. Har bir menyu o'ziga xos buyruqlar
to'plamidan tashkil topgan. Corel DRAW menyusi murakkab tuzilgan
bo'lib, har bir menyuda bir necha ichki menyular bo'lishi mumkin.

Standart uskunaiar paneli

Menyu satrining ostida Standart uskunaiar paneli joyiashgan. Bu
satrda eng ko'p bajariladigan buyruqiarga mos boshqarish elementlari
joyiashgan. Masalan, Открыть (ochish), Закрыть (yopish), Сохранить
(saqlash) buyruqlari, tizimli almashtirish buferining operatsiyalari,
rasmlarni ko'rish holati uskunalari joyiashgan.

rr, в M 8^ Ё Ife Ъ • '5 - E "00%t  I TT I TT I I—I I I T h
1  2 3 4 5 6 7 8 9 10 11 12 13 14

Привямть к ■»

Standart uskunaiar paneli tugmachalarinlng vazifalari:
1 - yangi hujjat yaratish: 2 - mavjud hujjatni ochish; 3 - hujjatni saqlash; 4 -
hujjatni chop qilish; 5 - qirqish; 6 - nusxa olish: 7 - qo4 ish; 8 - oxirgi harakatni
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bekor qilish; 9 - oxirgi harakatni takrorlash; 10 - import (blr hujjatni ikkinchisiga
ulash); 11 - eksport (fayllarni jo'natish); 12 - ilovani yuklanlsh moduli; 13 - Corel
DRAWning saytiga kirish; 14 - masshtabni kattalashtirish darajasi.

r  ' ̂

□ Atributlar paneli.
Standart uskunalar panelining ostida «atributlar paneli» (панель

атрибутов) satri joylashgan. U belgilangan obyelctning parametrlarini
o'zgartiradigan boshqarish elementlari to'plamidan iborat. Atributlar
paneli ichidagi elementlar belgilangan obyektning shakliga qarab
o'zgarib turadi. Bu panel foydalanuvchining asosiy ish paneli deb
ataladi.

XI ли 17^698 Wf 100«0 % Д л ал ryt /v ^ «pa л ■
»3,;691K> ,00.0 Ч ^ ^ ̂  ^

Ranglar palitrasi. Oynaning o'ng chegarasi bo'ylab «Палитра цве
тов» (ranglar palitrasi) paneli joylashgan. U rangni to'ldirish va rasmli
obyektlarning atrofini himoyalash, aylantirib bo'yash uchun qo'llaniladi.

Uskunalar paneli. Ish maydonining chap qismida uskunalar to'plami
(toolbox) oynasi joylashgan. Undagi kerakli uskunani tanlash uchun
uning ustida sichqoncha chap tugmasi bosiladi. Kerakli uskunani
tanlash bilan foydalanuvchining tasvir ustida barcha harakatlari
boshlanadi.

'Л ^ i-L H ^ %
I  I I I I I I " I I I I I I I • I I I

2  3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

Uskunalar panelidagi asosiy uskunalar va ularning vazifalari:
1 - Указатель (ko'rsatkich), tasvirni belgilaydi: 2 - Форма (shakl) uskunasi: 3 -
Вырезать (Qirqib olish); 4 - Масштаб (oMcham). Obyektni ko'rinishini o'zgartiradi
(kattalashtiradi va kichiklashtiradi); 5 - Свободная рука. Ixtlyoriy shakldagl
chiziqlarni chizadi; 6 - Авторисование uskunasi. Erkin chiziqlarni hosil.qiladi; 7 -
Прямоугольник uskunasi. To'rtburchaklar sinfini hosil qiladi; 8 - Aylana va uning
sinfiga tegishli obyektlarni chizadi: 9 - Многоугольник (ko'pburchak) uskunasi.
Ko'pburchaklarni chizadi: 10 - Простые формы (oddiy formalar); 11 - Текст
(matn) uskunasi: 12 - Таблица. Jadval uskunasi; 13 - Интерактивное перетекание
uskunasi; 14 - Пипетка uskunasi; 15 - Контур uskunasi; 16 - Заливка uskunasi;
17 - Интерактивная заливка uskunasi.
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